<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>What is interoperability?</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>Industry standards</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>Compatible formats</td>
<td>11</td>
</tr>
<tr>
<td>4</td>
<td>Compatible software</td>
<td>13</td>
</tr>
<tr>
<td>5</td>
<td>Import to and export from Tekla Structures</td>
<td>30</td>
</tr>
<tr>
<td>6</td>
<td>Conversion files</td>
<td>32</td>
</tr>
<tr>
<td>6.1</td>
<td>Twin profile conversion files</td>
<td>33</td>
</tr>
<tr>
<td>6.2</td>
<td>Create conversion files</td>
<td>34</td>
</tr>
<tr>
<td>7</td>
<td>Define project base points for IFC export and reference model import</td>
<td>37</td>
</tr>
<tr>
<td>7.1</td>
<td>Define a base point</td>
<td>37</td>
</tr>
<tr>
<td>7.2</td>
<td>Insert a reference model using a base point</td>
<td>40</td>
</tr>
<tr>
<td>7.3</td>
<td>Export an IFC model using a base point</td>
<td>41</td>
</tr>
<tr>
<td>8</td>
<td>Reference models and compatible formats</td>
<td>42</td>
</tr>
<tr>
<td>8.1</td>
<td>Import a reference model</td>
<td>43</td>
</tr>
<tr>
<td>8.2</td>
<td>View reference models</td>
<td>45</td>
</tr>
<tr>
<td>8.3</td>
<td>Modify reference model details</td>
<td>49</td>
</tr>
<tr>
<td>8.4</td>
<td>Lock reference models</td>
<td>50</td>
</tr>
<tr>
<td>8.5</td>
<td>Detect changes between reference model versions</td>
<td>51</td>
</tr>
<tr>
<td>8.6</td>
<td>Define a comparison set for reference model change detection</td>
<td>56</td>
</tr>
<tr>
<td>8.7</td>
<td>Inquire reference model contents</td>
<td>60</td>
</tr>
<tr>
<td>8.8</td>
<td>Reference model objects</td>
<td>61</td>
</tr>
<tr>
<td>8.9</td>
<td>Examine reference model hierarchy and modify reference model objects</td>
<td>61</td>
</tr>
<tr>
<td>8.10</td>
<td>Reference model assemblies</td>
<td>65</td>
</tr>
<tr>
<td>9</td>
<td>IFC</td>
<td>67</td>
</tr>
<tr>
<td>9.1</td>
<td>IFC interoperability concepts</td>
<td>67</td>
</tr>
<tr>
<td>9.2</td>
<td>IFC import</td>
<td>70</td>
</tr>
</tbody>
</table>
9.3 Convert IFC objects into native Tekla Structures objects

- Check and change the IFC object conversion settings
- Convert selected IFC objects at one go
- Convert IFC objects using conversion change management - first conversion
- Convert IFC objects using conversion change management - update conversion
- Macro for selecting converted IFC objects
- Class values
- Profile conversion logic in IFC object conversion
- Example: Convert IFC objects into Tekla Structures objects in one go
- Limitations in IFC object conversion

9.4 IFC export

- Define additional property sets for IFC export
- Add a new IFC property set configuration file
- Tekla Structures model objects and corresponding IFC entities
- Export a Tekla Structures model or selected model objects to an IFC file
- Define IFC entities for Tekla Structures model objects
- Export to IFC
- Check the exported IFC model
- IFC base quantities in exported IFC model
- Property set configuration files used in IFC export

10 SketchUp

10.1 Export a model to SketchUp

11 DWG and DXF

11.1 Import a 2D or 3D DWG or DXF file

11.2 Export a model to a 3D DWG or DXF file

11.3 Export a drawing to 2D DWG or DXF

- Layers in exported DWG/DXF drawings
- Create layers in DWG/DXF files for drawing export
- Assign objects to layers in drawing export
- Example: Create a rule for exporting beam marks to their own layer in drawing export
- Copying export layer settings to another project
- Define customized line type mappings in drawing export
- Default line types in drawings
- Example: Set up layers and export to DWG
- Example: Create a selection filter for DWG export
- Example: Create layers for DWG export
- Example: Create a rule for drawing DWG export and assign a layer to the rule
- Example: Define a custom line type for DWG export
- Example: Define line types and weights for layers in DWG export
- Example: Export the drawing to DWG

12 DGN

12.1 DGN import

12.2 DGN objects supported in reference models

12.3 Export to 3D DGN files

13 LandXML
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td><strong>PDF</strong></td>
<td>130</td>
</tr>
<tr>
<td>14.1</td>
<td>Import a PDF to a model</td>
<td>130</td>
</tr>
<tr>
<td>15</td>
<td><strong>CAD</strong></td>
<td>131</td>
</tr>
<tr>
<td>15.1</td>
<td>CAD import and export formats</td>
<td>131</td>
</tr>
<tr>
<td>15.2</td>
<td>Import an SDNF model</td>
<td>132</td>
</tr>
<tr>
<td>15.3</td>
<td>Import a Plantview model</td>
<td>135</td>
</tr>
<tr>
<td>15.4</td>
<td>Import a SteelFab/SCIA model</td>
<td>136</td>
</tr>
<tr>
<td>15.5</td>
<td>CAD model import settings</td>
<td>137</td>
</tr>
<tr>
<td>15.6</td>
<td>Export to CAD</td>
<td>143</td>
</tr>
<tr>
<td>15.7</td>
<td>CAD model export settings</td>
<td>144</td>
</tr>
<tr>
<td>15.8</td>
<td>Re-import a CAD model</td>
<td>149</td>
</tr>
<tr>
<td>15.9</td>
<td>Create import reports</td>
<td>150</td>
</tr>
<tr>
<td>16</td>
<td><strong>FEM</strong></td>
<td>152</td>
</tr>
<tr>
<td>16.1</td>
<td>FEM import and export file types</td>
<td>152</td>
</tr>
<tr>
<td>16.2</td>
<td>DSTV</td>
<td>153</td>
</tr>
<tr>
<td>16.3</td>
<td>Import a DSTV model</td>
<td>153</td>
</tr>
<tr>
<td>16.4</td>
<td>Import a STAAD model</td>
<td>154</td>
</tr>
<tr>
<td>16.5</td>
<td>Import a Stan 3d model</td>
<td>156</td>
</tr>
<tr>
<td>16.6</td>
<td>Import a Bus model</td>
<td>157</td>
</tr>
<tr>
<td>16.7</td>
<td>Export to STAAD</td>
<td>159</td>
</tr>
<tr>
<td>16.8</td>
<td>Export to DSTV</td>
<td>159</td>
</tr>
<tr>
<td>17</td>
<td><strong>ASCII</strong></td>
<td>162</td>
</tr>
<tr>
<td>17.1</td>
<td>Import a model in the ASCII format</td>
<td>162</td>
</tr>
<tr>
<td>17.2</td>
<td>Export a model to the ASCII format</td>
<td>163</td>
</tr>
<tr>
<td>17.3</td>
<td>ASCII file description</td>
<td>163</td>
</tr>
<tr>
<td>18</td>
<td><strong>Attribute import</strong></td>
<td>166</td>
</tr>
<tr>
<td>18.1</td>
<td>Import attributes</td>
<td>166</td>
</tr>
<tr>
<td>18.2</td>
<td>Input files in attribute import</td>
<td>167</td>
</tr>
<tr>
<td>18.3</td>
<td>Attribute import settings</td>
<td>171</td>
</tr>
<tr>
<td>19</td>
<td><strong>CIS and CIMSteel</strong></td>
<td>173</td>
</tr>
<tr>
<td>19.1</td>
<td>Import a CIMSteel model</td>
<td>173</td>
</tr>
<tr>
<td>19.2</td>
<td>Export to a CIMSteel analysis model</td>
<td>174</td>
</tr>
<tr>
<td>19.3</td>
<td>Export to a CIMSteel design/manufacturing model</td>
<td>175</td>
</tr>
<tr>
<td>19.4</td>
<td>CIMSteel conversion files</td>
<td>177</td>
</tr>
</tbody>
</table>
20 MIS............................................................................................... 179
20.1 Export a MIS list.............................................................................................179
20.2 Information on MIS file types..........................................................................180
21 FabTrol XML........................................................................................... 181
21.1 Import a FabTrol XML file..............................................................................181
22 PDMS/E3D ................................................................................................. 183
23 NC files......................................................................................................... 184
23.1 DSTV file description......................................................................................186
23.2 Create NC files in DSTV format......................................................................187
23.3 NC file settings................................................................................................189
23.4 Customize NC file header information .......................................................199
23.5 Create pop-marks in NC files...........................................................................200
23.6 Create contour marking in NC files.............................................................205
23.7 Fittings and line cuts in NC files......................................................................207
23.8 Create tube NC files .....................................................................................208
23.9 Create NC files in DXF format.........................................................................209
Create NC files in DXF format using Convert_DSTV2DXF................................................209
Create NC files in DXF format using tekla_dstv2dxf.exe.................................................210
24 HMS............................................................................................................... 221
24.1 Export to the HMS format...............................................................................221
24.2 HMS Export settings......................................................................................222
25 ELiPLAN......................................................................................................... 226
25.1 Import an ELiPLAN status data file...............................................................226
25.2 Export an ELiPLAN data file..........................................................................227
25.3 ELiPLAN user-defined attributes...................................................................228
25.4 ELiPLAN export settings...............................................................................230
Parameters tab.......................................................................................................230
Plotter data tab......................................................................................................232
Data content tab....................................................................................................233
26 BVBS............................................................................................................. 235
26.1 Export to the BVBS format.............................................................................235
26.2 Export settings...............................................................................................236
Parameters tab.......................................................................................................236
Advanced tab.........................................................................................................239
Checking tab.........................................................................................................241
26.3 Reinforcing bar length calculation in BVBS export......................................242
27 Unitechnik

27.1 Export to the Unitechnik format
27.2 Unitechnik export: Main tab
27.3 Unitechnik export: TS configuration tab
27.4 Unitechnik export: Embeds tab
27.5 Unitechnik export: Reinforcement tab
27.6 Unitechnik export: Validation tab
27.7 Unitechnik export: Reinf. data specification tab
27.8 Unitechnik export: Data specification tab
27.9 Unitechnik export: Mounting part data specification tab
27.10 Unitechnik export: Line attributes tab
27.11 Unitechnik export: Pallet tab
27.12 Unitechnik export: Log files tab

28 Layout Manager

28.1 Create a group in Layout Manager
Define numbering settings for groups in Layout Manager
Define a local coordinate system for a group in Layout Manager

28.2 Create a layout point

28.3 Create a layout line

28.4 View groups, layout points and layout lines in Layout Manager

28.5 Export layout data from Layout Manager
Define default export settings in Layout Manager
Define the drawing scale in Layout Manager

28.6 Import layout data to Layout Manager
Define point file columns in Layout Manager
Measured points in Layout Manager

29 Tekla Web Viewer

29.1 Publish a model as a web page

29.2 Customize Web Viewer tooltips

29.3 Web templates in Web Viewer

29.4 Send Web Viewer tooltips

29.5 Create a named view in Web Viewer

29.6 View a model in Web Viewer

30 Tekla BIMsight

30.1 Import reference models from Tekla BIMsight

30.2 Import additional reference models from a Tekla BIMsight project

30.3 Publish a model to Tekla BIMsight

31 Tekla Structural Designer
31.1 Example workflow of integration between Tekla Structures and Tekla Structural Designer.................................................................311
31.2 Import with Tekla Structural Designer integrator..................................................312
31.3 Re-import with Tekla Structural Designer integrator........................................314
31.4 Export with Tekla Structural Designer integrator.............................................315

32 Tekla Warehouse........................................................................................................317

33 Trimble Connector..................................................................................................319
33.1 Download reference model from and upload reference model to Trimble Connect...........................................................................319
33.2 Link a Tekla Structures model to a Trimble Connect project..........................320
33.3 Download a reference model from a Trimble Connect project to a Tekla Structures model .................................................................321
33.4 Download a reference model update from a Trimble Connect project to a Tekla Structures model .....................................................321
33.5 Upload a Tekla Structures reference model to a Trimble Connect project ....322
33.6 Upload a Tekla Structures reference model update to a Trimble Connect project .................................................................................322
33.7 Export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project ..............................................................322
33.8 Use base point instead of alignment offset.........................................................323
33.9 ToDos.......................................................................................................................323

34 Analysis and design systems..................................................................................327
34.1 Analysis and design direct links........................................................................327
34.2 Robot.......................................................................................................................328
34.3 SAP2000.................................................................................................................328
34.4 STAAD.Pro............................................................................................................329
34.5 ISM........................................................................................................................329
34.6 S-Frame.................................................................................................................330
The process of importing to and exporting from S-Frame........................................330

35 Disclaimer..................................................................................................................332
What is interoperability?

Interoperability is often seen as the missing link between different software systems. It allows best-of-breed applications to share common objects, geometry and properties between applications. Interoperability is a process, which allows diverse systems and organizations to work together. This allows common 3D models to be built or information and geometry defined in one system to be used in another. An example of this would be a 3D structural frame from a modeling application being transferred and used by an Analysis & Design system. Another example would be an Architectural model being used within a structural modeling system.
There are many industry standard file transfer formats. The principle ones supported by Tekla Structures are IFC, CIS/2, DSTV, SDNF, DGN, DXF, DWG, IGES, and STEP. Older formats are also included. For a tighter integration, you can link to Tekla Structures using the Tekla Open API technology.

The file name extension normally informs the user which format it is based upon. If you do not know what format it is, or the file does not import, then you will need to open the file in a text editor to look at the header information, where the file type and the authoring application is usually noted. With CIS/2 files the authoring application and version number is sometimes written at the end of the file.

See also

Compatible formats (page 11)
You can import and export several formats in Tekla Structures.

The following table lists many of the different formats you can use in Tekla Structures to import and export data (page 30).

For information about software connected to the formats, see Compatible software (page 13).

To find out more about the various import and export tools, see Import to and export from Tekla Structures (page 30).

<table>
<thead>
<tr>
<th>Format</th>
<th>Import</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>aSa (.TEK)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Autodesk (.dwg)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Autodesk (.dxf)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bentley ISM</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BIM Collaboration format (.bcf)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BVBS (.abs)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Cadmatic models (.3dd)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 analytical (.stp,.p21,.step)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 design (.stp,.p21,.step)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM6 manufacturing (.stp,.p21,.step)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CPIxml</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>DSTV (.nc,.stp,.mis)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EJE</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Elematic ELiPLAN, ELiPOS (.eli)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EPC</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Fabsuite (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FabTrol Kiss File (.kss)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>FabTrol MIS Xml (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>High Level Interface File (.hli)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HMS (.sot)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IBB Betsy (.fa,.f,.ev)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IFC2x2 (.ifc) **</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IFC2x3 (.ifc) **</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IFC4 (.ifc) **</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IFCXML 2X3 (.ifcXML) **</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IFCZIP 2X3 (.ifcZIP) **</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification (IGES) (.iges,.igs)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>LandXML (.xml)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project (.xml)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Microstation (.dgn)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Oracle Primavera P6 (.xml)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Plant Design Management System (.pdms)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP, Oracle, ODBC, etc.</td>
<td>X *</td>
<td>X *</td>
</tr>
<tr>
<td>SketchUp (.skp)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Staad ASCII file (.std)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Steel Detailing Neutral Format (.sdf,.sdnf,.dat)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Steel12000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP AP203 (.stp,.step)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>STEP AP214 (.stp,.step)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>StruM.I.S</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tekla BIMsight project file (.tbp)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tekla Collaboration file (.tczip)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tekla-FabTrol Report (.xsr)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tekla Structural Designer neutral file (.cxl)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tekla Structures shape (.tsc)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Trimble Field Link .tfl</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Trimble LM80 (.txt,.cnx)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>TubeNC (.xml)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Unitechnik (.uni,.cam)</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

* Tekla OpenAPI used
**For a list of IFC applications certified by buildingSMART international, see Certified Software.
Compatible software

The following table lists Tekla Structures compatible software and the formats that you can import to and export from Tekla Structures.

Many of the compatible interoperability applications, application links, or direct links are available on Tekla Warehouse.

For information about formats connected to the software, see Compatible formats.

For a list of IFC applications certified by buildingSMART international, see Certified Software.

To find out more about the various import and export tools, see Import to and export from Tekla Structures.

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D+</td>
<td>Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td>3ds Max</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>3ds Max Design/VIZ</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>A+ Software</td>
<td>ArmaPlus</td>
<td>BVBS (.abs), Soulé (.xml), aSa (.TEK)</td>
<td></td>
</tr>
<tr>
<td>Adapt</td>
<td>Adapt Corporation</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>ADConX</td>
<td>ADConX</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Advanced Steel, Advanced Design/Engineering</strong></td>
<td>Autodesk</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td><strong>Allplan/Planbar</strong></td>
<td>Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td><strong>ANSYS</strong></td>
<td>ANSYS</td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td><strong>ArchicAD</strong></td>
<td>Graphisoft / Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZIP (.ifczip)</td>
<td>IFCZIP (.ifczip)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coordinated view v1</td>
<td>Coordinated view v1</td>
</tr>
<tr>
<td><strong>ArchonCAD</strong></td>
<td>ArchonCAD Ltd.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td><strong>Armaor</strong></td>
<td>Ariadis</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td><strong>Artube</strong></td>
<td>Adige</td>
<td></td>
<td>STEP (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td><strong>aSa Rebar</strong></td>
<td>Applied Systems Associates Inc</td>
<td></td>
<td>aSa Rebar file (.TEK)</td>
</tr>
<tr>
<td><strong>ASI</strong></td>
<td>Applied Science International LLC</td>
<td></td>
<td>Staad ASCII file (.std)</td>
</tr>
<tr>
<td><strong>AutoCAD</strong></td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td><strong>AutoCAD Architecture</strong></td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>
| AutoCAD Civil 3D | Autodesk     | Autodesk (.dwg)  
Autodesk (.dxf)  
Microstation (.dgn)  
LandXML files (.xml) | Autodesk (.dwg)  
Autodesk (.dxf) |
| AutoCAD MEP      | Autodesk     | Autodesk (.dwg)  
Autodesk (.dxf)  
IFC2X3 (.ifc)     | Autodesk (.dwg)  
Autodesk (.dxf)  
IFC2X3 (.ifc)  
Microstation (.dgn) |
| AutoPLANT        | Bentley      | Autodesk (.dwg)  
Autodesk (.dxf)     | Autodesk (.dwg)  
Autodesk (.dxf) |
| AutoVue          | Oracle       |                                                                                            | Autodesk (.dwg)  
Autodesk (.dxf)  
IFC2X3 (.ifc)  
STEP AP214 (.stp, .step) |
| Aveva E3D        | AVEVA        | Microstation (.dgn)  
Steel Detailing Neutral Format (.sdf, .sdnf, .dat)  
.iFC based Tekla Collaboration files (.tczip) | Microstation (.dgn)  
Steel Detailing Neutral Format (.sdf, .sdnf, .dat)  
.iFC based Tekla Collaboration files (.tczip) |
| AviCAD           | Progress/EBAWE |                                                                                            | Unitechnik (.cam), BVBS (.abs) |
| AxisVM           | Inter-CAD Kft. | Direct Link  
Direct Link | Direct Link  
IFC2X3 (.ifc) |
| BeamMaster       | AGT          | Direct Link  |
| Bentley Architecture | Bentley    | Direct Link (ISM)  
Autodesk (.dwg)  
Autodesk (.dxf)  
IFC2X3 (.ifc)     | Direct Link (ISM)  
Autodesk (.dwg)  
Autodesk (.dxf)  
IFC2X3 (.ifc) |
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bentley Building Electrical Systems</td>
<td>Bentley</td>
<td>Microstation (.dgn)&lt;br&gt;STEP AP203/AP214 (.stp, .step)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Bentley Building Mechanical Systems</td>
<td>Bentley</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LandXML files (.xml)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Direct Link (ISM)</td>
<td>Direct Link (ISM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>Betsy</td>
<td>IBB – Consultant s &amp; Engineers</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>BIM Collaboration Format</td>
<td>BuildingSMART</td>
<td>BCF 1.0 (.bcf)</td>
<td>BCF 1.0 (.bcf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCF 2.0 (.bcf)</td>
<td>BCF 2.0 (.bcf)</td>
</tr>
</tbody>
</table>

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadmatic</td>
<td>Cadmatic</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cadmatic models (.3dd)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZip (.ifczip)</td>
<td>IFCZip (.ifczip)</td>
</tr>
<tr>
<td>CADmep+</td>
<td>MAP Software / Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td>AEC Design Group</td>
<td>Autodesk (.dwf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZip (.ifczip)</td>
<td>IFCZip (.ifczip)</td>
</tr>
<tr>
<td>CADPipe</td>
<td>AEC Design Group</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td>CADWorx Plant</td>
<td>Intergraph / Hexagon</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>CAESAR II</td>
<td>Intergraph / Hexagon</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>CATIA</td>
<td>Dassault</td>
<td>Autodesk (.dwg)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwf)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>Concrete Pro</td>
<td>LAP Laser GmbH</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unitechnik (.cam)</td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>ConSteel</td>
<td>ConSteel Solutions Limited</td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Corobs</td>
<td>Müller Opladen</td>
<td>TubeNC (.xml)</td>
<td></td>
</tr>
</tbody>
</table>

Compatible software 17
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYPECAD</td>
<td>Cype</td>
<td><strong>Direct Link</strong></td>
<td></td>
</tr>
<tr>
<td>Daystar Software</td>
<td>Daystar Software Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>DDS-CAD</td>
<td>DDS</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Diamonds</td>
<td>Buildsoft</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Project</td>
<td>Gehry Technologies</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.step, .step)</td>
<td>STEP AP203/AP214 (.step, .step)</td>
</tr>
<tr>
<td>DuctDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>ebos</td>
<td>Progress / EBAWE</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>elcoCAD</td>
<td>Hannappel SOFTWARE GmbH</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td>ELiPLAN</td>
<td>Elematic</td>
<td>ELiPLAN (.eli)</td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>ELIPOS</td>
<td>Elematic</td>
<td></td>
<td>ELIPLAN (.eli)</td>
</tr>
<tr>
<td>EliteCAD</td>
<td>Messerli Informatik</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td>ETABS</td>
<td>Computers &amp; Structure s, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>FabPro Pipe</td>
<td>UHP Process Piping Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
</tbody>
</table>

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabsuite</td>
<td>Fabsuite</td>
<td>Direct Link KISS (.kss)</td>
<td>Direct Link KISS (.kss)</td>
</tr>
<tr>
<td>FabTrol MRP</td>
<td>FabTrol</td>
<td>FabTrol MIS XML (.xml)</td>
<td>FabTrol KISS File (.kss)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tekla-FabTrol Report (.xsr)</td>
</tr>
<tr>
<td>FactoryCAD</td>
<td>Siemens</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>FelixCAD</td>
<td>SofTec</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>FEM Design</td>
<td>StruSoft</td>
<td>Direct Link IFC2X3 (.ifc)</td>
<td>Direct Link IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Floor Pro</td>
<td>Adapt Corporation</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>FormZ</td>
<td>AutoDesSys, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>FXTube</td>
<td>Mazak</td>
<td>STEP (.stp, .step)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td>GSA</td>
<td>Oasys</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>GT Strudl</td>
<td>GT Strudl</td>
<td>Direct Link Autodesk (.dxf)</td>
<td>Direct Link Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>HMS</td>
<td>HMS</td>
<td></td>
<td>HMS (.sot)</td>
</tr>
<tr>
<td>HOOPS</td>
<td>Tech Soft 3D</td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inventor</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/4 AP214 (.stp, .step)</td>
</tr>
<tr>
<td>IronCAD</td>
<td>IronCAD</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/4 AP214 (.stp, .step)</td>
</tr>
<tr>
<td>iTWO</td>
<td>RIB Software AG</td>
<td></td>
<td>CPIxml (.xml)</td>
</tr>
<tr>
<td>Joints For Tekla</td>
<td>Progetto Archimede</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>KeyCreator</td>
<td>Kubotek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/4 AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Lantek</td>
<td>Lantek</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>LEIT2000</td>
<td>SAA</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>LP-System</td>
<td>Lennerts &amp; Partner</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>MagiCAD</td>
<td>Progman</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>MasterFrame</td>
<td>MasterSeries</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
</tr>
<tr>
<td>Maxon Cinema 4D</td>
<td>Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Maya</td>
<td>Autodesk</td>
<td>Autodesk (.dxf)</td>
<td>STEP AP203/4 AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Autodesk Maya Autodek (.dxf)</td>
</tr>
<tr>
<td>Meridian Prolog</td>
<td>Trimble</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>EVG (Filzmoser)</td>
<td></td>
<td>Unitechnik (.cam), BVBS (.abs)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>A.W.M.</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>Progress / EBAWE</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Microsoft</td>
<td>Microsoft</td>
<td>Project (.xml)</td>
<td>Project (.xml)</td>
</tr>
<tr>
<td>Office Project</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microstran</td>
<td>Engineering Systems Pty Limited</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Microstation</td>
<td>Bentley</td>
<td>Autodesk (.dwg), Autodesk (.dxf)</td>
<td>Autodesk (.dwg), Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Midas Gen</td>
<td>MIDAS</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td>ModeSt</td>
<td>Tecnisoft</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td>Multiframe</td>
<td>Daystar Software Inc.</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Nastran</td>
<td>MSC Software Corporation</td>
<td>Autodesk (.dwg), IGES (.iges, .igs)</td>
<td>Autodesk (.dwg), IGES (.iges, .igs)</td>
</tr>
<tr>
<td>NavisWorks</td>
<td>Autodesk</td>
<td></td>
<td>Autodesk (.dwg), CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>NiSA</td>
<td>Cranes Software International Ltd. / CSC</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>NX (Unigraph)</td>
<td>Siemens</td>
<td>Autodesk (.dwg), Autodesk (.dxf), IGES (.iges, .igs), STEP AP203/AP214 (.stp, .step)</td>
<td>Autodesk (.dwg), Autodesk (.dxf), STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>PDMS</td>
<td>AVEVA</td>
<td>Microstation (.dgn), Steel Detailing Neutral Format (.sdf, .sdnf, .dat), Tekla Collaboration files (.tczip)</td>
<td>Microstation (.dgn), Steel Detailing Neutral Format (.sdf, .sdnf, .dat), Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>PDS</td>
<td>Intergraph / Hexagon</td>
<td>Microstation (.dgn), Steel Detailing Neutral Format (.dat)</td>
<td>Microstation (.dgn), Steel Detailing Neutral Format (.dat)</td>
</tr>
<tr>
<td>PEMA WeldControl</td>
<td>Pemamek</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>PipeCAD</td>
<td>Mc4 Software</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>PipeDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>Autodesk (.dwg), Autodesk (.dxf), IFC2X3 (.ifc)</td>
<td>Autodesk (.dwg), Autodesk (.dxf), IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Pipelabo</td>
<td>Maruhide</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Plancal</td>
<td>Plancal Ag / Trimble</td>
<td>Autodesk (.dwg), Autodesk (.dxf)</td>
<td>Autodesk (.dwg), Autodesk (.dxf)</td>
</tr>
<tr>
<td>Plant-4D</td>
<td>CEA Technology</td>
<td></td>
<td>Autodesk (.dwg), Autodesk (.dxf), Microstation (.dgn)</td>
</tr>
<tr>
<td>PowerConnect</td>
<td>Buildsoft</td>
<td>Work in progress</td>
<td>Work in progress</td>
</tr>
<tr>
<td>PowerFrame</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>PRIAMOS</td>
<td>GTSdata</td>
<td>CPIxml (.xml), Unitechnik (.cam)</td>
<td></td>
</tr>
<tr>
<td>Primavera</td>
<td>Oracle</td>
<td>P6 (.xml)</td>
<td>P6 (.xml)</td>
</tr>
<tr>
<td>ProCAM</td>
<td>HGG</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>ProConcrete, ProSteel, ProStructures</td>
<td>Bentley</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Autodesk (.dwg), Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Pro/Engineer</td>
<td>PTC</td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>ProFit</td>
<td>Progress/EBAWE</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>Pro-Fit</td>
<td>Zeman</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>RAM (CAD Studio)</td>
<td>Bentley</td>
<td>Autocad (.dwg)</td>
<td>Autocad (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autocad (.dxf)</td>
<td>Autocad (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISM</td>
<td>ISM</td>
</tr>
<tr>
<td>Revit</td>
<td>Autodesk</td>
<td>Autocad (.dwg)</td>
<td>Autocad (.dwg)</td>
</tr>
<tr>
<td>Architecture/MEP</td>
<td></td>
<td>Autocad (.dxf)</td>
<td>Autocad (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>Raptor</td>
<td>Peddinghaus</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Revit Structure</td>
<td>Autodesk</td>
<td>Autocad (.dwg)</td>
<td>Autocad (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autocad (.dxf)</td>
<td>Autocad (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
</tbody>
</table>

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFEM</td>
<td>Dlubal</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Rhinoceros</td>
<td>McNeel North America</td>
<td>Autodesk (.dwg)&lt;br&gt;Autodesk (.dxf)&lt;br&gt;IGES (.iges, .igs)&lt;br&gt;Microstation (.dgn)&lt;br&gt;STEP AP203/AP214 (.stp, .step)&lt;br&gt;Geometry Gym link</td>
<td>Autodesk (.dwg)&lt;br&gt;Autodesk (.dxf)&lt;br&gt;Microstation (.dgn)&lt;br&gt;STEP AP214 (.stp, .step)&lt;br&gt;Geometry Gym link</td>
</tr>
<tr>
<td>RinasWeld</td>
<td>Kranendonk</td>
<td></td>
<td>IFC</td>
</tr>
<tr>
<td>RISA 3D (Suite)</td>
<td>Risa Technology</td>
<td>Autodesk (.dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;CIS/2 LPM6 design (.stp, .p21, .step)&lt;br&gt;Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Autodesk (.dxf)&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>RisaConnectio n</td>
<td>Risa Technology</td>
<td><strong>Direct Link</strong> (US market)</td>
<td><strong>Direct Link</strong> (US market)</td>
</tr>
<tr>
<td>Robot Millenium</td>
<td>Autodesk</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>RSTAB</td>
<td>Dlubal</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
<td><strong>Direct Link</strong>&lt;br&gt;CIS/2 LPM6 analytical (.stp, .p21, .step)&lt;br&gt;IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>SACS</td>
<td>Engineering Dynamics Inc.</td>
<td>Autodesk (.dxf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf)</td>
<td></td>
</tr>
<tr>
<td>SAFE</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td></td>
</tr>
<tr>
<td>SAM</td>
<td>Bestech Limited</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>SAP2000</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td>Schnell</td>
<td>Schnell Software</td>
<td></td>
<td>BVBS (.abs), Unitechnik (rebar/mesh)</td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCIA</td>
<td>Nemetschek</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf) .ifc</td>
<td>Autodesk (.dxf) .ifc</td>
</tr>
<tr>
<td>SDS/2</td>
<td>Design Data</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>S-FRAME</td>
<td>S-FRAME Software Inc.</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Sicam</td>
<td>Controlled Automation</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>SketchUp Make</td>
<td>Trimble</td>
<td>SketchUp (.skp)</td>
<td>SketchUp (.skp)</td>
</tr>
<tr>
<td>SketchUp Pro</td>
<td>Trimble</td>
<td>SketchUp (.skp)</td>
<td>SketchUp (.skp)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Smart 3D (SmartPlant / SmartMarine)</td>
<td>Intergraph / Hexagon</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc), with</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SmartPlant 3D</td>
<td></td>
</tr>
<tr>
<td>Solibri Model Checker/Model Viewer</td>
<td>Solibri</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SolidEdge</td>
<td>Siemens</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>Dassault</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td></td>
</tr>
<tr>
<td>Soulé</td>
<td>Soulé Software Inc.</td>
<td></td>
<td>.xml, BVBS (.abs)</td>
</tr>
<tr>
<td>SPACE GASS</td>
<td>SPACE GASS</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SpaceClaim</td>
<td>SpaceClaim Co.</td>
<td>Autodesk (.dwg)                                                                                                       Autodesk (.dwg)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)                                                                                                       Autodesk (.dx)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)                                                                                                    STEP AP203/AP214 (.stp, .step)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>ISM</td>
</tr>
<tr>
<td>STAAD.Pro</td>
<td>Bentley</td>
<td>Direct Link                                                                                                           Direct Link</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)                                                                                                       Autodesk (.dwg)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)                                                                                                       Autodesk (.dx)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, p21, .step)                                                                                Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)                                                                             Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>ISM</td>
</tr>
<tr>
<td>Steel Projects PLM</td>
<td>Steel Projects</td>
<td>Direct Link                                                                                                          Direct Link</td>
<td>ISM</td>
</tr>
<tr>
<td>Steel Smart System</td>
<td>Applied Science International, LLC</td>
<td>Autodesk (.dwg)                                                                                                      Autodesk (.dwg)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)                                                                                                       Autodesk (.dx)</td>
<td>ISM</td>
</tr>
<tr>
<td>StructureWorks</td>
<td>Structure Works LLC.</td>
<td>Autodesk (.dwg)                                                                                                      Autodesk (.dwg)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)                                                                                                       Autodesk (.dx)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)                                                                                                    STEP AP203/AP214 (.stp, .step)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>ISM</td>
</tr>
<tr>
<td>STRUDS</td>
<td>SoftTech</td>
<td>Direct Link                                                                                                          Direct Link</td>
<td>ISM</td>
</tr>
<tr>
<td>StruM.I.S</td>
<td>StruM.I.S</td>
<td>Direct Link                                                                                                          Direct Link</td>
<td>ISM</td>
</tr>
<tr>
<td>Tekla BIMsight</td>
<td>Trimble</td>
<td>Tekla BIMsight Project (.tbp)                                                                                            Tekla BIMsight Project (.tbp) *</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tekla BIMsight Project (.tbp)                                                                                            Tekla BIMsight Project (.tbp) *</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)                                                                                                       Autodesk (.dwg)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)                                                                                                    IFC2X3 (.ifc)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2x3 (.ifcXML)                                                                                                   IFCXML 2x3 (.ifcXML)</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCzip (.ifcZIP)                                                                                                       IFCzip (.ifcZIP)</td>
<td>ISM</td>
</tr>
<tr>
<td>Tekla Field3D</td>
<td>Trimble</td>
<td>.ifc                                                                                                                   .ifc</td>
<td>ISM</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Tekla Civil</td>
<td>Trimble</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LandXML files (.xml)</td>
<td>.ifc</td>
</tr>
<tr>
<td>Tekla Collaboration</td>
<td>Trimble</td>
<td>Tekla Collaboration files (.tczip)</td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>Tekla Structural Designer</td>
<td>Trimble</td>
<td>Neutral XML file .cxl</td>
<td>Neutral XML file .cxl</td>
</tr>
<tr>
<td>Trimble Business Centre</td>
<td>Trimble</td>
<td>LandXML files (.xml)</td>
<td></td>
</tr>
<tr>
<td>Trimble Connect</td>
<td>Trimble</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.ifc</td>
<td>.ifc</td>
</tr>
<tr>
<td>Trimble Field Link</td>
<td>Trimble</td>
<td></td>
<td>.tfl</td>
</tr>
<tr>
<td>Trimble LM80</td>
<td>Trimble</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LM80 (.cnx,.txt)</td>
<td>LM80 (.cnx,.txt)</td>
</tr>
<tr>
<td>Trimble LM80 Desktop</td>
<td>Trimble</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LM80 (.cnx,.txt)</td>
<td>LM80 (.cnx,.txt)</td>
</tr>
<tr>
<td>TurboCAD</td>
<td>IMSI Design</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>UniCAM</td>
<td>Unitechnik</td>
<td></td>
<td>Unitechnik (.cam,.uni)</td>
</tr>
<tr>
<td>Unigraphics</td>
<td>Siemens PLM Software</td>
<td></td>
<td>IGES (.iges,.igs)</td>
</tr>
<tr>
<td>Vacam</td>
<td>Voortman</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Vernon</td>
<td>Lincoln Electric</td>
<td></td>
<td>TubeNC (.xml)</td>
</tr>
<tr>
<td>VectorWorks</td>
<td>Nemetschek</td>
<td>IFC2X3 (.ifc)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Vico Office</td>
<td>Trimble</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td>-----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IfcXML 2X3 (.xml)</td>
<td>IfcXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>.xls</td>
<td></td>
<td>.xls</td>
<td>.xls</td>
</tr>
<tr>
<td>Vico Schedule</td>
<td>Trimble</td>
<td></td>
<td>Direct Link (.xml)</td>
</tr>
<tr>
<td>Planner</td>
<td></td>
<td>Direct Link (.xml)</td>
<td>.xml</td>
</tr>
<tr>
<td>Volo View</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
</tbody>
</table>
Tekla Structures has several tools you can use to import and export physical and reference models and the information they contain.

For details about compatible software in import and export, see Compatible software (page 13).

**NOTE** The import and export functionality is not available in all Tekla Structures configurations. For more information, see Tekla Structures configurations.

You can use import and export in Tekla Structures for several purposes:

- You can import reference models to Tekla Structures. For example, you can import an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model as a reference model. Reference models can also be simple 2D drawings that are imported and then used as a layout to directly build the model on.

- You can import 2D or 3D models created by other software, then detail or manipulate the structural objects using Tekla Structures. Once the model is complete, you can export it, and return it to the architect or engineer for review.

- You can create reports from the imported models from most of the formats.

- You can export Tekla Structures models for use in Analysis & Design (several formats). Then you can import the Analysis & Design results back to the Tekla Structures model.

- Various model transfers can be completed for the engineering and contractor phase of the project.

- You can import shapes from many formats. Shapes are used in defining items.
• You can export data for use in manufacturing information systems and in the fabrication phase:
  • You can export CNC data (Computer Numerical Control) for use by automated cutting, drilling and welding CNC machinery.
  • You can export to MIS (Manufacturing Information Systems) so that fabricators can track project progress, for example.

Click the links below to find out more about the various types of import and export:

Reference models and compatible formats (page 42)
IFC (page 67)
SketchUp (page 100)
DWG and DXF (page 101)
LandXML (page 128)
NC files (page 184)
PDF (page 130)
DGN (page 123)
CAD (page 131)
FEM (page 152)
ASCII (page 162)
Attribute import (page 166)
CIS and CIMSteel (page 173)
MIS (page 179)
FabTrol XML (page 181)
HMS (page 221)
ELiPLAN (page 226)
BVBS (page 235)
Unitechnik (page 244)
Layout Manager (page 287)
Tekla Web Viewer (page 302)
Tekla BIMsight (page 308)
Tekla Structural Designer (page 310)
Trimble Connector (page 319)

In addition to these built-in import and export tools you have a variety of links to other applications available in Tekla Warehouse that you can download.
6 Conversion files

Conversion files map Tekla Structures profile, twin profile, and material names with names used in other software. Conversion files are simple text files, containing the Tekla Structures name in the first column, and the name used in the other software package in the second column. Columns are separated by a space. All parametric profiles must be entered in the profile conversion file.

You can use the same conversion file both when importing and exporting models, and you can specify the location of conversion files in most of the import and export tools.

If you enter a conversion file name without a path, Tekla Structures searches for the file in the current model folder. If you leave the box empty, Tekla Structures searches for the file indicated by the advanced option XS_PROFDB in File menu --> Settings --> Advanced options --> File Locations. This is also the case, if the tool does not allow you to define the path and conversion file.

Tekla Structures has several conversion files in the standard installation, and you can also create your own. Standard conversion files are located in the
\environments\<environment>\profiles folder. All conversion files have the .cnv extension.

See also
Twin profile conversion files (page 33)
Create conversion files (page 34)

6.1 Twin profile conversion files

Tekla Structures contains separate conversion files for twin profiles, and it reads the twin profile conversion file before the profile conversion file, so you must include the profiles from the original model in the import.

The twin profile conversion file is a text file containing the profile prefix (characters only) and the distance between the profiles in mm, separated by a space. Tekla Structures converts all profiles with the specified prefix to twin profiles.

The twin profile conversion file could be named twin_profiles.cnv and it could contain lines such as the one below:

DL 20

The distance between the profiles is the same for all profiles with the same profile prefix. For example, profiles with the prefix DL will always have the same spacing. If you want different spacing values, then you need to use a different profile prefix.

You also need to add the twin profile to the profile conversion file to get the DL profile converted to L-profile:

L200*20 DL200/20-20

Limitations

• Twin profile conversion cannot be used for profiles that start with a number. This means that you cannot define double angles as 2L. Instead, you need to use DL as the prefix for a twin profile, for example: DL200/20-20.

• Twin profile conversion does not work for FEM import. We recommend that each angle is modeled separately rather than as twin profiles, as SP3D does not control the gaps between members in the same way as Tekla Structures and there are, for example, various conversion and mapping difficulties. It is easier to convert members that are modeled as two members.
6.2 Create conversion files

You can create your own conversion files if the ones that come with Tekla Structures installation do not suit your needs.

1. Open an existing conversion file using any standard text editor.
   By default, conversion files are located in ...\ProgramData\Tekla Structures<version>\environments<environment>\profile.

2. Save the file with another name.
   If the export/import tool allows you to define the path to the conversion file, you can save the file where you like. If this is not the case, save the file in a location defined by the advanced option XS_PROFD in File menu --> Settings --> Advanced options --> File Locations.

3. Modify the file: enter profile names recognized by Tekla Structures in the first column, and the corresponding name recognized by the other software in the second column.
   While modifying, ensure that:
   • You do not have blank material definitions (" ", empty quotation marks).
   • You do not have spaces in the profile position strings. For example, enter "Hand_Rail" not Hand Rail".

4. Save your changes.

NOTE
• All the three files (profile, twin profile and material) are not needed if the differences in the profile name is just concerning * X or x formats, because these are normally handled automatically. For example, if you wanted to import UC254x254x73 to be UC254*254*73, the lower case "x" is automatically changed to "X" so the format of the conversion file would be UC254*254*73 254X254X73.
• If you have problems importing the model, check any error messages in the Tekla Structures log file, and check the conversion files.

Example
Below are some examples of conversion files:

! Profile name conversion Tekla Structures --> SDNF
!
! If Converted-name does not exist, it will be the same as Tekla Structures-name.

! Tekla Structures-name Converted-name

C10X15.3  C10X15.3
C10X20  C10X20
C10X25  C10X25
C10X30  C10X30
C12X20.7  C12X20.7
C12X25  C12X25
C12X30  C12X30
C15X33.9  C15X33.9
C15X40  C15X40
C15X50  C15X50
C3X4.1  3X4.1

! Profile name conversion Tekla Structures -> DSTV
!

Below there is first an example of an incorrect conversion file and then of a correct one, errors are highlighted:

00100782 4 0 2 "brace" "Tread 4" 1 "TREAD4.5" "" 0.000000 0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143 15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
00100782 4 0 2 "brace" "Tread_4" 1 "TREAD4.5" "A36" 0.000000
0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Conversion files 36 Create conversion files
Define project base points for IFC export and reference model import

The base points allow you to use another coordinate system needed for interoperability and collaboration. You can use another coordinate system for inserting reference models and exporting IFC models. When you use base points, you can keep the coordinates small and locate the model wherever needed. You can create as many base points as you need.

Note the following:
• Reference model should not have any additional lines to the origin.
• Reference models should not include objects that are very far from each other because otherwise using the model may get difficult.
• Tekla Structures native objects including reference models should not be inserted very far from the Tekla Structures model origin.

7.1 Define a base point
You can define base points in Project properties. To create a base point, you need to know the coordinates of the reference model that you are importing, or the coordinates that you want to use in IFC export.

1. Open a Tekla Structures model where you want to add a base point.
2. Click File --> Project properties --> Base points to open the Base point dialog box.
3. Fill in the needed information:
<table>
<thead>
<tr>
<th>Name, Description</th>
<th>Enter a name and a description for the base point.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate system</td>
<td>Enter the name of the coordinate system you are using.</td>
</tr>
<tr>
<td>East coordinate (E)</td>
<td>Enter the <strong>East coordinate (E)</strong> that represents the corresponding X coordinate point in the other coordinate system.</td>
</tr>
<tr>
<td>North coordinate (N)</td>
<td>Enter the <strong>North coordinate (N)</strong> that represents the corresponding Y coordinate point in the other coordinate system.</td>
</tr>
<tr>
<td>Elevation</td>
<td>Enter the <strong>Elevation</strong> that represents the corresponding Z coordinate point in the other coordinate system.</td>
</tr>
<tr>
<td>Latitude, Longitude</td>
<td>Enter the <strong>Latitude</strong> and <strong>Longitude</strong> of the base point to be used in the IFC export.</td>
</tr>
<tr>
<td></td>
<td><strong>Latitude</strong> and <strong>Longitude</strong> is additional information, which some software can use. In the IFC file this is written to <strong>IFCSITE</strong> information.</td>
</tr>
</tbody>
</table>
If the total number of digits in Longitude is more than 15, the value is rounded up to the nearest if it is > 99.999999999999999999.

To convert Latitude and Longitude information between decimal format and degree/minute/second (DMS) format, see Convert Latitude/Longitude to decimal.

<table>
<thead>
<tr>
<th>Location in the model</th>
<th>Pick or enter a location for the base point in the Tekla Structures model.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle to North</td>
<td>Pick or enter the Angle to North, which is the angle between Y and North. Angle to North is 0 if North is equal to Y in the other coordinate system. The maximum number of decimals for the angle is 13.</td>
</tr>
</tbody>
</table>

4. Click **Modify** to save the base point.

A blue symbol is added in the model.

If you later on make changes to the base point, the base point location in the model changes according to the location or rotation changes you make in the **Base point** dialog box when you press **Enter** or click another input field, and there is no need to click **Modify**.

Now you can insert a reference model, or export an IFC model using the defined base point.
7.2 Insert a reference model using a base point

Before you can insert a reference at the base points, you need to create a base point in your model. To create the base point, you need to know the coordinates of the reference model that you are importing.

1. Open the Reference Models list by clicking the Reference Models button in the side pane.
2. In the Reference Models list, click the Add model button.
3. In the Add model dialog box, if you have any previously created reference model properties files, load the desired file by selecting the file from the properties file list at the top.
5. In Group, select a group for the reference model, or enter a name for a new group.
   If you do not enter a name for the group, the reference model is inserted in the Default group.
6. In Location by, select the base point you want to use.

7. Click the Add model button. Tekla Structures inserts the reference model relative to the selected base point by using the coordinate system values, elevation and angle in the base point definition in the model Project properties.
7.3 Export an IFC model using a base point

Before you can export an IFC file using a base point, you need to create a base point in your model.

1. Click File --> Export --> IFC to open the Export to IFC dialog box.
2. In Location by, select a base point that you have created.
3. Fill in other necessary IFC export information.
4. Click Export. The base point option exports the IFC model relative to the base point using the coordinate system values, elevation, latitude, longitude and angle in the base point definition in the model Project properties.
A reference model is a file that helps you to build a Tekla Structures model. A reference model is created in Tekla Structures or another software or modeling tool and imported to Tekla Structures.

For example, an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model can be used as a reference model. Reference models can also be simple 2D drawings that are imported and then used as a layout to directly build the model on. You can snap to reference model geometry.

Tekla Structures loads reference models only when they are needed, not every time you open a model. Tekla Structures does not save the reference model when you save the current model, but it saves the link to the reference model. The filename extension of a saved reference model properties file is .rmip.json. The values of Code, Title, Phase and Description cannot be saved in the standard properties file.

The following file types are supported:

- AutoCAD files .dxf
- AutoCAD files .dwg (supported version ACAD2014 and earlier)
- Cadmatic files .3dd
- IFC files .ifc, .ifczip, .ifcxml
- IGES files .igs, .iges
- LandXML files .xml
- MicroStation files .dgn, .prp
- PDF files .pdf
- Tekla Collaboration files .tczip
- SketchUp files .skp (supported version SketchUp 2016 and earlier)
- STEP files .stp, .STEP
Some reference models are automatically subdivided or split into reference model objects.

**TIP** You can disable the roll-over highlight, which should speed up zooming.

### Reference models in drawings
You can show reference models in drawings and adjust their visibility settings:
Show reference models in drawings.

**See also**
- Import a reference model (page 43)
- Modify reference model details (page 49)
- Lock reference models (page 50)
- View reference models (page 45)
- Detect changes between reference model versions (page 51)
- Define a comparison set for reference model change detection (page 56)
- Reference model objects (page 61)
- Inquire reference model contents (page 60)
- Examine reference model hierarchy and modify reference model objects (page 61)

### 8.1 Import a reference model
You can import reference models in a Tekla Structures model. You can use the reference models to overlay different discipline models with your own model. These disciplines can be architect, plant engineer, services engineer or other structural disciplines.

1. Open a Tekla Structures model where you want to insert the reference model.
2. Open the **Reference Models** list by clicking the **Reference Models** button in the side panel.
3. In the **Reference Models** list, click the **Add model** button.
4. In the **Add model** dialog box, if you have any previously created reference model properties files, load the desired file by selecting the file from the properties file list at the top.
5. In the **Add model** dialog box, browse for the reference model file by clicking **Browse**.
You can also drag reference models from Windows Explorer, and import several models at a time.

For a list of compatible formats, see Reference models and compatible formats (page 42).

6. Select a group for the model or enter the name of a new group.
   If you do not enter a name for the group, the reference model is inserted in the Default group.
   You can also drag models to an existing group or create a new group later on.

7. In Location by, select one of the following options:
   - **Model origin** inserts the model relative to 0,0,0.
   - **Work plane** inserts the model relative to the current work plane coordinate system.
   - **Base point: <name of base point>** inserts the model relative to the base point by using coordinate system values East, North, Elevation, and Angle to North from the base point definition (page 37) in Project properties.

8. Select where you want to place the reference model. You can enter coordinates in the Offset boxes or pick a position for the reference model origin.
   The maximum number of decimals for coordinates is 13.

9. Set the Scale of the reference model if it is different from the one in the Tekla Structures model.
   Note that you need to set the scale for a DWG or a DXF file already in AutoCAD. When you define the measurement unit for a DWG or a DXF file and save the file in AutoCAD, the unit is recognized in Tekla Structures, and the reference model is scaled correctly.
   The maximum number of decimals for scale is 13.

10. You can rotate the model around model Z axis by picking a location in the model or entering the desired value in the Rotation box.
    The maximum number of decimals for the rotation value is 7.

11. Click More to show more details and add the Code, Title, Phase and Description of the reference model.
    By default, the title is the same as the name of the imported reference model. You may want to use the name of the discipline or the company instead, for example. The code could be a site number, project number, or accounting number. Write the description according to the company
conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).

Below is an example of these details when you inquire the reference model.

<table>
<thead>
<tr>
<th>Group</th>
<th>Basement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>123456</td>
</tr>
<tr>
<td>ref_description</td>
<td>Basement</td>
</tr>
<tr>
<td>Title</td>
<td>First phase</td>
</tr>
<tr>
<td>RevisionPhase</td>
<td>la</td>
</tr>
</tbody>
</table>

You can also modify all the details after you have inserted the model.

12. Click **Add model**.

13. If the inserted reference model lies outside the work area and is not fully or at all visible in the model view, Tekla Structures displays the "Objects outside the work area" warning message. Click **Expand** to extend the work area to see the reference model in the model view.

The reference model is inserted in the current phase of the Tekla Structures model.

Note that for IFC reference models the elevation offset value is not read from the imported reference model.

When a reference model is imported or updated, reference model data is copied to Tekla Structures model internal data storage located in the `<current model>\datastorage\ref` folder. The reference model is visible even if the original file is removed from its original location. The reference model data in this folder should not be touched.

**NOTE**  
Do not import the same reference model to the Tekla Structures model several times. If there are duplicate reference models, there are also duplicate GUIDs.

When you want to update the reference model, do not delete the old reference model from an open Tekla Structures model and replace it with a new one, because then you would lose the work done on reference objects in the old model. Use the change detection functionality instead.

**See also**

*Modify reference model details (page 49)*

### 8.2 View reference models

There are many ways you can select what you want to show about the reference models and how.
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open the Reference Models list</strong></td>
<td>• Click the Reference Models button in the side pane on the right side of the Tekla Structures main window.</td>
</tr>
<tr>
<td><strong>Hide and show reference models</strong></td>
<td>• Click the eye button next to the model you want to hide.</td>
</tr>
<tr>
<td></td>
<td>The button changes to and the reference model is hidden in the 3D view.</td>
</tr>
<tr>
<td></td>
<td>• Click the eye button again to show the model.</td>
</tr>
<tr>
<td><strong>Hide and show a group of reference models</strong></td>
<td>• Click the eye button next to the group you want to hide. The group eye button and the reference model eye buttons all change to , and all the reference models included in the group are hidden in the Tekla Structures model.</td>
</tr>
<tr>
<td></td>
<td>• Click the eye button again to show all the models in the group.</td>
</tr>
<tr>
<td></td>
<td>• If a group contains both hidden and visible models, the eye button for the group looks like this .</td>
</tr>
<tr>
<td></td>
<td>• If there are no reference models in a group, the eye button looks like this .</td>
</tr>
<tr>
<td><strong>Highlight the reference model in the 3D view</strong></td>
<td>• Click the reference model in the Reference Models list.</td>
</tr>
<tr>
<td><strong>Show reference model details</strong></td>
<td>• Double-click the reference model in the Reference Models list.</td>
</tr>
<tr>
<td><strong>Show reference model object details</strong></td>
<td>1. Double-click the reference model in the Reference Models</td>
</tr>
<tr>
<td></td>
<td>2. Ensure that the Select assemblies selection switch (for assemblies) or Select objects in assemblies (for parts) is active.</td>
</tr>
<tr>
<td></td>
<td>3. Point the reference model, hold down Shift and scroll to the hierarchy level</td>
</tr>
<tr>
<td>To:</td>
<td>Do this:</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
</tr>
<tr>
<td>4. Point the object and double-click it to open the reference model object details.</td>
<td>where the desired reference model object is located.</td>
</tr>
<tr>
<td>Rotate the reference model around model Z axis.</td>
<td>Enter the desired value in the <strong>Rotation</strong> box. You can also pick the rotation.</td>
</tr>
<tr>
<td><strong>Hide and show reference model layers</strong></td>
<td>1. Double-click the reference model in the <strong>Reference Models</strong> list to open the details.</td>
</tr>
<tr>
<td></td>
<td>2. Click the small arrow on the <strong>Layers</strong> row to show the list of layers.</td>
</tr>
<tr>
<td></td>
<td>3. You can show and hide individual layers or all layers:</td>
</tr>
<tr>
<td></td>
<td>• To hide all layers, click the eye button on the <strong>Layers</strong> row.</td>
</tr>
<tr>
<td></td>
<td>• To hide individual layers, click the eye buttons of the individual layers.</td>
</tr>
<tr>
<td></td>
<td>• To hide several layers, holding down <strong>Ctrl</strong>, click the desired layers and then click the eye button of one of the selected layers.</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Layers</strong> list contains both hidden and visible layers, the eye button for the <strong>Layers</strong> row looks like this.</td>
</tr>
<tr>
<td></td>
<td>• If you hide all layers, the eye button for the <strong>Layers</strong> row changes to .</td>
</tr>
<tr>
<td></td>
<td>• If you hide individual layers, the eye button for the hidden layers changes to .</td>
</tr>
<tr>
<td><strong>Detect changes between different versions of reference models</strong></td>
<td>For details about change detection, see <strong>Detect changes between reference model versions (page 51)</strong>.</td>
</tr>
<tr>
<td></td>
<td>For details about comparison sets, see <strong>Define a comparison set for reference model change detection (page 56)</strong>.</td>
</tr>
<tr>
<td>To:</td>
<td>Do this:</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Refresh all reference models | • If the file name or path has not changed, open the **Reference Models** list and click the **Refresh** button.

All models that are not up to date are reloaded. If a reference model is not found, a warning sign is displayed.

• If the file name or path has not changed, open reference model details, browse for the new file and click **Modify**.

You can also refresh locked reference models, if you have set the advanced option **XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS** to **TRUE** in **File --> Settings --> Advanced options --> Import**. |
| Refresh a single reference model | 1. Double-click the reference model in the **Reference Models** list to open the details.

2. Click the **Refresh** button.

The model is reloaded. If the reference model is not found, a warning sign is displayed. |
| View user-defined attributes | 1. Double-click the reference model in the **Reference Models** list to open the details.

2. Click the small arrow on the **User-defined attributes** row to show the list of user-defined attributes.

3. The user-defined attributes that are specified for reference models in the **objects.inp** file are listed in the **User-defined attributes** list. Enter or select a value from the list. By default, the **objects.inp** is located in ..\ProgramData\Tekla Structures \version>\environments\common\inp. You may also have some **objects.inp** files that you modify and keep in firm or project folders. These files are read in certain order. |
8.3 Modify reference model details

After you have inserted a reference model, you can modify its details.

**Limitation:** Coordinates given in the **Details** area are always relative to model coordinates. You can modify the coordinate system only if model coordinate system is used in the reference model.

1. Click the **Reference Models** button \[\]\ in the side pane on the right of the Tekla Structures main window.
2. In the **Reference Models** list, double-click the reference model that you want to modify.
3. Click the arrow on the **Details** row, and change the desired details:
   - Change **Code**, **Title**, **Phase** and **Description** of the reference model.
     - The code could be a site number, project number, or accounting number. By default, the title is the same as the name of the imported reference model. You may want to use the name of the discipline or the company instead, for example. Write the description according to the company conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).
   - You can import another version of the reference model using the **File** box.
   - In the **Group** box, you can select a new group for the reference model.
   - You can also change the **Location by** selection.
     - If reference model is inserted by using a base point, and you change the **Location by**, the offset values are relative to the base point. When you click **Modify**, the model position changes according to **East coordinate**, **North coordinate** and **Elevation** setting differences.
   - You can change the **Offset** by entering new coordinates or by picking a new offset.
   - You can change the **Rotation** by entering a new value or picking a new location.
• Click the arrow on the **User-defined attributes** row, and enter values for the user-defined attributes.

You may enter strings (texts), select dates or enter numeric information depending on the type of the user-defined attribute. The reference model user-defined attributes are defined in their own section in the `objects.inp` file. If you have several `objects.inp` files, they are read in a specific reading order, for more information, see Customizing user-defined attributes.

4. Click **Modify**. The changes that you made are implemented in the reference model.

**See also**

Import a reference model (page 43)

---

### 8.4 Lock reference models

You can prevent reference models from moving and from detail updates by locking the reference models.

1. Click the **Reference Models** button in the side pane on the right of the Tekla Structures main window.

2. Move your mouse over the desired reference model in the **Reference Models** list.

   The **Lock** button is displayed.

   ![DuplexHouse_Heating_RME](image)

3. Click the **Lock** button.

   Now the reference model is locked. You can only add values for user-defined attributes and work with layers, but you cannot modify the details in any other way or move the model.

   ![DuplexHouse_Heating_RME](image)

   To lock multiple reference models, select the models from the list and click the **Lock** button of one of the reference models.
To unlock the reference model, click the Lock button again.

See also
Reference models and compatible formats (page 42)
Modify reference model details (page 49)

8.5 Detect changes between reference model versions

You can check the changes between different IFC reference model versions in Tekla Structures using change detection. You can use change detection to detect changes between reference models from different disciplines, such as engineer or detailer. Changes are detected on object level. You can also compare Tekla Structures models if you have exported a Tekla Structures model into IFC format at least twice.

Tekla Structures stores versions of the reference models for change detection. Versioning is also needed for visualizing sharing changes and object conversion change management.

Limitations
- Property comparison works only for IFC or IFC-based reference models. The following formats are supported:
  - .ifc
  - .ifcxml
  - .ifczip
  - .tczip

Change detection

You can show changes between two stored reference model versions or between stored version and browsed reference model file version. In both of these cases you need to activate change detection:

1. Open the Reference Models list by clicking the Reference Models button in the side pane.
2. Open a reference model by double-clicking the model in the Reference Models list.
3. Open the Change detection list by clicking the arrow on the Change detection row.
**Change detection between stored version and browsed model file version**

The file path box has automatically the full file path to the current reference model original file. If a reference model file with the same name has changed, you can run the change detection and skip steps 1 and 3 below.

1. Click ... and browse for an earlier version of the reference model.
2. Select the **This model is newer** check box next to the file path if you want to define that the file shown in the box is newer.
3. Ensure that you have both the original reference model and the browsed reference model version visible by setting the eye buttons active in the **Change detection** section.
4. To change the comparison set if needed, click the ... button and define the set you want to use. Then click **Update view**. The comparison set contains the properties that you want to use in version comparison.

You can do any of the following in the changes list and in the property details list:

- Click a row in the changes list to open the related property details list in the side pane. The content of the property details list depends on the comparison rules that you are using. The details list also indicates how the individual properties have changed in the **Old value** and **New value** columns.
• To show the object in the model, select the **Select objects in model** check box, and then click a row in the changes list. Note that you cannot select deleted objects.

• The older state of an object is drawn to the model view when you select the corresponding object in the changes list.

• To highlight the object in the changes list, select the **Get selected objects from model** check box, and then click an object in the model.

• To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. You can also zoom to deleted objects.

• The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.

• To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the **Changes list** button in the side pane. If the details list disappears, you can bring it back by clicking the **Properties details** button in the side pane. These two buttons are only visible when the **Change detection** command is active.

### Update reference model and detect changes between versions

You can update a reference model with another version of the model, and detect the changes between these two reference model versions.

1. Open another version of the reference model by browsing to it in the **File** box and click **Modify**.

   This updates the original reference model with the changed information in the other reference model version.

   You can open several versions, but you can only compare two versions at a time.

   You do not need to copy the reference models to the model folder.

2. On the **Change detection** row, click the arrow on the row to open the **Change detection** list.

   In the **Change detection** list, the current version is bolded. The newest version is at the top and the oldest at the bottom.

3. Ensure that both models are visible by setting the eye buttons active in the **Change detection** list.

   Comparison is active only when two eye buttons are active. You cannot have more than two eye buttons active at the same time. If you
activate a third reference model in the list, the older version from
previously visible model is automatically set inactive 🎤, and the
comparison is done between the two models that have the active eye.

4. Set another version as the current version in the Change detection list by
right-clicking the version in the list and selecting Set as current.

5. To change the comparison set, click the ... button and define the set you
want to use. Then click Update view. The comparison set contains the
properties that you want to use in version comparison.

6. To delete a version, right-click the version in the Change detection list,
and select Remove.

The current model version is modified, and this modification is shared in
multiuser mode or Tekla Model Sharing.

You need to pay special attention to versioning and updating in a project.
For example, if you remove a version, the current model is updated and
you may end up with conflicts.

7. Select any or all of the check boxes for the following options: Changed,
Unchanged, Inserted and/or Deleted, and then click the Update view
button, which is displayed when you select an option.

For example, select Inserted to show with green color the objects that
were inserted between the two versions.

The changes list and the details list are displayed. The changes list content
is based on the IFC content and has all physical object types. The colors
are the same as the ones in Change detection.

8. You can do any of the following in the changes list and in the details list:

- Click a row in the changes list to open the related property details list
  in the side pane. The property details list contains at least the name,
  location as origin and property set properties, basically the content is
  the same as in the reference object inquiry report. The details list also
  indicates how the individual properties have changed in the Old value
  and New value columns.

- To highlight the object in the model, select the Select objects in
  model check box, and then click a row in the changes list. Note that
  you cannot select deleted objects.
• To highlight the model object in the changes list, select the **Get selected objects from model** check box, and then click an object in the model.

• To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. You can also zoom to deleted objects.

• To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

• The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the **Changes list** button in the side pane. If the details list disappears, you can bring it back by clicking the **Properties details** button in the side pane. These two buttons are only visible when the **Change detection** command is active.

**Change comparison order**

• Select the **This model is newer** check box to define that the file shown in the file path box is newer than the other compared file. If the file has been updated, it appears in the box automatically and the check box is selected.

• It is possible to compare as newer (default) or older.

Select the **This file is newer** check box next to the file path box if you want to define that the file shown in the box is newer.

**Macro for selecting Tekla Structures native objects**

The **SelectCorrespondingObjectsBasedOnIfcObjectsSelection** macro is useful for cases where you exported native objects to IFC, inserted the IFC model back to the same native model, and then you want to select the corresponding Tekla Structures objects. You may need to select the
corresponding objects when you want to add your own UDAs to all updated and selected native objects, for example.

**Remove old reference model versions automatically**

You can remove old reference model versions automatically with the advanced option XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT.

**See also**

- Import a reference model (page 43)
- Convert IFC objects into native Tekla Structures objects (page 70)

### 8.6 Define a comparison set for reference model change detection

Change detection in Tekla Structures compares different versions of the reference model based on a comparison set, which tells you whether Tekla Structures considers a change in a property a change or not. You can use the standard property comparison set, or define a comparison set of your own.

In the reference model, when change detection is active, the changes list shows all deleted, changed, new and not changed objects. The property details list only contains those properties that are defined by the current comparison set rules to be compared.

When you save a comparison file, both the standard file and a customized comparison set file are saved to the \attributes folder under model folder. The standard file can only be removed from model folder if it exists in another other location. If saving or removing the standard file is not successful, you will get an error message.

#### Create a new comparison set

1. In Change detection, click the **Comparison sets** button ... to open the **Comparison sets** dialog box.
2. Enter a name for the comparison set.

   ![MyComparisonSet](image)

3. Add a new comparison rule by clicking the **Add row** button and typing or copying and pasting the property name.
   - You can copy and paste property names directly from the property details list in change detection.
• To include more properties within one rule, use asterisk (*), for example:
  X* (all that starts with X)
  *X (all that ends with X)

• If you want to compare only one property set property, clear the Property sets check box and create a separate rule for that property.
  If you want to compare all property sets but not one property, select the Property sets check box and create a rule for that property and leave its check box empty.

• Note that comparison rules are case insensitive.

• All rules in comparison set affect the comparison if the reference model version has a corresponding property.

4. Add more rules in the same way as in step 2 and 3.

5. To delete a rule, select the rule and click the Delete rule button. You cannot delete fixed comparison rules, like Geometry, Location, Rotation, Materials, Profiles, Products, Common attributes or Property sets, but you can exclude those from comparison by leaving the check boxes next to them empty.

6. Ensure that you have the check box selected next to all the comparison rules you want to include in the comparison set. If you do not want to include a rule, clear the check box.

7. Click the Save button.

8. Close the comparison set dialog box by clicking the Close button. If you have not saved your changes, you will be asked if you want to keep the changes when you close the dialog box.

9. Click the Update view button.
**Properties in comparison property set**

A comparison set may contain the following types of properties:

- Free property set properties, such as `BaseQuantities.NetVolume`
- Fixed properties that always exist in the comparison set file, but can be excluded from the comparison.

The fixed properties are listed below:

<table>
<thead>
<tr>
<th>Property type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>Object dimensions</td>
</tr>
<tr>
<td>Location</td>
<td>The coordinates of the object in the model</td>
</tr>
<tr>
<td>Rotation</td>
<td>The rotation coordinates of the object</td>
</tr>
<tr>
<td>Material</td>
<td>Material name and grade</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile name</td>
</tr>
<tr>
<td>Product</td>
<td>IfcProduct parameters that vary object type by type. Some properties are optional. Below examples of product properties for IfcColumn: Application full name, Application identifier, Change action, Creation date, Description, Family name, Given name, Is set last modified date, Last modified date, Middle names, Name, Object type, Organization description, Organization names, Organization roles, Roles</td>
</tr>
</tbody>
</table>

Reference models and compatible formats 58
Define a comparison set for reference model change detection
<table>
<thead>
<tr>
<th>Property type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>Common attributes</td>
<td>Below examples of common attributes for IfcColumn:</td>
</tr>
<tr>
<td></td>
<td>External Use</td>
</tr>
<tr>
<td></td>
<td>Fire Rating</td>
</tr>
<tr>
<td></td>
<td>Load bearing</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
<tr>
<td></td>
<td>COLUMNTYPE-&gt;GUID</td>
</tr>
<tr>
<td></td>
<td>GUID</td>
</tr>
<tr>
<td>Property sets</td>
<td>Whatever has been added to IFC properties.</td>
</tr>
<tr>
<td></td>
<td>Below examples of property set properties for IfcColumn:</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.Length [mm]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.NetWeight [kg]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.NetVolume [mm³]</td>
</tr>
<tr>
<td></td>
<td>BaseQuantities.OuterSurfaceArea [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Bottom elevation</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Class</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Phase</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Preliminary mark</td>
</tr>
<tr>
<td></td>
<td>Tekla Common.Top elevation</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Area per tons [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Gross footprint area [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Height [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Length [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Net surface area [m²]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Weight [kg]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Width [mm]</td>
</tr>
<tr>
<td></td>
<td>Tekla Quantity.Volume [mm³]</td>
</tr>
</tbody>
</table>

Reference models and compatible formats

59

Define a comparison set for reference model change detection
8.7 Inquire reference model contents

You can inquire the contents of a reference model. This is something you might want to do after importing a reference model into Tekla Structures.

1. On the ribbon, click **Inquire object**.
2. In your Tekla Structures model, click the reference model you want to examine.

The contents of the reference model are listed in the **Inquire Object** dialog box.

![Inquire Object dialog box](image)

Reference models and compatible formats 60 Inquire reference model contents
See also
Import a reference model (page 43)

8.8 Reference model objects

Some types of reference models are automatically subdivided into reference model objects, which is an individual part of an imported reference model. You can define user-defined attributes separately for each reference model object and use them for reports and the view and selection filters. They can also be moved to a Tekla Structures model that is currently being worked on. Information included in a reference model object can be saved in the model database.

The reference model objects are read-only.

Whether the reference model supports splitting depends on the file format and file structure. .ifc models are always automatically subdivided, and .dwg files that include any of the following objects, are also automatically subdivided:

- block table
- polyface mesh
- polygon mesh
- proxy object (for example, ADT)
- ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

TIP To report a needed reference object attribute you can inquire a reference object in the model to see the property name and then in Template Editor, add that property name to be reported in a Reference* row.

See also
Reference models and compatible formats (page 42)

8.9 Examine reference model hierarchy and modify reference model objects

You can view the reference model hierarchy and check the hierarchy level of different objects. You can also add user-defined attributes to the reference model objects. The added attributes can be used for filtering, for example. Additionally, you can view the native reference object attributes and properties.
1. Ensure that the **Select assemblies** selection switch (for assemblies) or **Select objects in assemblies** selection switch (for parts) is active.

2. Point the reference model, hold down **Shift** and scroll using the middle mouse button to the hierarchy level where the reference object is. Notice that if the cursor is too close to a grid, the hierarchy is not scrolled.

3. Do any of the following:
   - To inquire the native reference object properties and attributes, right-click the object and select **Inquire**.
   - To view or modify the user-defined attributes of a reference object, double-click the object to open the reference model object details.

**TIP** There are many more commands available for the selected reference model objects. Check rest of the commands on the pop-up menu.

Below is an example of a reference model representing a sanitary system. When you want to scroll the hierarchy, the selection switch **Select assemblies** or **Select objects in assemblies** must be on. The 0 level IfcProject in the example is the upmost level.

Below you can see one of the reference objects on the 3 level, IfcBuildingStorey, of the same reference model.
The last level, level 4, shows the individual parts.
In the example below, one of the reference objects on the lowest level has been inquired.
8.10 Reference model assemblies

Imported IFC reference models can contain assemblies. You can select reference model assemblies in the model view and view assembly level information in Tekla Structures.

- You can add user-defined attributes to reference model assemblies.
- You can use the **Inquire** command to view information on reference model assemblies. For example, you can view GUIDs of child objects.
• You can create reports to view information on reference model assemblies.

See also
Select reference models, reference model objects and assemblies
Inquire object properties
Create a report
REFERENCE_ASSEMBLY
IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the construction industry. IFC is developed as an open standard by buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects, such as building elements, between disciplines across the building life cycle. The principal benefit of IFC is the object description – not only does the IFC protocol preserve the full geometric description in 3D, but it also knows its location and relationships, as well as all the properties (or parameters) of each object.

See also
IFC import (page 70)
IFC interoperability concepts (page 67)
Convert IFC objects into native Tekla Structures objects (page 70)
IFC export (page 85)

9.1 IFC interoperability concepts

Some common terms and concepts used in IFC import, export, and conversion are explained below.

B-rep

B-rep or boundary representation is a method for representing shapes using the limits. A solid is represented as a collection of connected surface elements, showing the boundary between solid and non-solid.

CSG

CSG or Constructive Solid Geometry is a technique used in solid modeling. CSG allows a modeler to create a complex surface or object by using Boolean operations to combine simpler objects.
Boolean operations on sets

Union:

Intersection:
Difference:

**Extrusion**
Sweeping is allowing a two-dimensional planar cross section to sweep through space.

**Revolved extrusion**
A revolved extrusion or a solid of revolution is a solid object that is obtained by rotating a plane cross section around a straight line (the axis) that lies on the same plane.

**Arbitrary profiles**
In addition to parameterized profiles, there is a free profile shape type called *arbitrary profiles*. These profiles are defined by an ifcCurve, which may have linear and curved segments. Thin wall profiles can be defined by a centerline and a thickness. Other profiles are defined by a closed shape. Closed profile shape may or may not have inner voids.
Parameterized profiles
There are several parameterized profiles available in the IFC specification. Those include standard hot-rolled steel I, L, T, U, and Z profiles, cold formed C profiles, and generic rectangle and circle profiles with or without a hollow. These profiles are defined with their parameters, such as width, height, web thickness and flange thickness.

9.2 IFC import
You can import IFC models as reference models to Tekla Structures, and optionally convert the imported IFC objects into native Tekla Structures objects by using the IFC object converter or selected IFC reference objects using conversion change management. You can use imported IFC reference models, for example, in clash checking, reporting and scheduling.

Tekla Structures supports the following IFC schemas:
• IFC2X3 (recommended)
• IFC4
The IFC import functionality has the IFC certification granted by buildingSMART international. For a list of IFC-certified applications, see Certified Software.

For a list of applications/utilities that are purported, by their developers, to provide IFC import and/or export functionality, see List of all IFC applications.

The IFC reference model import (page 43) in Tekla Structures supports all the sub-objects of the IfcBuildingElement class and sub-objects of the IfcProduct class including:
• Architectural entities
• Structural entities
• Building services entities

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed (.ifcZIP) or uncompressed import files. IFC4 does not support ifcXML.

See also
Convert IFC objects into native Tekla Structures objects (page 70)
9.3 Convert IFC objects into native Tekla Structures objects

You can convert most linear IFC reference objects such as beams, columns, braces, plates, slabs, footings and walls into native Tekla Structures objects. Conversion also supports polybeams that have curved sections, and have originally been exported from Tekla Structures, and string, int and double type UDAs. The purpose of converting IFC objects in Tekla Structures is to help in the creation of the structural model and to avoid rework in an early modeling phase.

In IFC object conversion, IFC objects are converted either as items or as extrusions. Conversion as item means that an IFC object is converted as a Tekla Structures item, where the 3D shape defines the geometry of the item. Conversion as extrusion (page 67) means that an IFC object is converted as a part (column, beam, plate, etc.) that has a profile extruded to create the length of the part.

In IFC object conversion you need to do the following:

1. Before converting, check that the profiles and units in the IFC reference model are compatible with your environment.
2. Check the object conversion settings in the IFC object conversion settings dialog box and change them, if needed.
3. Convert the IFC objects to native Tekla Structures objects. There are two alternative ways available in object conversion:
   - Converting all selected reference model objects at one go using the Convert IFC objects button on the Manage tab.
   - Converting using the IFC object conversion change management. You can also perform an update conversion with a new reference model revision using the change management.

Is object conversion always necessary?

In Tekla Structures, reference model objects can be used in a way similar to the native objects, for example, in clash detection, reporting and scheduling. There is no need to have everything as native, because the reference model objects can also be used in many ways. For example, reference model objects can be shown in drawings and they can be listed in reports.

The reference files have the benefit compared to the copied files that the content of the files is automatically updated by the designer of that design discipline.

Check and change the IFC object conversion settings

Before you start converting, check the conversion settings and change them if necessary.
1. On the **File** tab, click **Settings --> IFC object conversion settings**.

2. In the **IFC object conversion settings** dialog box, check and change the conversion settings:

<table>
<thead>
<tr>
<th>Create report after conversion</th>
<th>Not used any longer. The changes list replaces the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Brep object</td>
<td>Convert B-rep objects into Tekla Structures objects. After conversion B-rep objects are converted to items, and the items are added to the shape catalog. The items belong to class 996.</td>
</tr>
<tr>
<td>Set handles to top flange</td>
<td>Set the reference lines of beams to top flange. If <strong>Set handles to top flange</strong> is not selected, the reference lines of beams are located in the middle of the beams.</td>
</tr>
<tr>
<td>Primary profile mapping</td>
<td><strong>Profile name</strong>: Map profiles primarily by comparing the profile names between the IFC model and Tekla Structures profile catalog. <strong>Dimensions</strong>: Map profiles primarily by comparing the object dimensions. If the <strong>IFC object converter</strong> cannot map profiles with the method you select as primary, it applies the secondary (unselected) method.</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Enter values for dimension comparison. The unit of measurement is based on the environment. The r value in <strong>Tolerance</strong> affects only rectangular hollow profiles. It is used to distinguish hot rolled profiles from cold rolled profiles.</td>
</tr>
</tbody>
</table>

3. Copy properties from the IFC object property sets to be used as user-defined attributes of converted Tekla Structures objects:
   a. Click **Add** to add a row and enter the name of the IFC property in the **Property** box.
   b. Enter the name of the user-defined attribute in the **UDA** box. The maximum length of the user-defined attribute name is 20 characters. The user-defined attribute that you add here must also be included in the objects.inp file. Ensure that the attribute name is unique. Enter the original name of the user-defined attribute, not the translation.
   c. Click **Type** to select the format of the attribute. The possible formats are string, integer or double.
4. Before you convert IFC objects into native Tekla Structures objects, check the profiles and materials to ensure that the conversion will be successful, and map the profiles or material manually in the following way:
   a. Click the **Check** button.
      Tekla Structures displays any missing profiles or materials on the **Missing Profiles** and **Missing Materials** tabs in the **Missing Mapping** dialog box.
   b. Select an appropriate option in the Tekla Structures profile and Tekla Structures material lists to define a mapping for the missing profiles or materials.
      The mapping of profiles works for IFC data that has a profile name but does not include enough information for conversion. You can change your mappings later if needed. The maps are used in conversion only if the profiles are not found from Tekla Structures catalogs. Profile conversion follows a certain logic (page 79).
   c. Click **Update Mapping Catalogs and Close**.
      You can also open and modify the catalog files in a text editor. To do this, click the **Catalog** button. When you are done, reopen the IFC object conversion settings to take the new settings in use. The files are located in the \attributes folder under the model folder:
      - **TeklaStructuresCatalogMaterials.txt** contains all materials
      - **TeklaStructuresCatalogProfiles.txt** contains all profiles
      - **MappedMaterials-default.txt** maps the materials
      - **MappedProfiles-default.txt** maps the profiles

5. Click **OK** in the **IFC object conversion settings** dialog box. Now you can convert the IFC objects using one of the two available ways.

**Convert selected IFC objects at one go**
You can convert all imported IFC objects at one go using the current object conversion settings. You need to have at least two or more revisions of the same model.
1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.
2. Click the **Add model** button, browse for the model in the **Add model** dialog box, and click **Add model** again.
3. In the model, select the objects that you want to convert.
4. Go to the ribbon, and on the **Manage** tab, click **Convert IFC objects**. The selected objects are converted on the basis of IFC conversion settings.
Conversion is done automatically for objects that have not been converted earlier. Converted IFC objects are listed in the changes list at the bottom. Each object is on a row of its own, and cuts are listed hierarchically under the related object.

- To select objects in model, activate the Select objects in model check box, and then click an object row. This also selects the related native object.
- To highlight the object in the changes list and show its details, select the Get selected objects from model check boxes, and then click an object in the model.
- To zoom to the selected object in the model, select the Zoom to selected check box, and then click a row in the changes list. The Zoom to selected check box is disabled if the Select objects in the model is not selected.
- To show only changes in the property details list, select the Show only changes check box, and then click a row in the changes list.
- The status of an object may be New (green) Changed (yellow), Deleted (red), or Up-to-date (white). If there were some problems with conversion, the row color is purple.
- The Conversion status column shows the resulting conversion status.
- The properties of a converted object are listed in the property details list that appears in the side pane when you click an object in the changes list.
5. You can update an object in the list by changing its conversion status to Conversion and clicking Apply changes.

6. If the lists disappear, click the following buttons that are only visible when the conversion changes list is active:

   • The Changes list button brings back the changes list.

   • The Property details button brings back the property details list.

Convert IFC objects using conversion change management - first conversion

Object conversion change management provides change detection and change management on object level. Conversion change management is needed in the initial data change management to reduce the challenges in construction projects. Objects are not converted automatically but you need to convert the objects using the conversion changes list.

1. Open the Reference Models list by clicking the Reference Models button.

2. Click Add model, browse for the model in the Add model dialog box, and click Add model again.

3. Double-click the model in the Reference Models list to open it, and then click the Start IFC conversion change management button.

   The current conversion status is displayed in the changes list and conversion management is activated. The status is based on reference model object physical changes and IFC conversion settings. The properties of a reference object are listed in the property details list that appears separately for each object when you click an object in the changes list.

   Use the Select objects in model view, Get selected objects from model, and Zoom to selected check boxes to review the model and the changes and details lists.
The reference object status and conversion status logic and colors:

<table>
<thead>
<tr>
<th>Reference object status</th>
<th>Conversion status</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>No conversion</td>
<td>Green</td>
</tr>
<tr>
<td>Changed</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Yellow</td>
</tr>
<tr>
<td>Deleted</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Red</td>
</tr>
<tr>
<td>Up-to-date</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>White</td>
</tr>
</tbody>
</table>

4. Convert objects by selecting the desired object rows, selecting Conversion in the Conversion status column and clicking Apply changes. The conversion is based on conversion settings. You can select multiple objects.
After conversion, the conversion status is either **Conversion as item** or **Conversion as extrusion** depending on the result of the conversion.

- **B-reps (page 67)** are shown as **Surface geometry**, **parametric (page 67)** profiles as **Parametric** and **arbitrary (page 67)** shapes as **Arbitrary**. Assembly is also **Arbitrary**, and so are the reference objects that are selected with the **Select objects in assemblies** or **Select objects in components** selection switches.

- If B-rep (**Surface geometry** in the **Type** column) conversion is selected, conversion is done as item, if not error.

- If object is **extrusion (page 67)** (**Arbitrary** or **Parametric** in the **Type** column), it is converted as extrusion.

- You can force conversion to be item by selecting **Conversion as item**. In this case, and extrusion object is also converted as item. The conversion does not check if same shape is already available, meaning new shape will always be created.

- You can force conversion to be extrusion by selecting **Conversion as extrusion**. In this case, B-rep is also converted as extrusion, profile is by mapping, or by bounding box if there is no mapping. This conversion result is not always as preferred.

- If the conversion fails, the result is written to the **Conversion status** column, and the row color is purple.

5. If the lists disappear, click the following buttons that are only visible when the conversion management is active:

- The **Changes list** button brings back the changes list.
- The **Property details** button brings back the property details list.

For troubleshooting information about IFC object conversion, see support article **Troubleshooting "Convert IFC objects..." failures** in Tekla User Assistance.

### Convert IFC objects using conversion change management - update conversion

If a previously converted reference object has changed in a newer reference model revision, you can compare the older and newer revisions of the reference model and update the conversion.

1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.

ICF 77

Convert IFC objects into native Tekla Structures objects
2. Open the older reference model revision by double-clicking it in the Reference Models list.

3. Update the reference model with a new revision of the reference model by selecting a new revision file in the File list in the Details section and clicking Modify.

4. Click the Start IFC conversion change management button.

5. Go through the changes:
   • Select the Select objects in model view and Zoom to selection check boxes to see the changed objects clearly in the model.
   • Click the changed row to see detailed changes in property details in the side pane.

6. You can update previously converted objects partially by selecting the Update check box next to a certain property in the property details pane. For example, if you only want to update the profile information, only select the Update check box next to the Profile row in the property details pane.

7. To convert all objects with changed conversion status, select all rows, change the Conversion status to Conversion and click Apply changes.
   • The objects that have a changed conversion status are converted on the basis of the current IFC object conversion settings.
   • You can update previously converted native model objects based on previous conversion type and settings by selecting Conversion in the Conversion status column. You cannot change the type from extrusion to item, in this case you need to delete the native objects and force conversion.
   • If the reference object status is Deleted, select Conversion and click Apply changes. This removes the native object and the link to the removed reference objects.

Macro for selecting converted IFC objects

The SelectConvertedObjectsBasedOnIfcObjectsSelection macro selects the objects that have been converted to native Tekla Structures objects. You may need to select the converted objects to check the properties of the native Tekla Structures objects, for example. This macro is located in the Applications section of the Applications & components catalog.

Class values

The status of the converted object is reported in the changes list in the Class column. Sometimes the input data in the IFC model is not adequate to
successfully create the converted object. The following table explains what the class values mean.

<table>
<thead>
<tr>
<th>Class value</th>
<th>IFC object data</th>
<th>Converted object description</th>
</tr>
</thead>
<tbody>
<tr>
<td>990</td>
<td>Parametric profile with a name</td>
<td>There is enough information in the IFC model to convert the object successfully.</td>
</tr>
<tr>
<td>991</td>
<td>Parametric profile without a name</td>
<td>Tekla Structures determines the name of the object based on the objects profile.</td>
</tr>
<tr>
<td>992</td>
<td>Arbitrary profile with a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.</td>
</tr>
<tr>
<td>993</td>
<td>Arbitrary profile without a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model. The profile name is set to UN KN OWN.</td>
</tr>
<tr>
<td>994</td>
<td>B-rep piece with a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.</td>
</tr>
<tr>
<td>995</td>
<td>B-rep piece without a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.              The profile name is set to UN KN OWN.</td>
</tr>
<tr>
<td>996</td>
<td>B-rep piece</td>
<td>The object is converted using the Convert B-rep object option in converter settings.             The converted B-rep object is either an item or a concrete item and is added to the shape catalog.</td>
</tr>
</tbody>
</table>
Profile conversion logic in IFC object conversion
Tekla Structures uses a certain logic in converting profiles in IFC object conversion.

Parametric profile used in IFC model, I-, L-, U-, C-, T-, Z-, Rectangle- and Circular type profiles can be defined parametrically:

1. If IFC file has been created with Tekla Structures, original profile name is used.
2. If profile with same name is found from Tekla Structures Profile Catalog, it will be used.
3. Otherwise, Tekla Structures checks parameter values to find a corresponding profile. If found, that will be used.
4. Otherwise, a default parametric profile is used.

Arbitrary profile used in IFC model, profile shape is defined with polygon:

1. If IFC file has been created with Tekla Structures, original profile name is used.
2. If the shape is detected and found from Tekla Structures catalog, that profile will be used. The shape detection supports the standard types of hot rolled profiles.
3. Otherwise, a new profile is created based on the description of the arbitrary profile.

B-rep geometry used in IFC model, object is defined with surfaces and profile geometry information is not available:

1. If corresponding item exists in Tekla Structures model, it is used.
2. Otherwise, a new item will be created and used.

If Conversion as item is used for extrusion type of part, new item is always created.

See also
Convert IFC objects into native Tekla Structures objects (page 70)
Example: Convert IFC objects into Tekla Structures objects in one go

In this example, you use an IFC model as a basis for your structural model. You will convert the beams and columns into native Tekla Structures objects.

1. Hide irrelevant IFC layers:
   a. Click the Reference Models button.
   b. In the Reference Models list, double-click the reference model to open the details.
   c. Open the Layers list by clicking the down arrow on the right.
   d. Hide the unnecessary layers by clicking the eye button next to the layer.
2. Select all visible IFC objects.
3. On the Manage tab, click Convert IFC objects.
   Tekla Structures converts the reference objects.
4. Check the profiles and materials of the IFC objects and map missing material:
   a. On the File menu, click Settings --> IFC object conversion settings.
   b. Click Check.
      Tekla Structures lists the missing profiles and materials.
   c. View the Missing Profiles and Missing Materials tabs.
      Tekla Structures lists a missing reference part material Concrete Block.
   d. Select CONCRETE_UNDEFINED from the list.
   e. Click Update Mapping Catalogs and Close.
   f. Select the Create report after conversion check box.
   g. Click OK in the IFC object conversion dialog box.
5. On the Manage tab, click Convert IFC objects again.
Tekla Structures converts the objects.

The Class for all the converted objects is 992. That means that the profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.

6. Check the conversion changes list:
   - Select objects in the changes list to highlight them in the model: Use the buttons Select objects in model view and Zoom to selected.
   - Compare the converted objects with the IFC objects.
   - Use the Inquire objects button on the ribbon to view detailed information on objects.
Below is an image of converted beams and columns.

See also

Convert IFC objects into native Tekla Structures objects (page 70)

Limitations in IFC object conversion

Tekla Structures is dependent on the quality of the IFC model, because it uses information available in the model when converting objects.

Tekla Structures converts most linear IFC objects to native Tekla Structures objects.

The following limitations exist in IFC object conversion:

- If the IFC model does not comply with standard, it might not be converted as expected.
- Bolts, reinforcement and welds cannot be converted to native Tekla Structures objects.
- Only SweptSolid, Brep, CSG and Clipping representations are supported.
- Multiple representations for one object are not supported.
Profile offset is not supported.
Profiles with more than 99 polygon points are not converted correctly.
Sometimes, chamfers may be converted incorrectly.

See also
Convert IFC objects into native Tekla Structures objects (page 70)

9.4 IFC export
You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams, columns, braces, slabs, panels, plates, reinforcing bars, and bolts with nuts and washers.

Tekla Structures exports the model objects on the basis of the export settings you define, including the property sets.

The IFC export functionality in Tekla Structures supports the IFC2X3 schema. The IFC export functionality has the IFC certification granted by buildingSMART international Certified Software.

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed (.ifcZIP) or uncompressed import files.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the resulting IFC entities for the exported model Tekla Structures model objects and the IFC export settings, and then export Tekla Structures model or a part of it into a IFC file</td>
<td>Export a Tekla Structures model or selected model objects to an IFC file (page 89)</td>
</tr>
<tr>
<td>To</td>
<td>Click the links below to find out more</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test the reference model after creating it</td>
<td>Check the exported IFC model (page 95)</td>
</tr>
<tr>
<td>Check what kind of base quantity information is included in the</td>
<td>IFC base quantities in exported IFC model (page 95)</td>
</tr>
<tr>
<td>Quantity takeoff add-on view</td>
<td></td>
</tr>
<tr>
<td>Take a look at the property set configuration files</td>
<td>Property set configuration files used in IFC export (page 96)</td>
</tr>
<tr>
<td>Create additional property sets out of template attributes and</td>
<td>Define additional property sets for IFC export (page 86)</td>
</tr>
<tr>
<td>user-defined attributes, define property definitions for the</td>
<td></td>
</tr>
<tr>
<td>attributes, and bind the property sets to IFC entities to be used in IFC export</td>
<td></td>
</tr>
</tbody>
</table>

**Define additional property sets for IFC export**

You can create additional property sets out of template attributes and user-defined attributes, define properties for the attributes, and bind the Tekla Structures property sets to IFC entities for IFC export. Tekla Structures saves additional property sets in configuration files. You can keep several configuration files in several locations. When Tekla Structures exports an IFC file, it reads the predefined property sets and the additional property sets.

*Add a new IFC property set configuration file*

1. On the **File** menu, click **Export --> IFC**.
2. Select **<new>** in the **Additional property sets** list and click **Edit**. If you have copied one of the predefined configuration files in the model folder, open that one.
3. For a new configuration file, in the **Property Set Definitions** dialog box, enter a name for the configuration file in the **Name** box.
4. Enter a name for the property set next to the **New** button and click **New**. You can also select one of the property sets in the **Property sets** list.

You can create several property sets in one configuration file. For example, you can add COGs, and start and end points on the part level, and scheduling information on the assembly level.
5. For a new property set, enter a description for the property set in the empty box.

6. Select an entity type from the Select entity types list by selecting its check box.

   When you do this, the Select attributes list shows the attributes that are available for the selected entity type.

7. Add the desired attributes from the Select attributes list by selecting the check boxes next to the attribute names.

   The attribute is added to the List of all selected properties list on the right. This list shows which attributes are exported and in which format:

   • You can add new attributes by entering an attribute name in the Attribute box in the Create/Modify property area and clicking the Add button.
   
   • You can modify and remove attributes on the list by selecting the attributes on the list and clicking Modify or Remove.

8. Under Create/Modify property, define the attribute properties:

   • Select Property type for the selected attribute.

   Here, always select Template attribute for those user-defined attributes whose name contains more than 19 characters. For example, select Template attribute for ASSEMBLY.USERDEFINED.PLANS_STATUS.

   • Enter or modify the name of the selected attribute in the name box Name.

   • Select the Type of the attribute. The Type can be one of the following: String (sequence of characters), Boolean (false or true), Integer (number without a fractional part), Measurement, Real (numbers that have decimal representations), or Time stamp.

   • If the type of the user-defined attribute is Measurement:

   • You can select the Measurement type: Length, Area, Volume, Mass, Positive length or Count.

   • You can select the Conversion factor and Accuracy.

   User-definable accuracy allows better IFC file size optimization.

9. Click Save to save your modifications.
1) The entity groups where Tekla Structures attributes are written in the exported IFC file

2) The template attributes or user-defined attributes that you want to export for the selected entity

3) List showing the selected attributes

4) The properties that you can define for the attributes

**Tekla Structures model objects and corresponding IFC entities**

<table>
<thead>
<tr>
<th>Tekla Structures object</th>
<th>IFC entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IfcBeam (IfcMember)</td>
</tr>
<tr>
<td>Column</td>
<td>IfcColumn, (IfcPile), (IfcMember)</td>
</tr>
<tr>
<td>Polybeam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Tekla Structures object</td>
<td>IFC entity</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Curved beam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Pad footing, Strip footing</td>
<td>IfcFooting</td>
</tr>
<tr>
<td>Slab</td>
<td>IfcSlab</td>
</tr>
<tr>
<td>Panel</td>
<td>IfcWall or IfcWallStandardCase</td>
</tr>
<tr>
<td>Contour plate</td>
<td>IfcPlate or IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bolts, nuts and washers</td>
<td>IfcMechanicalFastener</td>
</tr>
<tr>
<td>Bolt hole</td>
<td>IfcOpeningElement</td>
</tr>
<tr>
<td>Vertical braces</td>
<td>IfcMember</td>
</tr>
<tr>
<td>Railing: Beam, Column</td>
<td>IfcBeam, IfcColumn, (IfcRailing)</td>
</tr>
<tr>
<td>Assembly, cast unit</td>
<td>IfcElementAssembly, (IfcRailing), (IfcRamp), (IfcRoof), (IfcStair), (IfcWall)</td>
</tr>
<tr>
<td>Tekla Structures project</td>
<td>IfcProject</td>
</tr>
<tr>
<td>Assembly sub-part</td>
<td>IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bar, wire, strand, mesh, tendon, and</td>
<td>(IfcReinforcingElement)</td>
</tr>
<tr>
<td>other component embedded in concrete</td>
<td></td>
</tr>
<tr>
<td>Reinforcement</td>
<td>IfcReinforcingBar</td>
</tr>
<tr>
<td>Pour object, pour break</td>
<td>IfcBuildingElementProxy</td>
</tr>
<tr>
<td>Surface treatment</td>
<td>IfcCovering</td>
</tr>
<tr>
<td>Weld</td>
<td>IfcFastener</td>
</tr>
</tbody>
</table>

**NOTE** • If the entity is not in parenthesis in the table above, the object is automatically exported to this entity type. If an entity is in parenthesis, the object is not exported to this entity type automatically, but you can select the entity for the object on the **IFC export** tab.

• The IfcBuildingElementPart and IfcBuildingElement entities can also be used. IfcBuildingElement matches beams, columns, etc, but not assemblies.

• Polybeams are always exported as B-rep (page 67).

---

**Export a Tekla Structures model or selected model objects to an IFC file**
You can export Tekla Structures model or a part of the model into an IFC file.

Before you start the export:

• Define the IFC entities for Tekla Structures model objects.

• Define the needed property sets (page 86).
• If you export the IFC file using the base point, define the **base point** (page 37).

• Note that to successfully export concrete parts, ensure that the advanced option `XS_ENABLE_POUR_MANAGEMENT` is set to `FALSE`. To export pour objects instead of the concrete parts, set the advanced option `XS_ENABLE_POUR_MANAGEMENT` to `TRUE` and select the **Pour objects** check box on the **Advanced** tab of the **Export to IFC** dialog box.

### Define IFC entities for Tekla Structures model objects

Before you export Tekla Structures model objects to IFC, you can define the resulting IFC entities for the exported model objects in the user-defined attributes of the objects.

1. Double-click an object, for example a column, to open the part properties dialog box, and click the **User-defined attributes** button.

2. On the **Parameters** tab, set **Load bearing** to **Yes**, if you want to define the user-defined attribute `LOAD_BEARING` for the exported object.
   
   Set this option to **No** for all non-load bearing objects. **Yes** is the default value.

3. On the **IFC export** tab, select an option in the **IFC entity** list to define the IFC entity for the exported model object.

   Below is a list of entities available for a different types of Tekla Structures objects:

<table>
<thead>
<tr>
<th>Tekla Structures object</th>
<th>IFC entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IfcBeam (IfcMember)</td>
</tr>
<tr>
<td>Column</td>
<td>IfcColumn, (IfcPile), (IfcMember)</td>
</tr>
<tr>
<td>Polybeam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Curved beam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Pad footing, Strip footing</td>
<td>IfcFooting</td>
</tr>
<tr>
<td>Slab</td>
<td>IfcSlab</td>
</tr>
<tr>
<td>Panel</td>
<td>IfcWall or IfcWallStandardCase</td>
</tr>
<tr>
<td>Contour plate</td>
<td>IfcPlate or IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bolts, nuts and washers</td>
<td>IfcMechanicalFastener</td>
</tr>
<tr>
<td>Bolt hole</td>
<td>IfcOpeningElement</td>
</tr>
<tr>
<td>Vertical braces</td>
<td>IfcMember</td>
</tr>
<tr>
<td>Railing: Beam, Column</td>
<td>IfcBeam, IfcColumn, (IfcRailing)</td>
</tr>
<tr>
<td>Assembly, cast unit</td>
<td>IfcElementAssembly, (IfcRailing), (IfcRamp), (IfcRoof), (IfcStair), (IfcWall)</td>
</tr>
<tr>
<td>Tekla Structures project</td>
<td>IfcProject</td>
</tr>
<tr>
<td>Assembly sub-part</td>
<td>IfcDiscreteAccessory</td>
</tr>
</tbody>
</table>
Bar, wire, strand, mesh, tendon, and other component embedded in concrete (IfcReinforcingElement)

Reinforcement IfcReinforcingBar
Pour object, pour break IfcBuildingElementProxy
Surface treatment IfcCovering
Weld IfcFastener

NOTE • If the entity is not in parenthesis in the table above, the object is automatically exported to this entity type. If an entity is in parenthesis, the object is not exported to this entity type automatically, but you can select the entity for the object on the IFC export tab.

• The IfcBuildingElementPart and IfcBuildingElement entities can also be used. IfcBuildingElement matches beams, columns, etc, but not assemblies.

• Polybeams are always exported as B-rep (page 67).

4. In the IFC export type list, select Auto or Brep:
   • The Auto option will automatically select what kind of Swept Solid IFC object a Tekla object becomes in the IFC.
   • If Auto fails for some reason (such as with a deformation), the export reverts to Brep automatically, and creates a mesh-based IFC object with less intelligence. These objects are data heavy but still geometrically correct.
   • Brep will force the IFC object to be always mesh based.

5. Click OK in the user-defined attributes dialog box.

6. Click OK in the part properties dialog box.

Export to IFC

1. Select the model objects to export.
   If you want to export all model objects, you do not have to select anything.

2. On the File menu, click Export --> IFC.

3. Browse for the Output file location and replace the name out with the desired file name.

   IFC files are by default exported to the \IFC folder under the model folder. The length of the file path is limited to 80 characters. You do not need to enter the file name extension, it will be automatically added according to the selected File format.
4. Define the export settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
<td>tab</td>
</tr>
<tr>
<td><strong>File format</strong></td>
<td>The options are IFC, IFC XML, zipped IFC, and zipped IFC XML.</td>
</tr>
</tbody>
</table>
| **Export type** | **Surface geometry** is ideal when the need is to view the model without any need for re-using or editing:  
  - Reinforcing bars are exported as B-rep (page 67).  
  - Export does not support CSG (page 67) (Constructive Solid Geometry).  
  - Curved elements are exported as B-rep.  
  - Bolts are exported as B-rep.  
  The certified **Coordination view 2.0** is recommended to be used when the geometry needs to be edited and modified in the receiving application:  
  - Reinforcing bars are exported as extrusions (page 67).  
  - Export uses CSG (Constructive Solid Geometry) for presenting cuts and voids.  
  - Curved elements are exported as extrusions.  
  - Bolts are exported as B-rep.  
  **Steel fabrication view** is recommended for exporting detailed information on steel objects for steel fabrication:  
  - Exports assembly presentation and dedicated property sets.  
  - Bolt holes are exported as voids.  
  - Steel fabrication model view configuration file for property sets and properties (IfcPropertySetConfigurations_AISC.xml) is included in the installation by default.  
  **Coordination view 1.0** is recommended to be used instead of **Coordination view 2.0** when you need to have voids and openings presented by using opening elements:  
  - Reinforcing bars are exported as extrusions. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Voids and openings are exported as opening elements (ifcOpeningElements).  
• Curved elements are exported as extrusions.  
• Bolts are exported as B-rep. | **Which export type to select?**  
• The certified **Coordination view 2.0** should be your default.  
• If the model is used only for viewing purposes, or as a reference model, **Surface geometry** is your choice.  
• **Coordination view 1.0** is for those who need to export openings as separate objects.  
• **Steel fabrication view** is for the fabrication workflow, and to be provided for manufacturing. |
| Additional property sets | • To define a new property set (page 86), select `<new>` and click **Edit**.  
• To use an additional property set created earlier, select the property set from the **Additional property sets** list. |
| Location by | **Model origin** exports the model relative to 0,0,0.  
**Work plane** exports the model relative to the current work plane coordinate system.  
**Base point:** `<name of base point>` exports the model relative to the base point using coordinate system values **East**, **North**, **Elevation**, **Angle to North** and **Latitude/Longitude** from the base point definition (page 37) in **Project properties**. |
| Advanced tab | **Object types**  
Select the object types to export.  
If you select **Pour objects**, cast in place concrete parts are exported as pour objects.  
If you select **Assemblies**, you can exclude single part assemblies by selecting **Exclude single part assemblies** in the **Other** area. |
<p>| Property sets | The option <strong>Base quantities</strong> includes in the exported IFC file a <strong>Quantity takeoff add-on view</strong> |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>containing additional information on the entities in the exported IFC model. For more information about the base quantities, see IFC base quantities in exported IFC model (page 95).</td>
</tr>
<tr>
<td></td>
<td><strong>Property sets: Default</strong> exports the default set of properties. <strong>Property sets: Minimum</strong> exports the minimum set of properties required by the buildingSMART IFC standard. To view the property sets, click View.</td>
</tr>
<tr>
<td>Other</td>
<td><strong>Layer names as part names</strong> uses part names, such as COLUMN and BEAM, as layer names for exported objects. <strong>Export flat and wide beams as plates</strong> exports flat and wide beams as plates. Select this option if you have modeled plates as beams or columns with flat profiles. For example, some system components use beams or columns instead of plates. <strong>Use current view colors</strong> exports the objects using the colors defined in object representation, not the class colors. Note that exporting object transparency settings is not supported. Select <strong>Exclude single part assemblies</strong> when you export assemblies. <strong>Locations from Organizer</strong> uses the spatial hierarchy created in Organizer in export. Do the following: a. Select Locations from Organizer. b. Create a project hierarchy in Organizer. c. In Organizer, right-click the project, and select Use for reporting. d. Before the IFC export, synchronize or write the Organizer data in the Tekla Structures model by right-clicking the project in Organizer, and selecting Write to model for reporting.</td>
</tr>
</tbody>
</table>
|                             | 5. Select either Selected objects or All objects to define the object selection for the export.  
6. Click Export.                                                                                                           |

**IFC** 94 **IFC export**
Check the exported IFC model
We recommend that you test the reference model after creating it.

To check the exported IFC model (page 89), insert the model as reference model to the original Tekla Structures model.

Check the following things:

- Check the IFC model visually. Use different colors for the IFC model and the original model. Use clip planes to check the model thoroughly.
- Compare the number of objects. If there are differences, check the export log.
- Check the modeling of unsuccessfully exported objects. For example, unnecessary cuts may result in unsuccessful export. Consider remodeling the incorrect objects or set IFC export type to Brep for the objects.

TIP You can also use Trimble Connector (page 319) for viewing and checking the IFC model.

IFC base quantities in exported IFC model
Base quantities are quantity definitions that are independent of a particular method of measurement and therefore internationally applicable. Base quantities are defined as gross and net values and provided by measurement of the correct geometric shape representation of the element. Additional Quantity takeoff add-on view is included to the exported IFC model if you set Base quantities to Yes in the Tekla Structures IFC Export dialog box.

The Quantity takeoff add-on view contains the following base quantity information on the entities in the exported IFC model:

<table>
<thead>
<tr>
<th></th>
<th>Beam</th>
<th>Column</th>
<th>Slab</th>
<th>Wall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Height</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Length</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Net area</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Outer surface area</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gross footprint area</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Net volume</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Net weight</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
NOTE To include the base quantities in a published Tekla BIMsight model, in Publish to TeklaBIMsight dialog box, select the Base quantities check box.

Property set configuration files used in IFC export
Tekla Structures uses configuration files for defining which user-defined attributes and template attributes are exported as property sets into IFC models. When you export to IFC, you select one predefined configuration file as Export type that you use as a main property set. In addition, you can define your own property set to add additional information to exported IFC models.

Predefined property set configuration files
The predefined configuration files are read-only and they are located in ..\ProgramData\Tekla Structures\<version>\Environments\Common\inp.

- IfcPropertySetConfigurations_CV2.xml (Default property sets)/IfcPropertySetConfigurations_CV2_1.xml (Minimum property sets) contains the property sets for Export type Coordination view 2.0.
- IfcPropertySetConfigurations_SG.xml (Default property sets)/IfcPropertySetConfigurations_SG_1.xml (Minimum property sets) contains the property sets for Export type Surface geometry.
- IfcPropertySetConfigurations_AISC.xml (Default property sets)/IfcPropertySetConfigurations_AISC_1.xml (Minimum property sets) contains the property sets for Export type Steel fabrication view.

The IfcPropertySetConfigurations_CV1.xsd file in the same folder is a schema file that describes the structure of the XML file and is used for validation of the XML file. This file is read when the software is started.

Additional property set configuration files
When you configure property sets for IFC export in XML format, you need two files:

- IfcPropertySetConfigurations.xsd is a schema file that describes the structure of the XML file and is used for validation of the XML file. This file is read when the software is started.
- IfcPropertySetConfigurations.xml is the actual property set configuration file.

We recommend you define the additional property sets (page 86) in the Property Set Definition dialog to ensure that the XML configuration files are valid. The additional property sets you create are saved to the \AdditionalPSets folder under the model folder by default. You can also read additional property sets from the following folders:
If you use the above mentioned folders, please save the files in a folder called \AdditionalPSets under the system, project or firm folder.

Property set configuration file contents

- A configuration file includes the structure of property sets, and the data definitions for the properties inside the property sets:
  - Template attribute or UDA name. Template attributes are read from content_attributes_global.lst and the user-defined attributes from the environment database.
  - Data type, such as String, Integer, Float, Timestamp, Boolean, Logical, or planeanglemeasure.
  - Unit type, such as length, area, volume, or mass.
  - Unit value scaling of unitless UDA values. Conversion factor is added so that unitless values can be converted to correspond to the global units used in the IFC files. Area and volume units need these factors.
  - Possibility to use default values.
  - Possibility to ignore the set to export if template attribute or UDA does not have a value.

- A configuration file includes property set binding rules to IFC entities:
  - Binding to IFC entity type hierarchy including support for not only building elements but also for bolts, reinforcing bars, and assemblies.
  - Possibility to use limiting rules, such as Equal, NotEqual, LessThan, GreaterThan, LessThanOrEqual, and GreaterThanOrEqual for numbers, and Equal and NotEqual for texts.
    You need to modify your additional property set configuration file using a suitable editor, if you want to add these limiting rules.
  - There can be any number of binding rules for any property set, but only one property set definition for each ReferenceId.
  - You can bind different property sets to different IFC entity types. For example, a plate may have a different property set than a beam.
  - If no value is found for a property in export, the export does not write the property set at all. To avoid this, add optional=true for that property in the property set.

Below is an example of the contents of the IfcPropertySetConfigurations_CV2.xml file.
Below is an example of the contents of the IfcPropertySetConfigurations.xml file.
<PropertySetBind referenceId="simpleOptional">
  <Rules>
    <Include subtypes="true" entityType="IfcFooting">
      <Where>
        <!-- Multiple constraints are also possible. Using multiple include rules allows optional constraints sets -->
        <!-- E.g., Any footing that is not made of concrete and has user defined field 1 set between 2 and 3, OR any footing that field 1 set to 1 and has user defined field 2 set between 0 and 42, except 10 -->
        <Compare comparisonOperator="LessThen" xsl-type="IntegerCompareType">
          <GetValue xsl-type="TemplateVariableType">
            <TemplateName>USER_FIELD_1</TemplateName>
          </GetValue>
          <ReferenceValue>4</ReferenceValue>
        </Compare>
        <Compare comparisonOperator="GreaterThan" xsl-type="IntegerCompareType">
          <GetValue xsl-type="UdaVariableType">
            <UdaName>USER_FIELD_1</UdaName>
          </GetValue>
          <ReferenceValue>1</ReferenceValue>
        </Compare>
        <Compare comparisonOperator="NotEqual" xsl-type="StringCompareType">
          <GetValue xsl-type="TemplateVariableType">
            <TemplateName>MATERIAL_TYPE</TemplateName>
          </GetValue>
          <ReferenceValue>CONCRETE</ReferenceValue>
        </Compare>
      </Where>
    </Include>
    <Include subtypes="true" entityType="IfcFooting">
      <Where>
        <Compare comparisonOperator="Equal" xsl-type="IntegerCompareType">
          <GetValue xsl-type="UdaVariableType">
            <UdaName>USER_FIELD_1</UdaName>
          </GetValue>
          <ReferenceValue>1</ReferenceValue>
        </Compare>
        <Compare comparisonOperator="LessThenOrEqual" xsl-type="IntegerCompareType">
          <GetValue xsl-type="UdaVariableType">
            <UdaName>USER_FIELD_2</UdaName>
          </GetValue>
          <ReferenceValue>42</ReferenceValue>
        </Compare>
        <Compare comparisonOperator="GreaterThenOrEqual" xsl-type="IntegerCompareType">
          <GetValue xsl-type="UdaVariableType">
            <UdaName>USER_FIELD_2</UdaName>
          </GetValue>
          <ReferenceValue>0</ReferenceValue>
        </Compare>
        <Compare comparisonOperator="NotEqual" xsl-type="IntegerCompareType">
          <GetValue xsl-type="UdaVariableType">
            <UdaName>USER_FIELD_2</UdaName>
          </GetValue>
          <ReferenceValue>10</ReferenceValue>
        </Compare>
      </Where>
    </Include>
  </Rules>
</PropertySetBind>
Trimble SketchUp is a modeling software used in, for example, architecture, construction, engineering and landscape architecture. 3D Warehouse contains lots of SketchUp models that you can import as reference models to Tekla Structures.

You can import Sketchup files as reference models to Tekla Structures. Tekla Structures supports Sketchup version 2016 and earlier in import.

You can export Tekla Structures models as .skp files to be used in SketchUp.

See also
Import a reference model (page 43)
Export a model to SketchUp (page 100)

10.1 Export a model to SketchUp

You can export a Tekla Structures model to SketchUp in the .skp format.

1. Select the model objects to export.
   If you want to export all, you do not have to select anything. We recommend exporting large models in portions.


3. Browse for the Output file location and enter the file name.

4. On the Advanced tab, select the objects that you want to export.

5. Click Create selected.
   If you want to export everything, click Create all.
DWG is the native file format of AutoCAD and the standard file format for Autodesk products. DWG is used for 2D and 3D CAD data that is supported by Tekla Structures.

DXF (Drawing eXchange Format) was developed by Autodesk for enabling data interoperability between AutoCAD and other programs. As the file format does not contain any form of part ID it is not possible to track changes between different physical objects contained within different versions of a file. Clash checking is not possible with a DXF file in Tekla Structures.

The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part profiles that can be used to create a model. If you want to show surfaces of the objects, import DWG and DXF files as reference models (page 43).

In DWG/DXF import, Tekla Structures supports ACAD2012 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text editor. You will find the version code in the first six bytes:

AC1027 = 2013
AC1014 = 14
AC1012 = 13
AC1009 = 12, 11
AC1006 = 10
AC1004 = 9
AC1002 = 2

Click the links below to find out more:
Import a 2D or 3D DWG or DXF file (page 102)
Export a model to a 3D DWG or DXF file (page 103)
Export a drawing to 2D DWG or DXF (page 105)

Import DWG files in drawings
You can also add links to DWG files in drawings through the 2D Library or by using a ribbon command:
• 2D Library in drawings
• Add links to DWG and DXF files in drawings

11.1 Import a 2D or 3D DWG or DXF file
The DWG/DXF import tool imports 2D and 3D models that are in DXF or DWG format. You can import the file as parts or reference lines.
1. On the File menu, click Import --> DWG/DXF.
2. Enter the name of the import file.
   Click Browse to browse for the file.
3. Enter the offset from X, Y and Z.
4. Enter the scale.
5. Select how to show the imported parts:
   • Reference lines displays parts in the model using their reference lines in the original model.
   • Parts displays the full profile of parts in the original model, based on the profile sizes defined in the Beam profile and Plate profile boxes. You can only use metric profiles with this option.
6. Select Use 2D import to import a two-dimensional representation of the original model.
   This is useful when have selected the Reference line option. Do not select Use 2D import if you want to import the model in 3D.
7. Click Import.

Tekla Structures imports the file you specified. If you need to delete the imported parts or reference lines, select the parts or lines and press Delete.

Limitations
When importing DWG profiles, note the following:
• The profile must be the only object in the DWG file. The file should not include any titles, blocks or any other graphics.
• The profile must be a closed POLYLINE.
• Generating the polylines from an ADSK 3D model requires a number of steps to clean the profile.
• The profile needs to be scaled up.
• The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part profiles that can be used to create a model. If you want to show surfaces of the objects, import DWG and DXF files as reference models (page 43).
• The import functionality is not available in all Tekla Structures configurations. For more information, see Tekla Structures configurations.

11.2 Export a model to a 3D DWG or DXF file
You can export the whole model or model parts to 3D DWG or 3D DXF file types. By default, Tekla Structures creates a model.dwg file in the current model folder. You can export parts, items and bolts to 3D DWG/DXF.

Limitations
The export has the following limitations:
• Bolt holes are not exported.
• Curved beams and polybeams are exported as single, continuous beams.
• The number of segments in the curved beams is as defined for the particular curved beam.
• Reinforcing bars are not exported.
• Grids are not exported.

TIP You can define color and transparency settings for parts and other model objects. This way you can affect the color that the objects have in the exported DWG/DXF files.

1. Open a Tekla Structures model.
2. On the File menu, click Export --> 3D DWG/DXF.
3. In the Export 3D DWG/DXF dialog box, accept the default export file name, or enter another one.
   To replace an already existing export file, click the ... button and browse for the file.
4. Select whether to export as DWG or DXF.
5. In Export as, select the representation for the exported objects:
• **Faces** exports parts as faces.
  Exporting 3D DWG or DXF files as **Faces** uses more memory and may take longer, but the end result is better.

• **Lines** exports parts as lines located in the center of the profile cross section. Suits well for exporting to analysis software.

• **Center lines** exports parts as part center lines.

• **Reference lines** exports parts as reference lines, drawn between the creation points. Suits well for exporting to analysis software.
  If the model is large, or you have less memory to use, the **Reference lines** option is faster, and the resulting file size is smaller.

6. Select the **Part accuracy**:
   • The options are **High** and **Normal**. **High** also exports chamfers in profile cross-sections.

7. Select the **Bolt accuracy**:
   • **High** exports entire bolt assemblies, including washers.
   • **Normal** only exports the bolt and nut.
   • **No bolts** exports no bolts.

8. Select whether to include **Cuts** in the export.
   **Yes** exports cuts.

9. Select whether to include **Inner contours**:
   **Yes** includes the inner contours.

10. In the **Export** list, select what to export:
    • **All objects** exports the whole model.
    • **Selected objects** exports the parts selected from the model.
      To only select parts that you want to include in the export, activate the **Select parts** and **Select objects in components** selection switches. You can also create a selection filter that exports all the parts and objects that you want. Components cannot be imported as such, but you need to select the objects in components to export the included parts.

11. Click **Create**.

Tekla Structures creates the export file in the current model folder. The ID of each part is exported as an attribute and written into the export file for each part.

**See also**

*Export a drawing to 2D DWG or DXF (page 105)*
11.3 Export a drawing to 2D DWG or DXF

You can export drawings to the 2D DWG or DXF format.

1. On the **Drawings & reports** tab, click **Drawing list**.
2. Select from the list the drawings that you want to export.
3. Right-click and select **Export**.
4. In the **Export Drawings** dialog box, on the **Export file** tab, enter the export file name.
   
   If you are exporting several drawings, leave the file name box empty.
   
   The drawings are exported by default to the `\PlotFiles` folder under the current model folder. If you want to use another folder, enter the full path.

   Tekla Structures uses one of the following advanced options to define the names for the export files. The advanced option that is used depends on the drawing type:

   - `XS_DRAWING_PLOT_FILE_NAME_A`
   - `XS_DRAWING_PLOT_FILE_NAME_C`
   - `XS_DRAWING_PLOT_FILE_NAME_G`
   - `XS_DRAWING_PLOT_FILE_NAME_W`
   - `XS_DRAWING_PLOT_FILE_NAME_M`.

5. Select the file type: **DXF** or **DWG**.
6. If you want to include a revision mark in the file name, select **Include revision mark to file name**.
7. Set the layer options on the **Layer options** tab:
   - Select the layer rules file.
     
     To add or modify layers, and to assign object groups to different layers, click **Setup**.
   - If you want to use advanced conversion to convert the type, color and weight of lines and layers, select **Use advanced line type and layer conversion**.
• In the **Conversion file** box, enter the name of the file to be used in the conversion.

By default, Tekla Structures uses the LineTypeMapping.xml file in the `..\Tekla Structures\<version>\environments\common\inp` folder.

If you need to define your own line type mappings, you can use the file LineTypeMapping.xml as a template when you create a conversion file of your own.

• Select **Include empty layers** if you want to include empty layers in the export.

• Select **Object color by layer** to have different colors on different layers.

8. Set the other drawing export options on the **Options** tab:

• Set **Drawing scale** and **Line type scale**.

• If you want to export the drawings so that the DWG/DXF content is grouped by object, select **Export objects as groups**. When you do this, Tekla Structures makes a new group for each object (part, mark, dimension line, etc.).

• Select **Cut lines with text** if you do not want to display continuous lines in exported drawings, for example, to run the line through text or drawing marks.

• Select **Export custom lines as split lines** to ensure that custom line types have the same appearance in the software you are exporting to and when printed. If **Export custom lines as split lines** is selected, custom line types are exported as solid lines that are split to several short lines. If **Export custom lines as split lines** is not selected, custom line types are exported as defined in `TeklaStructures.lin`.

• Select **Use paper space** to export to both model space and paper space. The unscaled contents of the drawing views are exported into model space. The drawing layout is exported into paper space. The layout contains scaled viewports showing appropriate areas of the model space.

When exporting to paper space, ensure that all objects in the view are inside the view frame. Objects that are partially outside the drawing view frame are not exported.

9. Click **Export**.

**See also**

- Default line types in drawings (page 114)
- Define customized line type mappings in drawing export (page 111)
- Example: Set up layers and export to DWG (page 115)
Layers in exported DWG/DXF drawings

In drawing DWG/DXF export, you can define the layers to which different drawing objects belong. The benefit of using layers in export is that if you do not want to show a certain layer in the drawing, you can turn it off.

You can define the different layers using Tekla Structures selection filters. You can use the LineTypeMapping.xml file to define the line type, line weight and line color for objects on different layers. You can also add custom line types in the TeklaStructures.lin file and use these when mapping Tekla Structures line types to the line types in the exported DWG and DXF files.

You can export into layers of their own all object types that are listed in the Drawing Export Layers dialog box.

The following objects cannot have layers in export because they cannot be identified as separate objects that can have selection filters: clouds, hatches, neighbor parts, symbols in drawings, section view titles, grid label texts, dimension labels, weld labels, bolt mark leader lines, and part mark leader lines. For example, hatches are exported to the same layer with the part that the hatch belongs to.

See also
Example: Set up layers and export to DWG (page 115)

Create layers in DWG/DXF files for drawing export

You need to define the layers that are included in the exported DWG and DXF files.

NOTE To keep track on the layers that you have, create all the layers that you need for the final DWG/DXF drawings at the same time.

1. On the File menu, click Export --> Drawings.
2. In the Export Drawings dialog box, go to the Layer options tab and click Setup next to the Layer rules box.
3. In the Drawing Export Layers dialog box, click Modify layers.
4. To add a layer, click **Add**.
   You can add as many layers as you need.

5. Click the row of the new layer in the **Name** column and enter a name for the layer.

6. Click the row of the new layer in the **Color** column and select a color for the new layer.

```
<table>
<thead>
<tr>
<th>beam_group_1_layer</th>
<th>blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>LevelText</td>
<td>black</td>
</tr>
<tr>
<td>LinkedObject</td>
<td>red</td>
</tr>
<tr>
<td>Mark</td>
<td>green</td>
</tr>
<tr>
<td>ModelObject</td>
<td>black</td>
</tr>
<tr>
<td>NeighbourPartMark</td>
<td>green</td>
</tr>
</tbody>
</table>
```

7. Click **OK**.

Next you can assign objects to the new layer.

**See also**

- Assign objects to layers in drawing export (page 108)
- Example: Set up layers and export to DWG (page 115)

**Assign objects to layers in drawing export**

You need to define which objects to export to certain layers in the exported DWG/DXF file. You can do this by using a selection filter for identifying the desired objects among all objects, and by creating a rule to export these objects to a certain layer.

Before creating the rule, first create the selection filter.

1. Create a selection filter.
2. On the **File menu**, click **Export --> Drawings**.
3. In the **Export Drawings** dialog box, go to the **Layer options** tab, and click **Setup**.
4. Open an object group by clicking the plus sign next to the group name.
   For example, click the plus sign next to **Model Object**.
5. Right-click a rule in the list and select **Add Next Level Rule**.
For example, right-click **Part**.

6. Enter a name for the rule and select the selection filter that you created.

7. Click **OK**.

8. Double-click the row under the rule you just created and select the desired layer for it in the **Select Layer** dialog box.

9. Click **OK**.

   Tekla Structures maps the selected layer to the rule.

10. Save the created layer rule settings for later use by entering a name next to the **Save as** button and clicking **Save as**.

**NOTE**  The order of rules is important. Organize the rules by right-clicking the rule, and selecting **Move up** or **Move down**. The objects are exported to the first matching layer. If there is no matching layer, the objects are exported as **Other object type**.
Example: Create a rule for exporting beam marks to their own layer in drawing export

You can export all kinds of drawing objects to layers of their own.

This example shows how you can do that for beam marks. All kinds of marks can be exported separately to their own layers: bolt marks, part marks, connection marks, neighbor part marks, reinforcement marks and component marks.

First you need to create a selection filter selecting the beams and then you can define the layer rule. Name the beam selection filter Beams.

1. On the File menu, click Export --> Drawings.
2. Go to the Layer options tab of the Export Drawings dialog box and click Setup next to the Layer rules box.
3. Under Mark in the Drawing Export Layers dialog box, select the layer rule of the mark you want to define to its own layer (part, bolt, connection, neighbor part, or reinforcement mark).

Select Part mark.

4. Right-click Part mark and select Add Next Level Rule from the pop-up menu.

This opens the Layer manager rules dialog box.

5. Enter a rule name (for example, BeamMark) and select a filter that you have created (Beam).

6. Click OK.

Tekla Structures creates a new rule BeamMark. Now you can connect the new rule to a layer you have created for beam marks and use when exporting drawings.

See also

Assign objects to layers in drawing export (page 108)
Copying export layer settings to another project

If you want your layer settings to also be available in other projects, you can copy them to a firm or project folder.

1. On the File menu, click Export --> Drawings.
2. Go to the Layer options tab and click Setup.
3. Define the required rule and layer settings.
4. Enter a name for the layer rule settings file next to the Save as button and click Save as.
5. Copy the file <your_layer_rule>.ldb from the \attributes folder under the current model folder to the firm or project folder.

See also
Assign objects to layers in drawing export (page 108)
Create layers in DWG/DXF files for drawing export (page 107)

Define customized line type mappings in drawing export

You can use advanced conversion to convert the type, color and weight of lines and layers. This way you will get the line types that you want to use in the target software, for example, AutoCAD.

By default, Tekla Structures uses the file LineTypeMapping.xml in the folder ..\Tekla Structures\<version>\environments\common\inp for the conversion.

If you need to define your own line type mappings, you can use the file LineTypeMapping.xml as a template.

NOTE When modifying the line type mappings file, use an editor that is capable of validating XML in order to maintain a valid document structure.

To define your own line type mappings, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Map according to line types only | 1. Open the mapping file in an XML editor.  
2. Enter only the line type information.  
For example, all lines in all layers with line type XKITLINE01 will be exported to DASHED. |
<table>
<thead>
<tr>
<th><strong>To</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Map according to line types and layers</td>
<td>3. <strong>Save the mapping file to the model folder.</strong></td>
</tr>
<tr>
<td></td>
<td>1. <strong>Open the mapping file in an XML editor.</strong></td>
</tr>
<tr>
<td></td>
<td>2. <strong>Enter the line type and layer name.</strong></td>
</tr>
<tr>
<td></td>
<td>Define the layers that the mapping will apply to in the LayerName attribute.</td>
</tr>
<tr>
<td></td>
<td>If you leave out the attribute LayerName, Tekla Structures uses the line type mapping for any layer. If you include the attribute LayerName, Tekla Structures uses the line type mapping for that layer only.</td>
</tr>
<tr>
<td></td>
<td>For example, all lines on the layer BEAM with line type XKITLINE01 will be exported to DASHED. Tekla Structures first searches for these kinds of mappings by default.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Define the color of the line in the Color attribute. Enter the color values in AutoCAD Color Index (ACI) codes (numbers from 0 to 255).</strong></td>
</tr>
<tr>
<td></td>
<td>4. <strong>Define the thickness of the line in the Weight attribute. Enter the values in hundredths of millimeters.</strong></td>
</tr>
<tr>
<td></td>
<td>5. <strong>Save the mapping file to the model folder.</strong></td>
</tr>
</tbody>
</table>
This is how the file LineTypeMapping.xml is composed:

```xml
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<!DOCTYPE Mapper []>
<!ELEMENT Mapper (Mapping*)>
<!ATTLIST Mapper Version CDATA #REQUIRED>

<!ELEMENT Mapping (From, To)> 
<!ATTLIST Mapping LayerName CDATA #IMPLIED>
<!ATTLIST Mapping LineType CDATA #REQUIRED>

<!ELEMENT From EMPTY>
<!ATTLIST From LineType CDATA #REQUIRED>
<!ATTLIST From LayerName CDATA #IMPLIED>
</Mapping>

<!ELEMENT To EMPTY>
<!ATTLIST To LineType CDATA #IMPLIED>
<!ATTLIST To LayerName CDATA #IMPLIED>
<!ATTLIST To Color CDATA #IMPLIED>
<!ATTLIST To Weight CDATA #IMPLIED>
</Mapping>

<Mapper Version="1.1">
    <Mapping LayerName="Part">
        <From LineType="XITLINED0"/>
        <To LineType="BYLAYER" Color="4" weight="100"/>
    </Mapping>
    <Mapping LayerName="Part">
        <From LineType="XITLINED2"/>
        <To LineType="HIDDEN" LayerName="Part_Hidden" Color="8" weight="100"/>
    </Mapping>
    <Mapping LayerName="Part">
        <From LineType="XITLINED3"/>
        <To LineType="DASHOFF" LayerName="Part_Refline" Color="12" weight="100"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED0"/>
        <To LineType="continuous"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED1"/>
        <To LineType="DASHED"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED2"/>
        <To LineType="DASHEDX2"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED3"/>
        <To LineType="DASHOFF"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED4"/>
        <To LineType="dot2"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED5"/>
        <To LineType="DIVIDE"/>
    </Mapping>
    <Mapping>
        <From LineType="XITLINED6"/>
        <To LineType="CENTER"/>
    </Mapping>
</Mapper>
```

1. The first section consists of XML and document type definition. Do not change or remove this section.
2. The mappings that are available are defined here. You can use these mappings as a template for your own mappings.
Examples

In the first example, a new Mapping element is added, where XKITLINE00 lines in the Beam layer are converted to BORDER line type, color is converted to 10 and weight to 1.00 mm:

```xml
<Mapping LayerName="Beam">
  <From LineType="XKITLINE00"/>
  <To LineType="BORDER" Color="10" weight="100" />
</Mapping>
```

In the second example, a new Mapping element is added, where XKITLINE02 lines in the Part layer are converted to HIDDEN2 line type, the layer name is converted to Part Hidden, the color is converted to 8 and weight to 1.00 mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to separate layers. The hidden lines must then be defined to their own layers (here Part_Hidden).

```xml
<Mapping LayerName="Part">
  <From LineType="XKITLINE02"/>
  <To LineType="HIDDEN2" LayerName="Part_Hidden" Color="8" Weight="100"/>
</Mapping>
```

**NOTE** For the export to succeed, ensure that the layer (here Part_Hidden) exists on the list of available layers in the **Modify Layers** dialog box.

See also

Default line types in drawings (page 114)

Default line types in drawings

Default line types are available in Tekla Structures drawings. You can map default line types to customized line types, which are defined in TeklaStructures.lin and further exported to DWG/DXF files.

The table below lists the default line types and shows what they look like.

<table>
<thead>
<tr>
<th>Line type name</th>
<th>Line type appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>XKITLINE00</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE01</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE02</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE03</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE04</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE05</td>
<td>·······················</td>
</tr>
<tr>
<td>XKITLINE06</td>
<td>·······················</td>
</tr>
</tbody>
</table>
Example: Set up layers and export to DWG
This example shows how to define layers and export line types on a certain layer to their own sublayers in DWG export. The workflow consists of six tasks:

1. Example: Create a selection filter for DWG export (page 115)
2. Example: Create layers for DWG export (page 116)
3. Example: Create a rule for drawing DWG export and assign a layer to the rule (page 116)
4. Example: Define a custom line type for DWG export (page 117)
5. Example: Define line types and weights for layers in DWG export (page 118)
6. Example: Export the drawing to DWG (page 119)

Example: Create a selection filter for DWG export
Start by creating a selection filter. This task is phase 1 in the workflow Example: Set up layers and export to DWG (page 115).
To create a selection filter:

1. In the model, click the Selection filter switch.
2. In the Object Group - Selection Filter dialog box, click New filter.
3. Add new filter rules.
   a. Create a filter rule that select parts according to the name BEAM.
   b. Create a filter rule that selects parts according to the material S* (as in steel).
4. Save the filter as steel-beam.
Example: Create layers for DWG export

After creating a selection filter, you can continue by creating layers that you want to have in the exported DWG. This task is phase 2 in the workflow Example: Set up layers and export to DWG (page 115).

To create the layers you want to have in the exported DWG:

1. On the File menu, click Export --> Drawings.
2. Go to the Layer options tab.
3. Click Setup and then click Modify layers.
4. Click Add to add a new layer.
   Create separate layers for solid lines (steel-beam-layer) and hidden lines (steel-beam-layer-H) within steel beams.
5. Set the color for the layers.
   Set the solid lines to red and hidden lines to blue.
   - steel-beam-layer-H
   - steel-beam-layer
5. Click OK to accept the changes.
Example: Create a rule for drawing DWG export and assign a layer to the rule

After creating layers, you can continue by creating a rule to export an object group into a layer, and assign the layer to the created rule. This task is phase 3 in the workflow Example: Set up layers and export to DWG (page 115).

To create a rule to export an object group into a layer, and assign the layer to the created rule:

1. Right-click a model object part rule and select Add Next Level Rule.
2. Enter a name for the rule (steel-beam-rule) and select the selection filter you created for steel beams (steel-beam).
3. Click OK.
4. To assign a layer to a rule, double-click the row under the steel-beam-rule and select a layer, in this case steel-beam-layer.
5. Click OK.
6. Save the layer rule settings with the name example1 using Save as.
7. Close the dialog box by clicking OK.
Example: Define a custom line type for DWG export

After creating a rule, you can continue by defining a custom line type for continuous lines in the exported DWG. In this example, you will add some line type definitions. This is phase 4 in the workflow Example: Set up layers and export to DWG (page 115).

To define a custom line type:

1. Open the TeklaStructures.lin file in a text editor (.\ProgramData\Tekla Structures\<version>\environments\common\inp).
2. Add the following line type definition in the file:

```
*HIDDEN,Hidden __ __ __ __ __ __ __ __ __ __ __ __
A, 1.5875, -0.79375
*HIDDEN2,Hidden (.5x) __ __ __ __ __ __ __ __ __ __ __ __
A, 0.79375, -0.396875
*HIDDENX2,Hidden (2x) __ __ __ __ __ __ __ __ __ __ __ __
A, 3.175, -1.5875
*PHANTOM,Phantom __ __ __ __ __ __ __ __ __ __ __ __
A, 7.9375, -1.5875, 1.5875, -1.5875, 1.5875, -1.5875
*PHANTOM2,Phantom (.5x) __ __ __ __ __ __ __ __ __ __ __ __
A, 3.96875, -0.79375, 0.79375, -0.79375, 0.79375, -0.79375
*PHANTOMX2,Phantom (2x) __ __ __ __ __ __ __ __ __ __ __ __
A, 15.875, -3.175, 3.175, -3.175, 3.175, -3.175
*CONTINUOUS,Continuous __________________________
A, 3|
```
3. Save the file. Ensure that the file name extension does not change.

Example: Define line types and weights for layers in DWG export

After defining a custom line type, you can continue by modifying the LineTypeMapping.xml file and defining the line types and weights. This task is phase 5 in the workflow Example: Set up layers and export to DWG (page 115).

To define the line types and weights:

1. Open the LineTypeMapping.xml file (.\ProgramData\Tekla Structures\<version>\environments\common\inp) in a text editor.
2. Add the line type mappings for the layers as shown inside the lower blue frame in the image below. Do not touch the lines inside the upper red frame.
3. Save the file. Ensure that the file name extension does not change.
1. The lines are on the steel-beam-layer layer.
2. The lines are drawn with XKITLINE00 (solid lines).
3. The lines are exported to CONTINUOUS lines in DWG. The line color in DWG was already defined in the layer properties (red). The line weight in DWG is 35.
4. The lines are on the steel-beam-layer layer.
5. The lines are drawn with XKITLINE02 (hidden lines).
6. The lines are exported to DASHED lines into a separate layer called steel-beam-layer-H in DWG. The line color in DWG was already defined in the layer properties (blue). The line weight in DWG is 35.
**Example: Export the drawing to DWG**

After you have defined all the layer settings, you can continue by exporting the drawing. Before exporting the drawing to DWG, ensure that all the drawing properties are as you wish. This task is phase 6 in the workflow Example: Set up layers and export to DWG (page 115).

To export the drawing:
1. Open the drawing that you want to export.
2. On the **File** menu, click **Export drawings**.
3. Enter a name for the export file.
4. Set the **Type** to **DWG**.
5. Go to the **Layer options** tab page and load the layer rule settings that you saved earlier with the name example1.
6. Select the following check boxes: **Use advanced line type and layer conversion**, **Include empty layers** and **Object color by layer**.
7. Browse for the **LineTypeMapping.xml** file.
8. Go to the **Options** tab, set the scale for the export and select the **Export objects as groups** check box and, if you want to, **Cut lines with text** and **Export custom lines as split lines**.
9. Click **Export**.

Open the exported DWG with an applicable DWG viewer software. You can see that the solid lines of the steel beam are on one layer and the hidden lines are
on another layer. You can also see that columns do not match with the layer rules you defined, so they are handled according to other rules.

See below for examples on how the selecting and not selecting **Cut lines with text** affects the result.

In the following example, **Cut lines with text** is selected.

In the following example, **Cut lines with text** is not selected.
Export a drawing to 2D DWG or DXF
The DGN format has been used especially for data transfer between plant design programs. It was developed by MicroStation. It is similar to DWG in that it is only a graphical data format. It contains unique part IDs in the given model. It is possible to check for clashes between the Tekla Structures model and a DGN reference model.

This format has the following limitations:
- GUID is not supported
- Change management is not possible with a DGN file.

See also
- Reference models and compatible formats (page 42)
- Import a reference model (page 43)
- Export to 3D DGN files (page 126)

12.1 DGN import

You can import DGN models as reference models to Tekla Structures. You can view DGN model objects on different reference model layers according to the level settings in the DGN file. You can use DGN models for clash checking.

Tekla Structures reference model import supports V7 and V8 DGN formats.

A DGN file may contain one or more DGN models. A DGN model can be one of the following three types: a design model, an extrusion model or a sheet model. Design models are most useful in Tekla Structures as they contain appropriate structural data. If there are many model types available in a DGN file, Tekla Structures selects the imported model type in the following order:

1. Active model is imported if it is a design model.
2. Default model is imported if it is a design model.
3. If DGN file contains design models, the first one is imported.
4. If there are no design models in the DGN file, the first model regardless of the model type is imported.

You can view a DGN import log about DGN import on the Log file tab in Message Panel. To open the Message Panel, go to Quick Launch and type Message Panel and select the Message Panel command from the displayed list.

See also
Import a reference model (page 43)
DGN objects supported in reference models (page 124)

12.2 DGN objects supported in reference models

Tekla Structures can display the following DGN objects in reference models:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell</td>
<td>2</td>
<td>A collection of grouped entities with a common insertion point/origin, scale and orientation in 2D/3D space.</td>
</tr>
<tr>
<td>Line</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Line string</td>
<td>4</td>
<td>A series of interconnected lines.</td>
</tr>
<tr>
<td>Shape</td>
<td>6</td>
<td>Like a line string, but closed (first point = last point).</td>
</tr>
<tr>
<td>Text node</td>
<td>7</td>
<td>A multi-line paragraph/block of text.</td>
</tr>
<tr>
<td>Curve</td>
<td>11</td>
<td>A parametric spline curve.</td>
</tr>
<tr>
<td>Complex chain</td>
<td>12</td>
<td>A chained collection of other entities (lines, line strings, arcs, curves or b-spline curves).</td>
</tr>
<tr>
<td>Complex shape</td>
<td>14</td>
<td>Like a complex chain, but closed (first point = last point).</td>
</tr>
<tr>
<td>Ellipse</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>17</td>
<td>Supports TrueType fonts and text styles (bold, underline, italic, etc).</td>
</tr>
<tr>
<td>3D surface</td>
<td>18</td>
<td>Like a 3D solid, but not capped on the ends.</td>
</tr>
<tr>
<td>3D solid</td>
<td>19</td>
<td>The solid created by projecting or rotating from a boundary entity</td>
</tr>
<tr>
<td>Object</td>
<td>Type no.</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(line, line string, curve, arc or ellipse)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cone</td>
<td>23</td>
<td>Actually a truncated cone described by two parallel circles; if the radius of both circles is the same, a cylinder is produced.</td>
</tr>
<tr>
<td>B-spline surface</td>
<td>24</td>
<td>See description of b-spline curves, which also applies here; additional data is provided by surface boundary entities (type 25).</td>
</tr>
<tr>
<td>B-spline curve</td>
<td>27</td>
<td>Can be rational/non-rational, uniform/non-uniform, open/closed; entity type 27 supplies header data and additional data is provided by pole entities (type 21), knot entities (type 26) and weight factor entities (type 28).</td>
</tr>
<tr>
<td>Shared cell definition</td>
<td>34</td>
<td>Similar to a DWG block definition; basically defines a set of grouped entities.</td>
</tr>
<tr>
<td>Shared cell instance</td>
<td>35</td>
<td>Similar to a DWG block instance; given a particular cell 'definition', numerous cell 'instances' can be created at differing locations, scales and orientations.</td>
</tr>
<tr>
<td>Multiline</td>
<td>36</td>
<td>A set of parallel lines, which can be jointed (with or without visible seams at the joints), and have various types of end caps (rounded, square, etc).</td>
</tr>
<tr>
<td>Mesh</td>
<td>105</td>
<td>Supports indexed face loops, quad list, quad grid, triangle grid and triangle list meshes.</td>
</tr>
<tr>
<td>Smart solid</td>
<td>-</td>
<td>Smart solids (solids created from embedded Parasolid/ACIS data) can be imported into Tekla Structures as wireframe outlines.</td>
</tr>
</tbody>
</table>

**Limitations**

The following objects have specific limitations:

DGN 125 DGN objects supported in reference models
<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point string</td>
<td>22</td>
<td>Not supported. (A point string is a series of points with associated orientations; point strings are typically used for defining walkthrough paths).</td>
</tr>
<tr>
<td>Dimension</td>
<td>33</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Mesh</td>
<td>105</td>
<td>The point cloud mesh type is not currently supported.</td>
</tr>
<tr>
<td>Smart solid</td>
<td>-</td>
<td>Smart solids (solids created from embedded Parasolid/ACIS data) are currently supported as wireframe outlines only; for this reason, smart solids do not currently participate in clash checking operations.</td>
</tr>
</tbody>
</table>

See also

Import a reference model (page 43)
DGN import (page 123)

12.3 Export to 3D DGN files

You can export selected parts or the whole model to 3D DGN.

1. Open a Tekla Structures model.
2. On the File menu, click Export --> 3D DGN .
   The Export 3D DGN dialog box opens.
3. In the Output file box, enter the name of the export file.
   If you want to replace an already existing file, click the ... button and browse for the file.
4. In the Export list, select All objects, or Selected objects and select the parts to export.
5. Click **Create**.

Tekla Structures creates the `<name>.dgn` file in the current model folder.

If you have tubular parts in your model and you want to reduce the size of the DGN files or the complex display in the rendered views, you can use the following advanced options to control this:

`XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS`

`XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS`

You can also use the following advanced options to control DGN exports:

`XS_EXPORT_DGN_COORDINATE_SCALE`

`XS_EXPORT_DGN_FILENAME`

`XS_EXPORT_DGN_INCLUDE_CUTS`

`XS_EXPORT_DGN_INCLUDE_INNER_CONTOUR`

`XS_EXPORT_DGN_USE_CLASS_AS_COLOR`
You can import LandXML reference models to Tekla Structures. The supported contents of LandXML files are terrain models, line alignments of roads and railways, and rain water systems.

You can export files in .xml format from applications like Bentley InRoads, Autodesk Civil, and Trimble Business Center, and import the .xml files in Tekla Structures as reference models. The LandXML format extends the capabilities of Tekla Structures to show merged models, including the infra models. Tekla Structures supports LandXML 1.2 schema and single-precision floating-point format.

A typical example of a building structure where LandXML can be used is the surface of the bedrock to be utilized when pile lengths are to be considered. LandXML can also be used when estimating the need of excavation. The LandXML format is important also for bridge and for civil structures design tasks.

An example of an imported LandXML reference model:

An example of layers in a LandXML reference model:
Limitations

The LandXML feature does not support all the possible data in the format. It supports the subset of the primitives defined in LandXML 1.2 schema, such as alignments, terrain models and pipe networks.

- Surfaces are not shown correctly in drawings.
- Triangle type of surfaces are only supported.
- There is no warning if the LandXML file contains unsupported data.

See also

Import a reference model (page 43)
You can import a PDF as a reference model to your model. During import, Tekla Structures converts the PDF into the DXF format. Only vector graphics are converted.

**See also**
Import a PDF to a model (page 130)

### 14.1 Import a PDF to a model

1. On the **File** menu, click **Import --&gt; Insert PDF document**. The **Insert PDF Reference Model** dialog box opens.
2. Click **Browse**.
3. Browse for the PDF and click **Open**.
4. Set the scale for the reference model.
5. Enter the page number that you want to import.
6. Click **OK**.
7. Pick a point to place the reference model.
   Tekla Structures converts the PDF into the DXF format. The conversion creates a DXF file for every imported page. Tekla Structures saves the DXF files to the same folder where the PDF is.

**Limitations**

Only vector graphics are converted, not raster graphics.
Computer-aided design (CAD) means that you can create, modify, analyze, and optimize a design using software. CAD software applications are available for generic design or specialized use, such as for architectural or plant design. More complex forms of CAD are solid modeling and parametric modeling, which allow objects to be created with real-world characteristics. In parametric modeling, objects have meaningful relationships with each other.

In Tekla Structures, the CAD import tool supports several different formats to import models, and is able to import a maximum of 10,000 parts. If the number of parts exceeds this, Tekla Structures displays a warning message, and does not import the model.

See also
Conversion files (page 32)
CAD model import settings (page 137)
CAD model export settings (page 144)

15.1 CAD import and export formats

You can import to and export from Tekla Structures the following file types using the CAD import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF</td>
<td>x</td>
<td>x</td>
<td>SDNF (Steel Detailing Neutral File) is used in importing to and exporting from several different CAD systems.</td>
</tr>
<tr>
<td>HLI</td>
<td>x</td>
<td>x</td>
<td>HLI (High Level Interface). IEZ AG Speedikon software</td>
</tr>
<tr>
<td>Plantview</td>
<td>x</td>
<td></td>
<td>Plantview design system</td>
</tr>
</tbody>
</table>

CAD 131 CAD import and export formats
<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF (PDMS)</td>
<td>x</td>
<td>x</td>
<td>Plant Design Management System. Aveva 3D plant design software. Data is exported to PDMS via SDNF link. Tekla Structures writes the information of finish field in the member class attribute, whereas in SDNF export it omits the class information.</td>
</tr>
<tr>
<td>XML</td>
<td>x</td>
<td>x</td>
<td>ArchiCAD modeling system. There are some limitations in the export: • Conversion files are not used. • Holes, bolts and welds are not exported.</td>
</tr>
<tr>
<td>PDMS</td>
<td>x</td>
<td></td>
<td>Outdated format. We do not recommend using this option.</td>
</tr>
<tr>
<td>SCIA</td>
<td></td>
<td>x</td>
<td>SCIA is used for SteelFab interface.</td>
</tr>
</tbody>
</table>

### 15.2 Import an SDNF model

1. On the **File** menu, click **Import --> CAD**. The **Import Models** dialog box opens.
2. Select **Import CAD** from the **Type** list.
3. Use the default name **import model** or enter a new name.
4. Click **OK**.
5. Select the model from the list.
6. Click **Properties** to open a dialog box where you can define the settings for the import file:
   - You can load the standard parameters for PDS and PDMS SDNF files with the **Load** option.
   - On the **Conversion** tab, enter the conversion file names or browse for the conversion files.
• On the **Parameters** tab, enter the name of the SDNF file you want to import in the **Input file** box, or use the default name. SDNF files normally have a *.dat extension. The version number for SDNF 3.0 files can be found in the header if you open the file with a text editor.

• On the **Parameters** tab, set the file **Type** to **SDNF**, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.

• Set the SDNF options on the **SDNF** page:
  • In the **Part Pos_No** area enter a prefix and a start position number. This relates to the **Position number type** setting.
  • In **SDNF version number**, select the SDNF format type (2.0 or 3.0). SDNF 3.0 is generally the format to select. However, with StruCAD it is better to share SDNF 2.0 files.
  • Set **Apply cuts and fittings** to **Yes** (default) to apply cuts and fittings in the import. These will only be included if contained within the SDNF file.
  • Set **Consider offsets** to **Yes** to create offsets. In most cases you should select **Yes**. **No** (default) positions part creation points at part end points.
  • You can create a log file. If the import fails, examine the log file to find out why. Check the log file even if the import seems to have succeeded. In the **Create log** file, you can select **Create** to write a new log file, and delete the previous log file, each time you import the model. If you select **Append** (default), the log file information is added at the end of the existing log file.
  • You can also select how the log file is displayed, the options being **With an external viewer** (like Microsoft Notepad), **Not viewed**, and **In a dialog box**, which creates a separate list dialog box in which the file can only be viewed.
  • Enter the log file name or browse for an existing log file.
  • The SDNF file contains identifiers that can be included in a part’s user-defined attributes, or used as position numbers. In **Position number type**, select **Part position** if you want the identifier to become the part’s position number. Do not use the **Part Pos_No** fields with this option. Select **Universal ID** if you want the identifier to become a user-defined attribute for the part. In most cases, you would select **Universal ID**. To make user-defined attributes visible, you need to add them to the **objects.inp** file. For file imports from PDS or PDMS then the Universal ID option is the normal case.
  • If you wish to create a report of the import, enter the required information on the **Report** tab.
On the **Advanced** tab, you can set some advanced options. Usually there is no need to change the defaults.

7. Click **OK** to go to the **Import Model** dialog box.

8. Select the import model name from the list and click **Import**.
   You can also click the **New** or **Properties** buttons if you require to make some changes.
   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.
    The **Accept all** option is generally used if importing a new model over an existing one. If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**....

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.
    Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

   ![View_01 3d](image)
NOTE  If you want to import information, which Tekla Structures parts do not have, you can use the SDNF extension line in the SDNF file to be imported, and the REVISION_NUMBER user-defined attribute in Tekla Structures.

See also
CAD model import settings (page 137)

15.3 Import a Plantview model
1. On the File menu, click Import --> CAD.
   The New Import Model dialog box opens.
2. Select Import CAD.
3. Use the default name import model or enter a new name.
4. Click OK.
5. Select the model from the list.
6. Click Properties to open a dialog box where you can define the settings for the import file type you selected:
   • On the Conversion tab, enter the conversion file names or browse for the conversion files.
   • On the Parameters tab, enter the name of the Plantview file you want to import in the Input file box, or use Browse to locate the file.
   • Set the file type to Plantview in the Type box, and set the origin coordinates in the Origin boxes if you want the file in a specific location.
   • Set the material grade in the Material box on the SDNF tab.
     You can also click ... next to the box, and browse for the material grade in the Select Material dialog box.
   • If you wish to create a report of the import, enter the required information on the Report tab.
   • If you are importing the model for the first time, you do not need to change the default values on the Advanced tab.
7. Click OK to go to the Import Model dialog box.
8. Click Import.
   Tekla Structures displays the Import model info dialog box.
9. Select which version of parts to import.
10. Click **Accept all**.

   If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports? Click Yes**.

   Tekla Structures displays the imported model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**See also**

**CAD model import settings (page 137)**

---

### 15.4 Import a SteelFab/SCIA model

1. On the **File** menu, click **Import --> CAD**.

   The **Import Models** dialog box opens.

2. Select **Import Steelfab/SCIA** from the **Type** list.

3. Use the default name **import model** or enter a new name.

4. Click **OK**.

5. Select the model from the list.

6. Click **Properties** to open a dialog box where you can define the settings for the import file:

   - Enter the input file name.
   - Enter the conversion file names.
   - Set the origin coordinates in the **Origin** boxes if you want the file in a specific location
   - Set **Import weldings** to **Yes** to include welds in the model.
   - Set **Import holes** to **Yes** to include holes in the model.

7. Click **OK**.

8. Click **Import**.

9. Select which version of parts to import.

10. Click **Accept all**.
11. If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

12. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.
   
   Tekla Structures displays the import model in a model view.

13. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

14. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**See also**

CAD model import settings (page 137)

### 15.5 CAD model import settings

The settings related to importing various types of models through the **Import Model** dialog box are listed below. All of the tabs and settings are not available for all import types. The import types are listed next to the settings, so that you can see which import type the settings belong to. The **Import Model** dialog box is displayed when you click **Properties** in the **Import Models** or **New Import Model** dialog box.

#### Conversion tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile conversion file</td>
<td>Set the conversion files you want to use. Conversion files map Tekla Structures profile and material names with names used in other software. For SteelFab/SCIA, these options are located on the <strong>Parameters</strong> tab.</td>
<td>CAD, FEM, CIS Model/CIMSteel, Eureka LMP, MicasPlus, SteelFab/SCIA</td>
</tr>
<tr>
<td>Material conversion file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Advanced tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action when object status is (compared to)</td>
<td>Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be <strong>New</strong>, <strong>Modified</strong>, <strong>Deleted</strong>, or <strong>Same</strong>. Tekla Structures compares the state of imported objects with those in your model</td>
<td>CAD, FEM, MicasPlus</td>
</tr>
</tbody>
</table>
### Option Description Import type

**Model**. They can be **Not in model**, **Different**, or **Same**. Use the options under **Not in model**, **Different**, and **Same** to specify the actions when importing changed objects. The options are **No action**, **Copy**, **Modify**, or **Delete**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Not in model</strong></td>
<td>Model must not be imported.</td>
<td>Eureka LMP</td>
</tr>
<tr>
<td><strong>Different</strong></td>
<td>Model must be imported and modified.</td>
<td>CIS Model/</td>
</tr>
<tr>
<td><strong>Same</strong></td>
<td>Model must be imported but not modified.</td>
<td>CIMSteel</td>
</tr>
</tbody>
</table>

**Parts tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part Pos_No</strong></td>
<td>Enter a prefix and a start position number.</td>
<td>FEM</td>
</tr>
<tr>
<td><strong>Assembly Pos_No</strong></td>
<td>For SDNF, this option is located on the SDNF tab.</td>
<td></td>
</tr>
</tbody>
</table>

**Parameters tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input file or ASCII file name</strong></td>
<td>The file you want to import. You can also browse for the file.</td>
<td>All</td>
</tr>
</tbody>
</table>
| **Type or Model type** | Set the input file or model type:  
  CAD: SDNF, Calma, HLI, Plantview, SDNF (PDMS), XML  
  FEM: DSTV, SACS, Monorail, Staad, Stan 3d, Bus  
  CIS Model/CIMSteel: Design, Analysis, SP3D. | CAD, FEM, CIS Model/CIMSteel |
| **CIS version**       | Select **CIS/1** or **CIS/2**:  
  - **CIS/1** imports files compatible with the CIMsteel LPM4DEP1 schema declaration.  
  - **CIS/2** imports files compatible with the CIMsteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration. | CIS Model/CIMSteel |
<p>| <strong>Input scope</strong>       | Import the <strong>Entire model</strong> or <strong>Selection only</strong>.                           | CIS2 status                       |
| <strong>Part rotation</strong>     | Select <strong>Front</strong> or <strong>Top</strong>.                                                 | MicasPlus                          |
| <strong>Origin X, Y, Z</strong>    | Set the origin coordinates to place the file in a specific location.         | CAD, FEM                           |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default yield stress limit</strong></td>
<td>The Default material when yield stress &lt; limit setting is used for SACS import file. Define the material to use if yield stress is less than the limit. The setting Default material when yield stress &gt;= limit is used for SACS or DSTV import files. For SACS, this field defines the material to use if yield stress is greater than or equal to the limit. For DSTV you can enter the material grade here, if it is not included in the import file.</td>
<td>FEM</td>
</tr>
<tr>
<td><strong>Combine members</strong></td>
<td>To combine several elements in the FEM or CIS model into one part in Tekla Structures, set Combine members to Yes. For example, if a beam in a file consist of more than one element, and you select Yes, the elements are combined to form one beam in the Tekla Structures model. If you use the value No, Tekla Structures creates a beam for each element in the FEM or CIS model. <strong>Max length for combining</strong> is only applied if you set Combine members to Yes. Use this setting to define the maximum length for combining parts. Tekla Structures combines elements into one part only if their combined length is less than the value you enter here.</td>
<td>FEM</td>
</tr>
<tr>
<td><strong>Ignore offsets</strong></td>
<td>CIS/1 and CIS/2 analysis models can include member offsets, which means that nodes are not exactly at the beam's end points. With the default Yes, Tekla Structures uses these offsets to locate the physical members. With No, Tekla Structures determines the location using the node locations.</td>
<td>CIS/CIMSteel</td>
</tr>
<tr>
<td><strong>Ignore forces</strong></td>
<td>Use to define how forces are imported. With No, Tekla Structures imports absolute values of maximum forces to</td>
<td>CIS/CIMSteel</td>
</tr>
</tbody>
</table>
### CAD model import settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
<td><strong>Import type</strong></td>
</tr>
<tr>
<td><strong>Import GUID (design model)</strong></td>
<td>The part GUID is included in the import.</td>
<td>CIS/CIMSteel</td>
</tr>
<tr>
<td><strong>Create log file</strong></td>
<td>Select <strong>Create</strong> to write a new log file and delete the previous log file</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td></td>
<td>each time you import the model.</td>
<td>CIS2 status</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Append</strong> (default) to add the log file information at the end of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the existing log file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you do not need a log file, select <strong>No</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In SDNF, this option is on the <strong>SDNF</strong> tab.</td>
<td></td>
</tr>
<tr>
<td><strong>Display log file</strong></td>
<td>Select <strong>With an external viewer</strong> to display the log file in an external</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td></td>
<td>viewer, like Microsoft Notepad.</td>
<td>CIS2 status</td>
</tr>
<tr>
<td></td>
<td>If you do not want to display the file, select <strong>Not viewed</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select <strong>In a dialog box</strong> to create a separate list dialog box in which the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>file can only be viewed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In SDNF, this option is on the <strong>SDNF</strong> tab.</td>
<td></td>
</tr>
<tr>
<td><strong>Import weldings</strong></td>
<td>Include weldings in the imported model.</td>
<td>SteelFab/SCIA</td>
</tr>
<tr>
<td><strong>Import bolt holes</strong></td>
<td>Include bolt holes in the imported model.</td>
<td>SteelFab/SCIA</td>
</tr>
</tbody>
</table>

### Report tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create report</strong></td>
<td>Set to Yes to create a report.</td>
<td>CAD FEM</td>
</tr>
<tr>
<td><strong>Display report</strong></td>
<td>Set to Yes to display the report.</td>
<td>CAD FEM</td>
</tr>
<tr>
<td><strong>Report template</strong></td>
<td>Select the report template.</td>
<td>CAD FEM</td>
</tr>
<tr>
<td><strong>Report file name</strong></td>
<td>Enter the report file name or browse for a report file.</td>
<td>CAD FEM</td>
</tr>
</tbody>
</table>
### SDNF tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Pos_No</td>
<td>Enter a prefix and a start position number. This settings relates to the <strong>Position number type</strong> setting.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>SDNF version number</td>
<td>Set the SDNF format type to <strong>2.0</strong> or <strong>3.0</strong>.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Apply cuts and fittings</td>
<td>Set to <strong>Yes</strong> (default) to apply cuts and fittings in the import.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Consider offsets</td>
<td>Set to <strong>Yes</strong> to create offsets. In most cases you should select <strong>Yes. No</strong> (default) positions part creation points at part end points.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Log file name</td>
<td>Enter the log file name or browse for an existing log file.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Position number type</td>
<td>The SDNF file contains identifiers that can be included in a part's user-defined attributes, or used as part position numbers. Select <strong>Part position</strong> if you want the identifier to become the part's position number. Do not use the <strong>Pos_No</strong> option with this option. Select <strong>Universal ID</strong> if you want the identifier to become a user-defined attribute for the part. For file imports from PDS or PDMS then the Universal ID option is the normal case. To make user-defined attributes visible in the dialog boxes, you need to add them to the objects.inp file.</td>
<td>CAD (SDNF)</td>
</tr>
</tbody>
</table>

### Plantview tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Select the material grade.</td>
<td>CAD (Plantview) FEM (Staad)</td>
</tr>
</tbody>
</table>
## DSTV tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Select the DSTV version.</td>
<td>FEM (DSTV)</td>
</tr>
<tr>
<td>Import static elements</td>
<td>If the DSTV file to be imported contains a static and a CAD model, you can choose which one to import. Answering Yes to Import static elements imports the static model. Answering Yes to Import other elements imports the CAD model.</td>
<td>FEM (DSTV)</td>
</tr>
<tr>
<td>Import other elements</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Stan 3d

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Specify the scale of the import model. You can import Stan 3d without specifying the scale as long as both the Tekla Structures model and the import model are in millimeters. If the Stan 3d file is in millimeters, use the scale 1. If the Stan 3d file is in meters, use the scale 1000.</td>
<td>FEM (Stan 3d)</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
<td>FEM (Stan 3d)</td>
</tr>
</tbody>
</table>

## Bus tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pos_No</td>
<td>Indicate the Pos_No of the girders, columns, braces and cantilevers you import.</td>
<td>FEM (Bus)</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
<td>FEM (Bus)</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the parts to import.</td>
<td>FEM (Bus)</td>
</tr>
<tr>
<td>Class</td>
<td>Enter the class of the parts to import.</td>
<td>FEM (Bus)</td>
</tr>
<tr>
<td>Beams behind plane</td>
<td>The value Yes aligns the tops of all beams at the floor level.</td>
<td>FEM (Bus)</td>
</tr>
</tbody>
</table>

## Advanced tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action when object status is</td>
<td>Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be New, Modified, Deleted, or Same. Tekla Structures compares the state of imported objects with those in your model.</td>
<td>CAD</td>
</tr>
<tr>
<td>(compared to)</td>
<td></td>
<td>FEM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MicasPlus</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Import type</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>model. They can be <strong>Not in model</strong>, <strong>Different</strong>, or <strong>Same</strong>. Use the options under <strong>Not in model</strong>, <strong>Different</strong>, and <strong>Same</strong> to specify the actions when importing changed objects. The options are <strong>No action</strong>, <strong>Copy</strong>, <strong>Modify</strong>, or <strong>Delete</strong>.</td>
<td>Eureka LMP CIS Model/ CIMSteel</td>
</tr>
</tbody>
</table>

See also
Import an SDNF model (page 132)
Import a Plantview model (page 135)
Import a SteelFab/SCIA model (page 136)

### 15.6 Export to CAD

You can export a CAD model in several formats.

**NOTE** Before you start an SDNF export, check that the advanced option `XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE` has not been set on the Export page of the Advanced Options dialog box.

1. Open a Tekla Structures model.
2. On the **File** menu, click **Export -> CAD**.
   The CAD export dialog box opens.
3. Enter the paths to the required conversion files on the **Conversion** tab.
4. Go to the **Parameters** tab, and give a name to the export file in the **Output file** box.
   You can also browse for the file.
5. Select the export format from the **Type** list.
6. Use the **Origin X, Y, Z** boxes to specify the origin of the exported model.
7. In PML export, define PML-specific information on the **PML** tab.
8. In SDNF, SDNF (PDMS) and PDMS export, go to the **SDNF** tab, and define the necessary information.
9. Select the parts in the model to export.
10. Click **Apply** and **Create**.
    Tekla Structures creates the export file in your current model folder.
15.7 CAD model export settings

Settings related to exporting various types of models through the Export CAD dialog box are listed below. FEM export settings are also described. All of the tabs and settings are not available for all export types. The export types are listed next to the settings, so that you can see which export type the setting belongs to. The Export CAD dialog box opens when you click File menu -> Export --> CAD.

**Conversion tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile conversion file</td>
<td>Set the conversion files you want to use.</td>
<td>All</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
<td>All</td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td></td>
<td>All</td>
</tr>
</tbody>
</table>

**Parameters tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output file</td>
<td>The file name of the exported file. You can also browse for the file.</td>
<td>All</td>
</tr>
<tr>
<td>Type</td>
<td>Select the export format.</td>
<td>All</td>
</tr>
<tr>
<td>Origin X, Y, Z</td>
<td>Set the origin coordinates to place the exported model in a specific location.</td>
<td>PML, SDNF, XML</td>
</tr>
<tr>
<td>Split members</td>
<td>Splits a part in the Tekla Structures model into several elements in the STAAD or DSTV model.</td>
<td>FEM</td>
</tr>
<tr>
<td>Combine segmented members (MicroSAS)</td>
<td>Gives you the option to combine multiple parts</td>
<td>FEM (MicroSAS)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Export type</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Export type</td>
<td>to form one part in the exported model. For example, if you have divided a beam into several elements and select the Yes option, Tekla Structures combines the elements so that they form one beam in the exported model. With the option No every element of the beam in the model forms individual beams.</td>
<td>PML</td>
</tr>
</tbody>
</table>

**PML tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units (for PML only)</td>
<td>Select the units for the export model.</td>
<td>PML</td>
</tr>
<tr>
<td>Export cut parts</td>
<td>Controls whether cuts are included in the export. <strong>Yes</strong> exports part cuts. When you use PML, enter the Tekla Structures profile names in the conversion file. This makes the other software consider parts as beams and columns, not as plates, and reduces the export file size.</td>
<td>PML</td>
</tr>
</tbody>
</table>

**SDNF tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF version number</td>
<td>Select the SDNF version to be used in the export. With StruCAD, use SDNF version 2.0.</td>
<td>SDNF</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Export type</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Apply cuts and fittings</td>
<td>Select Yes (default) applies cuts and fittings in the export.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Position number type</td>
<td>The SDNF file contains identifiers, which can be included in a part’s user-defined attributes, or as position numbers. You have the following options:</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td>• Part position</td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td>The identifier becomes the part’s position number. Do not use the Part Pos_No fields with this option.</td>
<td>PDMS</td>
</tr>
<tr>
<td></td>
<td>• Assembly position</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The identifier becomes the assembly's position number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Universal ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The identifier becomes a user-defined attribute for the part.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To make user-defined attributes visible, you need to add them to the objects.inp file.</td>
<td></td>
</tr>
<tr>
<td>Consider offsets</td>
<td>To ignore the offset records during export, select No, and to take them into account, select Yes.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td>This setting does not affect the actual start and end point information, only the offset. Tekla Structures writes the start and end point information when the offset is considered.</td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Export type</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>PDMS phase offset</td>
<td>PDMS phase offset defines phase offset for exported parts. For example, if the first phase in Tekla Structures model is 1 and you enter 10 for phase offset, Tekla Structures parts in another software get the phase from 11 and up.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Engineering firm</td>
<td>Enter the name of the engineering company.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Client</td>
<td>Enter the name of the client.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Structure ID</td>
<td>Enter a unique identification number for the exported model.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Project ID</td>
<td>Enter a unique identification number for the exported project.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Revision number</td>
<td>Enter an optional revision number. Tekla Structures takes the revision number from the user-defined attributes (REVISION_NUMBER) of the model. If this field is blank, Tekla Structures uses a revision number from the CAD export dialog box (<strong>Revision Number</strong>).</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
<tr>
<td>Issue code</td>
<td>Tekla Structures writes an issue code in the header section of the output file. For PDMS,</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
</tbody>
</table>
### Option Descriptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design code</strong></td>
<td>Define the design code to be used in structural design.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
</tbody>
</table>

### XML Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Units</strong></td>
<td>Specify unit conversions (MM, M, IN, FT). For example, for a Tekla Structures model created using millimeters, select IN to convert all part dimensions to inches in the output file.</td>
<td>XML</td>
</tr>
<tr>
<td><strong>XML structure ID</strong></td>
<td>Unique identification number for the exported model. You must always enter the identification ID. Tekla Structures uses this value to identify the model if you re-export it.</td>
<td>XML</td>
</tr>
<tr>
<td><strong>XML structure name</strong></td>
<td>Unique name of the exported model.</td>
<td>XML</td>
</tr>
</tbody>
</table>

### Staad Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile table</strong></td>
<td>Select the profile type.</td>
<td>FEM (STAAD)</td>
</tr>
</tbody>
</table>
| **Parametric shapes when possible** | Use to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad.  
  - **Yes** exports the profiles as parametric shapes so that STAAD can identify them correctly.  
  - **No** exports all profiles as standard STAAD shapes.                                                                                     | FEM (STAAD) |
### DSTV tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
<td>Select the DSTV version to export.</td>
<td>FEM (DSTV)</td>
</tr>
<tr>
<td><strong>Element reference with</strong></td>
<td>Select CROSS-SECTION to export a static model or MEMBER_LOCATION to export a CAD model.</td>
<td>FEM (DSTV)</td>
</tr>
</tbody>
</table>

#### 15.8 Re-import a CAD model

Sometimes you have already imported a model, but because of some changes, you need to re-import it.

The profile and material conversion files need to be the same as adopted in the original model import.

The following instructions also apply to CIMsteel (cis/2) models.

1. Open Tekla Structures and a model where you have already imported an existing CAD model.
2. On the **File** menu, click **Import --> CAD**.
3. Select the import type in the **Type** list.
   - For CAD models, this will generally be for SDNF format files only.
4. Enter a new name for the imported model in the **Name** box.
   - The total path and filename cannot be longer than 80 characters. If the total path is too long, a message is displayed saying "File name and path is too long. Please, place the file into another directory." Also, if you use the same name as in the original import, Tekla Structures gives the warning message "Illegal name for import model."
5. Click the **Properties** button and ensure that the **Profile material conversion** files on the **Conversion** tab are the same as adopted in the original model import.
6. Go to the **Advanced** tab and define the actions Tekla Structures takes when importing changed objects:
   - The left-hand column, **Previous plan**, lists the state of the objects in your model, compared with the state of objects in the file to be imported. They can be **New**, **Modified**, **Deleted**, or **Same**.
   - The objects can be **Not in model**, **Different**, or **Same**.
• Use the list boxes in the rows under **Not in model, Different, or Same** to specify the actions to take when importing changed objects. The options are **No action, Copy, Modify, or Delete**.

You can select **Delete** only for **Deleted** objects. You can only use **Delete** to delete objects that have been deleted from your model, not from the imported model.

• Normally, default settings would be used by most users.

7. Click **OK** or **Apply**.
8. Click **OK** in the **Import Model** dialog box to import the updated model.
9. Create reports on the **Report** tab to compare the various imports.

**See also**

- CAD model import settings (page 137)
- Create import reports (page 150)

### 15.9 Create import reports

Some of the import tools give you the option to create a report of the import. By default, Tekla Structures does not create reports when you import files.

With this import report you can compare different revisions from previous imports. You can list the differences in profiles, material, part rotation, part position, paint, start connection codes, end connection codes, phase, for example.

1. Open the import tool, for example, CAD ( **File menu --> Import --> CAD**).
2. Go to the **Report** tab of the import dialog box.
3. In **Create report**, select **Yes**.
4. In **Display report**, select **Yes** to display the report file.
5. In **Report template**, enter the path of the report template, or use the browse button to locate it.

You can also leave the template name out, in which case the default import template is used.

6. In **Report file name**, enter the path for the report file, or use the browse button to locate it.

You can also leave the report file name out, in which case the default import report file is used.
7. Import the model.
The model is imported and the report is displayed on the screen. If you have not given the report any other name, the report is saved with the name import_revision_report.rpt in the model folder.

See also

CAD model import settings (page 137)
16 FEM

FEM (Finite Element Method) is an analysis and calculation method used in structural engineering. In this element method, the target is divided into appropriate finite elements interconnected at points called nodes.

Tekla Structures FEM import and export tool support several formats and provide several options for importing and exporting models.

See also
FEM import and export file types (page 152)

16.1 FEM import and export file types

You can import the following file types into Tekla Structures using the FEM import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSTV</td>
<td>DSTV format data (Deutsche Stahlbau-Verband). Several different systems, for example, RSTAB static software and Masterseries Analysis &amp; Design system.</td>
</tr>
<tr>
<td>SACS</td>
<td>SACS modeling and analysis software</td>
</tr>
<tr>
<td>S-Frame</td>
<td>Analysis software, for example, FASTSOLVE.</td>
</tr>
<tr>
<td>Monorail</td>
<td>Monorail system</td>
</tr>
<tr>
<td>STAAD</td>
<td>STAAD format data (Structural Analysis And Design). STAAD modeling and analysis system.</td>
</tr>
<tr>
<td>Stan 3d</td>
<td>Stan 3d analysis software</td>
</tr>
<tr>
<td>Bus</td>
<td>BUS 2.5 analysis software</td>
</tr>
</tbody>
</table>

You can export to the following formats: DSTV, MicroSAS, and STAAD.

See also
16.2 DSTV

DSTV (Deutscher Stahlbau-Verband) manufacturing format is the standard format used for manufacturing steel components on numerically controlled (NC) machines. It also has an Analysis & Design format that is used for transferring Analysis & Design models to the physical 3D model.

Different programs produce different DSTV files. For example, the DSTV file produced by RSTAB static software only contains a static model. Tekla Structures exports either the static model (CROSS_SECTION), or the CAD model (MEMBER_LOCATION).

See also
Import a DSTV model (page 153)

16.3 Import a DSTV model

1. On the File menu, click Import --> FEM.
   The New Import Model dialog box opens.
2. Select Import FEM.
3. Select import model (default) from the list or enter a new name.
4. Click OK.
5. Click Properties to open a dialog box where you can define the settings for the import file:
   • On the Conversion tab, enter the conversion file names or browse for the files.
   • On the Parts tab, enter a prefix and a start position number for the imported parts in the Part Pos_No and Assembly Pos_No boxes.
   • On the Parameters tab, enter the name of the DSTV file you want to import in the Input file box, or use the default name.
   • On the Parameters tab, set the file type to DSTV in the Type box, and set the origin coordinates in the Origin boxes if you want the file in a specific location.
   • If you wish to create a report of the import, enter the required information on the Report tab.
   • Select the DSTV version on the DSTV tab.

For Masterseries, the DSTV99 format must be selected.
• Still on the DSTV tab, set Import static elements to Yes to import a static model. If you set Import other elements to Yes, a CAD model is imported.

6. Click OK to go to the Import Model dialog box.
7. Select the model to import.
8. Click Import.
Tekla Structures displays the Import model info dialog box.
9. Select which version of parts to import.
10. Click Accept all.
If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual.
11. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.
Tekla Structures displays the import model in a model view.
12. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.
13. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also
CAD model import settings (page 137)

16.4 Import a STAAD model
This FEM import tool imports steel structures from the STAAD modeling and analysis system.

NOTE FEM import is an old way to import STAAD data. We recommend that you use a direct link to ISM or STAAD.Pro, which are available in Tekla Warehouse. If Tekla Structures and STAAD.Pro or ISM are loaded onto the same machine then direct links can be used.

NOTE To make a STAAD input file compatible with the Tekla Structures STAAD import, use the option joint coordinate format (Single) to save the input file in STAAD. This creates a line for each coordinate in the input file.

1. On the File menu, click Import --&gt; FEM.
The New Import Model dialog box opens.
2. Select **Import FEM**.
3. Use the default name **import model** or enter a name for the import model.
4. Click **OK**.
5. Select the model.
6. Click **Properties** to open a dialog box where you can define the settings for the import file type you selected:
   - On the **Conversion** tab, enter the conversion file names or browse for the conversion files.
   - On the **Parameters** tab, enter the name of the STAAD file you want to import in the **Input file** box.
   - Set the file type to **STAAD** in the **Type** box, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.
   - Set the material grade in the **Material** box on the **Staad** tab. You can also click ... next to the box, and browse for the material grade in the **Select Material** dialog box.
   - If you wish to create a report of the import, enter the required information on the **Report** tab.
   - If you are importing the model for the first time, you do not need to change the default values on the **Advanced** tab.
7. Click **OK** to go to the **Import Model** dialog box.
8. Click **Import**.
   Tekla Structures displays the **Import model info** dialog box.
9. Select which version of parts to import.
10. Click **Accept all**.
    If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.
11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.
    Tekla Structures displays the import model in a model view.
12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.
13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.
STAAD table type specifications

Tekla Structures supports the following STAAD table type specifications:

- ST (single section from the standard built-in tables)
- ST PIPE (parametric)
- ST TUBE (parametric)
- RA (single angle with reverse Y_Z axes)
- D (double channel)
- LD (long leg, double angle)
- SD (short leg, double angle)
- TC (beams with top cover plates)
- BC (beams with bottom cover plates)
- TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and other non-standard profiles, if you have defined them in the profile conversion file. You must use the underscore character in the STAAD name, for example, UPT_1_W10X49. Tekla Structures automatically converts twin profiles in this import routine.

See also
Import a STAAD model (page 154)

16.5 Import a Stan 3d model

1. On the File menu, click Import --> FEM.
   The New Import Model dialog box opens.
2. Select Import FEM.
3. Use the default import file name import model or enter another name.
4. Click OK.
5. Select the model to import.
6. Click Properties to open a dialog box where you can define the settings for the import file type you selected:
• On the **Conversion** tab, enter the conversion file names or browse for the conversion files.

• On the **Parameters** tab, enter the name of the file you want to import in the **Input file** box.

• Set the file type to **Stan 3d** in the **Type** box, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.

• If you wish to create a report of the import, enter the required information on the **Report** tab.

• If you are importing the model for the first time, you do not need to change the default values on the **Advanced** tab.

7. Click **OK** to go to the **Import Model** dialog box.

8. Click **Import**.

   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.

   If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

   Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**See also**

CAD model import settings (page 137)

### 16.6 Import a Bus model

The **Bus import tool** imports basic steel structures from the BUS 2.5 analysis software input file.

1. On the **File** menu, click **Import --> FEM**.

   The **New Import Model** dialog box opens.

2. Select **Import FEM**.

3. Use the default name **import model** or enter another name.
4. Click **OK**.

5. Select the model.

6. Click **Properties** to open a dialog box where you can define the settings for the import file type you selected:
   
   • On the **Conversion** tab, enter the conversion file names or browse for the conversion files.
   
   • On the **Parameters** tab, enter the name of the Bus file you want to import in the **Input file** box.
   
   • Set the file type to **Bus** in the **Type** box, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.
   
   • On the **Bus** tab, enter the position number, material, name, and class of the parts to import. Use **Beams behind plane** to indicate the position of girders and cantilevers. The option **Yes** aligns the tops of all beams at the floor level.
   
   • If you wish to create a report of the import, enter the required information on the **Report** tab.
   
   • If you are importing the model for the first time, you do not need to change the default values on the **Advanced** tab.

7. Click **OK** to go to the **Import Model** dialog box.

8. Click **Import**.

   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.

    If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

    Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**See also**

*CAD model import settings (page 137)*
16.7 Export to STAAD

1. Open a Tekla Structures model.
2. On the File menu, click Export --> FEM. The FEM export dialog box opens.
3. Go to the Conversion tab and enter the names of the conversion files, or browse for the files.
4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.
5. Select Staad in the Type list.
6. Set Split members to Yes to split a part in the Tekla Structures model into several elements in the STAAD model.
7. Go to the Staad tab and select an option from Profile type list.
8. Use the setting Parametric shapes when possible to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad.
   - Yes exports the profiles as parametric shapes so that STAAD can identify them correctly.
   - No exports all profiles as standard STAAD shapes.

Tekla Structures creates the export file in the current model folder.

Example
Example of a plate PL10*200 when exported as parametric shape (Yes):
13 PRI YD 200.000000 ZD 10.000000.
Example of the same plate exported as a standard shape (No):
13 TABLE ST PL10*200

NOTE  FEM export is one way to export STAAD data. Direct link to STAAD.Pro analysis and design application is another, more versatile way to export.

See also
STAAD.Pro (page 329)

16.8 Export to DSTV

NOTE  The FEM DSTV export is not the same as DSTV export (File menu --> Export --> NC files), which produces DSTV files to be used as instruction files for NC machines. The FEM DSTV export is intended to
be used for transferring the model in the DSTV format. The DSTV file (*.stp) saves the data elements (end points, material, cross sections, references) as a standard DSTV file for importing and exporting models. For more information about creating NC files in DSTV format, see Create NC files in DSTV format (page 187).

1. Open a Tekla Structures model.
2. On the File menu, click Export --> FEM .
   The FEM export dialog box opens.
3. Go to the Conversion tab and enter the names of the conversion files, or browse for the files.
4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.
5. Select DSTV in the Type list.
6. Set Split members to Yes to split a part in the Tekla Structures model into several elements in the DSTV model.
7. Go to the DSTV tab and select the DSTV version from the Version list.
8. In Element reference with, select whether you want to export into a static model CROSS_SECTION, or into a CAD model MEMBER_LOCATION.

See also
Supported DSTV entities (page 160)

**Supported DSTV entities**

The DSTV entities are listed below. Tekla Structures supports those marked with an asterisk (*). See the DSTV standard "Stahlbau - Teil 1. März 2000" for more information.

**Static data:**
vertex (*)
polyline
substructure (*)
node (*)
element (*)
element_eccentricity (*)
raster
boundary_condition
elastic_support
nodal_reaction
element_reaction

**General data:**
material (*)
cross_section (*)

**CAD data:**
member (*)
member_location (*)
construction-data
cutout
hole

**See also**
Export to DSTV (page 159)
ASCII stands for American Standard Code for Information Interchange. Some plant design systems export ASCII files, for example, ModelDraft, PDS and PDMS.

You can import and export profiles and plates created as beams using the ASCII format. Contour plates cannot be imported.

See also
Import a model in the ASCII format (page 162)
Export a model to the ASCII format (page 162)
ASCII file description (page 163)

17.1 Import a model in the ASCII format

2. Create a new 3D view.
3. Copy the ASCII file to the model folder.
4. Name the file import.asc.
5. On the File menu, click Import --> ASCII.
   Tekla Structures displays the main parts created from the ASCII file in the model.

See also
ASCII (page 162)
Export a model to the ASCII format (page 162)
ASCII file description (page 163)
17.2 Export a model to the ASCII format

1. Open the Tekla Structures model you want to export.
2. Select the parts in the model you want to export.
3. On the File menu, click Export --> ASCII.

Tekla Structures creates a model.asc file in the current model folder.

See also

ASCII (page 162)
Import a model in the ASCII format (page 162)
ASCII file description (page 163)

17.3 ASCII file description

In an import.asc file each part is described by 8 lines. These lines are repeated for each part to be transferred. Units are always in millimeters, blanks are used as separators.

Below is an example of a beam part description:

```
4169 HEA300 1
290.000000 8.500000 300.000000 14.000000 300.000000 14.000000
A/6 BEAM
5235JR S235JR
0.000000
16.500000 24000.000000 4855.000000
6000.000000 24000.000000 4855.000000
16.500000 24000.000000 5855.000000
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>4169 HEA300 1 = ID profile type</td>
</tr>
<tr>
<td></td>
<td>• ID 4169: Unique ID (integer).</td>
</tr>
<tr>
<td></td>
<td>• PROFILE HEA300: Profile name (string).</td>
</tr>
<tr>
<td></td>
<td>• TYPE 1: Profile type (integer)</td>
</tr>
<tr>
<td>The available profile types are:</td>
<td></td>
</tr>
<tr>
<td>0 = free cross section (can be used for special profiles which are not in the database)</td>
<td></td>
</tr>
<tr>
<td>1 = I profiles</td>
<td></td>
</tr>
<tr>
<td>2 = Welded hollow core profiles (HK, HQ)</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>U profiles</td>
</tr>
<tr>
<td>4</td>
<td>L profiles</td>
</tr>
<tr>
<td>5</td>
<td>Round bars</td>
</tr>
<tr>
<td>6</td>
<td>Round tubes</td>
</tr>
<tr>
<td>7</td>
<td>Rectangular hollow core sections (RHS, P)</td>
</tr>
<tr>
<td>8</td>
<td>T profiles</td>
</tr>
<tr>
<td>9</td>
<td>Rectangular bars (FL, PL)</td>
</tr>
<tr>
<td>10</td>
<td>Z profiles</td>
</tr>
<tr>
<td>11</td>
<td>C profiles</td>
</tr>
<tr>
<td>12</td>
<td>Omega profiles</td>
</tr>
<tr>
<td>13</td>
<td>Sigma profiles</td>
</tr>
<tr>
<td>14</td>
<td>Rail profile</td>
</tr>
<tr>
<td>16</td>
<td>Reinforcement bars (DH)</td>
</tr>
</tbody>
</table>

Line 2                  The contents of line 2 depend on the part profile.

- Polygon plates:
  
  N_POINTS COORDINATES
  
  N_POINTS: For profiles of type 0.
  
  COORDINATES: Number of the corner points (integer).
  
  The X and Y coordinates of the plate corners (floating). Rotation
direction is clockwise. Coordinates follow the global coordinate
system. Z coordinates are taken from the center line in the plate
thickness direction.
  
  Note that the line 2 can be divided into several rows in the file.

- Profiles:
  
  For profile types 1-16, the line includes the physical dimensions of
the cross section.

  HEIGHT S W1 T1 W2 T2: 290.000000 8.500000 300.000000 14.000000 300.000000 14.000000
  
  • HEIGHT 290.000000: Height of the cross section
  
  • S 8.500000: Web thickness.
  
  • W1 300.000000: Width of the upper flange.
  
  • T1 14.000000: Thickness of the upper flange.
  
  • W2 300.000000: Width of the lower flange.
  
  • T2 14.000000: Thickness of the lower flange.
**Line 3**

A/6 BEAM = mark name

- MARK A/6: Position mark of the part (string).
- NAME BEAM: Part name (string).

**Line 4**

S235JR S235JR = material

Material of the part (string).

**Line 5**

0.000000 = rotation

Rotation angle (in degrees) around the local x-axis of the beam.

**Line 6**

16.500000 24000.000000 4855.000000 = X1 Y1 Z1

Coordinates of the beam start point. Z coordinates are center-line coordinates.

**Line 7**

6000.000000 24000.000000 4855.000000 = X2 Y2 Z2

Coordinates of the beam end point. Z-coordinates are center-line coordinates.

**Line 8**

16.500000 24000.000000 5855.000000 = X3 Y3 Z3

Direction vector showing the direction of the local z-axis.

**See also**

- [ASCII (page 162)]
- [Import a model in the ASCII format (page 162)]
- [Export a model to the ASCII format (page 162)]
You can import user-defined attribute (UDA) values to a model from a text file. For example, you can import a list of manufactured or checked assemblies. You can import the attribute values to Tekla Structures model objects, drawings or some reference model objects by selecting an area in the model, or the whole model.

The imported file can be:

- Exported from other software.
- Created manually using any standard text editor, for example, Microsoft Notepad.
- A simple Tekla Structures report containing the part GUIDs and user-defined attributes.

**See also**

Import attributes (page 166)
Input files in attribute import (page 167)
Examples of input files used in attribute import (page 168)
Data file used in attribute import (page 170)
Attribute import settings (page 170)

### 18.1 Import attributes

You can import user-defined attribute (UDA) values from a text file.

1. Copy the text file that you want to import to the current model folder.
2. If you want to import user-defined attributes to a selected area in the Tekla Structures model, select an area in the model.
3. On the **File** menu, click **Import --> Attributes**.
   The **Import Attribute** dialog box opens.
4. Click the ... button next to the **Input file** box to browse for the file to be imported.

5. Select the delimiter used in the text file.

6. Select an option in the **Input scope**, **Create log file** and **Display log file** boxes.

7. Click **Create** to import the file.

**See also**

- **Input files in attribute import** (page 167)
- **Examples of input files used in attribute import** (page 168)
- **Data file used in attribute import** (page 170)
- **Attribute import settings** (page 170)

### 18.2 Input files in attribute import

Input files used in the import of user-defined attribute (UDA) values are text files, which are delimited by a comma, tab, semi-colon, space or a user-defined delimiter. The input files contain the names and values of the user-defined attributes to be imported to the Tekla Structures model.

In the input file, the column headings must contain the names of properties and user-defined attributes in model objects and drawings. The remaining lines contain the values of the properties and user-defined attributes.

You must include at least one key field as a column heading. Key fields are drawing or model object properties. Tekla Structures uses the key fields to identify the model objects or drawings to which the user-defined attributes are assigned.

The key fields for model objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUID</td>
<td>ID4FEAFC88-0000-0004-3133-343038303031</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the model object that has a GUID value of ID4FEAFC88-0000-0004-3133-343038303031.</td>
</tr>
<tr>
<td>ASSEMBLY_POS or MARK</td>
<td>A3</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has an ASSEMBLY_POS value of A3. Repeat this line for each assembly you want to include.</td>
</tr>
</tbody>
</table>
PHASE 2

Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has a PHASE value of 2.

You must also use ASSEMBLY_POS as a key field with this option.

The key fields for drawing objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE NAME</td>
<td>A D4</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the drawing that has a TYPE value of A and a MARK value of D4. Use both key fields in the input file.</td>
</tr>
<tr>
<td>ID</td>
<td>134</td>
<td>Tekla Structures assigns the user-defined attributes in this line in the input file to the drawing object that has an ID value of 134.</td>
</tr>
</tbody>
</table>

If you want to use user-defined attributes of other value types than the string in the input file, you need to define them in the import_macro_data_types.dat file, located in the ..\Tekla_Structures \<version>\environments\common\system folder.

TIP If you use Microsoft Excel to create the input file, save the file with the Save as command to Text (Tab-delimited) (*.txt) format.

See also

Attribute import (page 166)
Import attributes (page 166)
Examples of input files used in attribute import (page 168)
Data file used in attribute import (page 170)
Attribute import settings (page 170)

Examples of input files used in attribute import

Example input file for parts

ASSEMBLY_POS and PHASE are the key fields. Tekla Structures adds several user-defined attributes to the assemblies with values that match those listed in the ASSEMBLY_POS and PHASE columns.

For example, an assembly with the ASSEMBLY_POS (assembly number) of B5 in phase 1 gets the following user-defined attributes:
The input file contains several entries for B1. In this case, Tekla Structures writes the message **Duplicate entry in input file** in the log file and does not overwrite the user-defined attributes that are listed earlier in the file with those that are listed later. For example, at the end of the attribute import, B1 will have the following user-defined attributes:

**STATUS:** 7

**USER_PHASE:** 3

**USER_ISSUE:** 3/25/2012

This input file is tab-delimited. You can also use a comma, semi-colon, space or a user-defined delimiter.

**Example input file for drawings**

**TYPE** and **NAME** are the key fields. Tekla Structures adds a value for the user-defined attribute **User field 4** to drawings with values that match those listed in the **TYPE** and **NAME** columns.

For example, a drawing with the **TYPE A** (assembly drawing) and **NAME B.2** gets the value 4 in the **User field 4**.
Data file used in attribute import

If you want to use user-defined attributes of other value types besides string in the attribute import input file, you need to define them in the import_macro_data_types.dat file, located in the ..\\Tekla Structures \<version>\environments\common\system folder.

The import_macro_data_types.dat file is a simple text file listing the user-defined attributes that you can include in an input file.

You can modify the file using any standard text editor, for example, Microsoft Notepad.

You can:

• Change any of the user-defined attributes that are not key fields.
• Add user-defined attributes as INT, STRING, FLOAT, or DATE value types.

The file contains the following columns:

VARIABLE_NAME, VARIABLE_TYPE, CONVERSION_FACTOR, COMMENT

NOTE Tekla Structures uses CONVERSION_FACTOR to convert imperial values to metric values. Tekla Structures only uses this value in Imperial environments. We recommend that you check the FLOAT values to avoid conversion factor errors.

Tekla Structures treats lines starting with double forward slash characters // as comments and ignores them when reading the file.

See also

Attribute import (page 166)
Import attributes (page 166)
Input files in attribute import (page 167)
Examples of input files used in attribute import (page 168)
Attribute import settings (page 170)
### 18.3 Attribute import settings

Use the options in the **Import Attribute** dialog box to define the input scope and log file properties when importing user-defined attribute (UDA) values from a text file to a model.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input file delimiters</strong></td>
<td>Select the delimiter used in the input file.</td>
</tr>
</tbody>
</table>
| **Input scope**      | • **Default, Entire model**  
Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in the model.  
• **Selection only**  
Tekla Structures only assigns the user-defined attribute values of objects in the input file to matching objects in the selected area of the model.  
Use this option to import user-defined attributes to models. Do not use it for drawings.  
• **Reference models**  
Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in reference models. |
| **Create log file**  | • **Create**  
Creates a new log file named *attribute_import.log* in the current model folder each time you import the user-defined attributes. Any previous attribute import log files are overwritten.  
• **Append**  
Adds log entries to the *attribute_import.log* file in the current model folder each time you import the user-defined attributes. If the log file does not exist, Tekla Structures creates it.  
• **No**  
Does not create a log file. |
| **Display log file** | • **No**  
The log file is not displayed.  
• **On dialog**  
Tekla Structures displays the log file in a separate window. Click an object GUID in the log file to highlight the part in the model. |
See also

Attribute import (page 166)
Import attributes (page 166)
Input files in attribute import (page 167)
Examples of input files used in attribute import (page 168)
Data file used in attribute import (page 170)
19 CIS and CIMSteel

The CIS (CIMsteel Integration Standards) is one of the results of the Eureka CIMsteel project. The current version CIS/2 is an extended and enhanced second-generation release of the CIS. It was developed to facilitate a more integrated method of working through the sharing and management of information within, and between, companies involved in the planning, design, analysis and construction of steel framed buildings and structures.

There is one limitation: multi-material objects cannot be defined, because the standard concentrates on steel objects.

See also
CAD model import settings (page 137)

19.1 Import a CIMSteel model

1. On the File menu, click Import --> CIMSteel. The Import Model dialog box opens.
2. Select Import CIS model from the Type list.
3. Use the default name import model or enter a new name.
4. Click OK.
5. Select the model from the list.
6. Click Properties to open a dialog box where you can define the settings for the import file type you selected.
7. On the Parameters tab, enter the following information:
   • Select the Model type, which can be Analysis, Design or SP3D.
   • Select CIS/1 or CIS/2 from the CIS version list.
   • Enter the name of the model file in the Input file box. You can also browse for the file.
• Set the origin coordinates to place the file in a specific location.

• To combine several elements in the CIS model into one part in Tekla Structures, set Combine members to Yes.

• Use Max length for combining to define the maximum length for combining parts (the maximum length of the combined parts together).

• Set Ignore offsets Yes if you want Tekla Structures to use member offsets to locate the physical members.

• In Ignore forces, indicate how forces are imported.

• To also import part GUIDS, set Import GUID (design model) to Yes.

8. On the Conversion tab, enter the conversion file names or browse for the conversion files.

9. Click OK to go to the Import Model dialog box.

10. Click Import.

   Tekla Structures displays the Import model info dialog box.

11. Select which version of parts to import.

12. Click Accept all.

   If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual.

13. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.

   Tekla Structures displays the import model in a model view.

14. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.

15. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also

CAD model import settings (page 137)

19.2 Export to a CIMSteel analysis model

1. Open a Tekla Structures model that you want to export.

2. Select the objects to export using the appropriate selection switches or filters.

3. On the File menu, click Export --> CIMSteel: Analysis model.
4. Select the CIS version from the **CIS version** list.
   - **CIS/1** generates a file that is compatible with the CIMsteel LPM4DEP1 schema declaration.
   - **CIS/2** generates a file compatible with the CIMSteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration.

5. Enter a name for the export file in the **Step file** box or accept the default. You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.

6. If required, enter a name and organization to identify who created the export file.

7. From the **Flavor** list, select one of the following standards to apply to the export: **UK**, **EUROPEAN**, or **US**.

8. Set units to **metric** or **imperial** in the **Linear units (CIS/2 only)** box. Imperial is only available for CIS/2. CIS/1 is always exported in metric units.

9. Enter coordinate values in **Origin X**, **Y**, and **Z** boxes if you want to export the model to a specific location. The origin comes from the origin in Tekla Structures.

10. To split a part in the Tekla Structures model into several elements in the CIMsteel model, set **Split members** to **Yes**.
    For example, three columns may be connected to a beam in a model, so that one column is in the middle and the others are at each end of the beam. With the **Yes** option the beam is split into two equal elements in the CIMsteel model. With the **No** option there will be one beam, a single linear element, and two nodes (a node at each end) in the CIMsteel model.

11. Click **Apply** and **Create**.
    Tekla Structures exports the CIMSteel analysis model to the current model folder, or to another folder you specified, using the name you specified.

**See also**

*CIS and CIMSteel (page 173)*

### 19.3 Export to a CIMSteel design/manufacturing model

1. Open a Tekla Structures model that you want to export.
2. Select the parts that you want to export.
3. On the **File** menu, click **Export --> CIMSteel: Design/Manufacturing Model**.
4. Go to the Parameters tab and specify the required information:
   • Select the LPM version: LPM4 or LPM5.
   • Enter name for the export file in the Output file box or accept the default.
     You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.
   • Select the model type from the CIS/2 model type list. The options are manufacturing, design, and SP3D.
   • Set units to metric or imperial in the Linear units (CIS/2 only) box.
     With Imperial units Tekla Structures writes all of the designations for nuts, bolts, and washers in fractional inches.
   • Enter a name for the structure in the Structure name field.
   • Enter the path to the profile and material conversion files or browse for them.
     If you leave the profile and material conversion file paths empty, Tekla Structures uses the conversion files in the current profile folder for the conversion.
   • To export globally unique IDs instead of internal ID numbers, set Export Globally unique ID to Yes.
   • If you want to export concrete parts, set Export concrete to Yes.

5. Go to the Standards tab, and enter the appropriate profile, material, and bolt standard organization, name and year.

   Tekla Structures populates the export file with the information you enter here. If you do not enter the standard organization or the name, Tekla Structures places an empty entry ("") in the export file. If you do not give the year, Tekla Structures uses 1999 as the default value.

6. If you are exporting to a manufacturing model, go to the Manufacturing tab, and specify the required information:
   • Set Include NC files to Yes to include information on NC files in the export.
   • In NC file directory, specify the path (relative to the current model folder) to the folder where the NC files are located.

7. If you are exporting to a design model, go to the Design model tab, and set Export design connections to Yes to export design connections.

8. Click Apply and Create.

   Tekla Structures exports the CIMSteel design or manufacturing model to the current model folder, or to another folder you specified, using the name you specified.
CIMSteel conversion files

Here are examples of the contents of the conversion files used in CIMSteel conversion.

Example 1
This example shows part of the profile conversion file prfexp_cis.cnv:

```
! US Imperial Flavor
! Profile name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name
!
!American Sections - Imperial
!W - Wide Flange Beams
W44X335 S\SECT\US\W44X335\ASTM_A6\1994
W44X290 S\SECT\US\W44X290\ASTM_A6\1994
W44X262 S\SECT\US\W44X262\ASTM_A6\1994
```

**Converted-name** contains the following information, and items are separated by a backslash (\):

- S (fixed value)
- SECT (fixed value)
- Name of the standardization organization
- Standard name of the profile shape
- Name of the standard
- Year of the standard

If the conversion file does not contain the relevant profile type, the Tekla Structures name of the profile is used. Tekla Structures also uses the standardization organization, standard name and year of standard defaults given on the **Standards** tab.

Example 2
This example shows part of the material conversion file matexp_cis.cnv:
# Carbon Structural Steel (ASTM_A36\1994)
GRADE32 S\MAT\US\GRADE32\ASTM_A36-94\1994
GRADE36 S\MAT\US\GRADE36\ASTM_A36-94\1994

#High Strength Carbon Manganese Steel (ASTM_A529\1994)
GRADE42 S\MAT\US\GRADE42\ASTM_A529-94A\1994

**Converted-name** contains the following information, and items are separated by a backslash (\):

- S (fixed value)
- MAT (fixed value)
- Name of the standardization organization
- Standard name of the material
- Name of the standard
- Year of the standard

**Converted-name** contains the following information about bolts, nuts, and washers, separated by two colon characters (\::\):

- Name of the standards organization
- Name of the standard
- Year of the standard
- Standard name of the bolt, washer, or nut

Tekla Structures names for bolts, washers, and nuts are constructed from their fastener standard, fastener type and size.

If the conversion file does not contain an equivalent profile name, Tekla Structures uses the name of the material.

**See also**

[Export to a CIMSteel design/manufacturing model (page 175)]
[Conversion files (page 32)]
You can export model data to Manufacturing Information Systems (MIS). The MIS export supports the following formats:

- DSTV
- FabTrol / KISS
- EJE
- EPC
- Steel 2000

**NOTE** We recommend using the FabTrol reports instead of the MIS export for exporting FabTrol data. The FabTrol reports are available for the Steel Detailing role in the US imperial and US metric environments. If you do not use a suitable environment you may also contact your local support for the FabTrol files.

See also

Export a MIS list (page 179)
Information on MIS file types (page 180)

### 20.1 Export a MIS list

You can export an MIS list to a file.

1. On the **File** menu, click **Export --> MIS**.
   
   The **Export MIS** dialog box opens.

2. Select the file type from the MIS type list.

3. If you selected **Fabtrol/KISS** or **Steel 2000**, define the additional options:
- **Fabtrol/KISS**
  Enter the customer name in the **Customer name** box.
  Select the **Full material list** check box to add labor-related information to the list (for example, holes, welds, cambers, preliminary marks).

- **Steel 2000**
  Select the **Export only shop bolts** check box to include only workshop bolts in the list file.

4. Enter a name for the list file in the **MIS list file** box.
   By default, the list file is saved in the model folder.
   You can select the folder where you want to save the list file by clicking **Browse**.

5. Ensure that you have the selection switch **Select objects in components** selected. If you have the switch **Select assemblies** selected, Tekla Structures will create empty files.

6. Click **Create all** or **Create selected** to export the MIS list file.

**See also**

**Information on MIS file types (page 180)**

### 20.2 Information on MIS file types

See below for information on MIS file types.

- **DSTV**
  The exported file contains the MIS information written in the DSTV format.

- **EJE**
  US Imperial version only.
  Structural Material Manager internally stores all dimensions in sixteenths. Its External Data Interface writes all dimensions, such as widths and lengths, except for Beam and Channel descriptions, in sixteenths of an inch.

  As an example the length 12'-8 7/8 is equivalent to 2446 sixteenths, which is calculated as \((\text{feet} \times 192) + (\text{inches} \times 16) + (\text{eighths} \times 2) = (12 \times 192 + 8 \times 16 + 7 \times 2)\).

- **EPC**
  The EPC (Estimating and Production Control) module of SDS/2 requires multinumbering to be active.
You can import fabrication status information for parts to a Tekla Structures model from an XML file written by FabTrol.

FabTrol is a Material Resource and Planning (MRP) system commonly used by steel fabricators to manage estimating, inventory and production. Data can be written to FabTrol via a KISS format export or directly via the text based reports from Tekla Structures for tracking of the assembly status through the project lifecycle. The tracking information entered in FabTrol can then be re-imported back to Tekla Structures via the FabTrol XML import for colorization of the model. This is performed by storing the data in a preset collection of user-defined attributes (UDAs). Import of the FabTrol XML is possible in all configurations of Tekla Structures (including Project Viewer) but data can only be saved into the UDAs in modeling or management configurations.

You need to have the XMLTrans.trn file in the ..\ProgramData\Tekla Structures\<version>\environments\<environment>\system folder. This file maps the FabTrol XML names to Tekla Structures UDA names.

See also
Import a FabTrol XML file (page 181)

### 21.1 Import a FabTrol XML file

1. On the **File** menu, click **Import --> FabTrol XML**.
2. Click the ... button next to the **Input file** box to browse for the XML file.
3. Select an appropriate option from the **Create log file** list:
   - Select **Create** to write a new log file and delete the previous log file each time you import the XML file.
   - Select **Append** to add the log file information at the end of the existing log file.
   - If you do not need a log file, select **No**.
4. Select an appropriate option from the **Display log file** list:
   • If you do not want to display the log file, select **No**.
   • To display the log file, select **On** dialog.

5. Click **Create** to import the status information.

**See also**

FabTrol XML (page 181)
You have the following tools available for download in Tekla Warehouse:
PDMS/E3D and Tekla Structures Interoperability: Export to PDMS/E3D
PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension
BIM Publisher
Tekla User Assistance contains the following articles about PDMS/E3D:
PDMS/E3D and Tekla Structures Interoperability: Q&A, collected 06 May 2016
AVEVA PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension
PDMS
NC (Numerical Control) refers to a method where machine tool operations are controlled with a computer. The NC data controls the motion of CNC (computer numerical control) machine tools. During the manufacturing process a machine tool or machining center drills, cuts, punches or shapes the piece of material.

After you have finished detailing a Tekla Structures model, you can export the NC data as NC files from Tekla Structures to be used by CNC machine tools. Tekla Structures transforms the part length, hole positions, bevels, notches, and cuts into sets of coordinates that the machine tools can use to create the part in a shop. In addition to the CNC machine tools, the NC files can also be used by MIS and ERP software solutions.

The data for the NC files comes from the Tekla Structures model. We recommend that you complete detailing and create drawings before producing the NC files.

Tekla Structures produces NC files in DSTV format (Deutscher Stahlbau-Verband). Tekla Structures can also produce NC files in DXF format by converting DSTV files to DXF files.

DSTV is a standard interface for geometrical description of steel structure pieces for the post-processors with numerical control. The essential aim of this interface is to be neutral, which means that with only one standard description you can manage several different NC machines. The interface standardizes the link between a CAD-program or a graphical system via a CAM file for the NC machines. The geometry of the piece is introduced completely neutrally, and after knowing the parameters of the NC machine, the post-processor is able to translate this neutral language to the NC machine language. For more information, visit http://www.deutscherstahlbau.de/dstv/der-verband.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produce NC files in DSTV format. You can select the information to be included in NC files and NC file headers, and define the desired pop-</td>
<td>Create NC files in DSTV format (page 187)</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Click the links below to find out more</strong></td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>mark and contour mark settings.</td>
<td>DSTV file description (page 186)</td>
</tr>
<tr>
<td>Check the DSTV file description. DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.</td>
<td>NC file settings (page 189)</td>
</tr>
<tr>
<td>Define settings for NC files, folder locations, part selection, hard stamps, holes and cuts, AK and IK block curve radius signs, and curve detection</td>
<td>Customize NC file header information (page 199)</td>
</tr>
<tr>
<td>Customize the order in which information is displayed in an NC file, and add additional information on individual parts in the NC file header</td>
<td>Create pop-marks in NC files (page 200)</td>
</tr>
<tr>
<td>Define and generate pop-marks in NC files. Pop-marks are small holes that help the shop assemble individual parts to form an assembly.</td>
<td>Create contour marking in NC files (page 205)</td>
</tr>
<tr>
<td>Create NC files in DXF format by converting DSTV files to DXF files</td>
<td>Create NC files in DXF format (page 209)</td>
</tr>
<tr>
<td>Select a correct method for cutting the end of the beams</td>
<td>Fittings and line cuts in NC files (page 207)</td>
</tr>
<tr>
<td>Create NC files for tubular hollow sections. You first need to use</td>
<td>Create tube NC files (page 208)</td>
</tr>
</tbody>
</table>
To find out more specific tube components to create the connections.

23.1 DSTV file description

Tekla Structures produces NC files in DSTV format. DSTV format is an industrial standard defined by the German Steel Construction Association (Deutsche Stahlbau-Verband). A DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.

To learn more about the DTSV syntax, see Standard Description for Steel Structure Pieces for the Numerical Controls.

Blocks

The DSTV file is divided into blocks that describe the content of the file.

<table>
<thead>
<tr>
<th>DSTV block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST</td>
<td>Start of the file</td>
</tr>
<tr>
<td>EN</td>
<td>End of the file</td>
</tr>
<tr>
<td>BO</td>
<td>Hole</td>
</tr>
<tr>
<td>SI</td>
<td>Hardstamp</td>
</tr>
<tr>
<td>AK</td>
<td>External contour</td>
</tr>
<tr>
<td>IK</td>
<td>Internal contour</td>
</tr>
<tr>
<td>PU</td>
<td>Powder</td>
</tr>
<tr>
<td>KO</td>
<td>Mark</td>
</tr>
<tr>
<td>KA</td>
<td>Bending</td>
</tr>
</tbody>
</table>

Profile types

Profile types are named according to the DSTV standard.

<table>
<thead>
<tr>
<th>DSTV profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>I profiles</td>
</tr>
<tr>
<td>U</td>
<td>U and C profiles</td>
</tr>
<tr>
<td>L</td>
<td>L profiles</td>
</tr>
<tr>
<td>M</td>
<td>Rectangular tubes</td>
</tr>
<tr>
<td>RO</td>
<td>Round bars</td>
</tr>
<tr>
<td>RU</td>
<td>Round tubes</td>
</tr>
<tr>
<td>B</td>
<td>Plate profiles</td>
</tr>
</tbody>
</table>
### DSTV profile type

<table>
<thead>
<tr>
<th>DSTV profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>CC profiles</td>
</tr>
<tr>
<td>T</td>
<td>T profiles</td>
</tr>
<tr>
<td>SO</td>
<td>Z profiles and all the other types of profile</td>
</tr>
</tbody>
</table>

#### Part faces

Single letters in the DSTV file describe the part faces.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Part face</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>front</td>
</tr>
<tr>
<td>o</td>
<td>top</td>
</tr>
<tr>
<td>u</td>
<td>bottom</td>
</tr>
<tr>
<td>h</td>
<td>behind</td>
</tr>
</tbody>
</table>

#### See also

Create NC files in DSTV format (page 187)

---

### 23.2 Create NC files in DSTV format

Tekla Structures produces NC files in DSTV format. You can select the information to be included in NC files and NC file headers, and define the desired pop-mark and contour mark settings. You can also produce MIS (Manufacturing Information System) list files according to the DSTV standard.

By default, Tekla Structures creates the NC files in the current model folder. In most cases each part has its own NC file.

**Limitations:**

- The DSTV standard does not support curved beams, and therefore Tekla Structures does not create NC files for curved beams. Use polybeams instead of curved beams.

- DSTV for bent plates does not support KA block.

1. On the **File** menu, click **Export --> NC files** .
2. If you have some predefined settings that you want to use, select the settings from the settings file list at the top and click **Load**.
3. In the **NC Files** dialog box, select the check box in the **Create** column next to **DSTV for plates** and/or **DSTV for profiles**.
4. To modify the NC file settings (page 189), select an NC file settings row, and click Edit.

If you want to add new NC file settings, click Add. This will add a new row in the NC file settings list, and the NC File Settings dialog box is displayed, where you can give the settings a new name.

5. In the NC File Settings dialog box, modify the settings on the Files and part selection, Holes and cuts, Hard stamp and Advanced Options tabs.

You can select to create only DSTV files, MIS files, both, or DSTV files embedded in MIS files.

Hard stamps can be created for both the main part and the secondary parts. By default, Tekla Structures creates hard stamps only for the main part. Set the advanced option XS_SECONDARY_PART_HARDSTAMP to TRUE to also create hard stamps for secondary parts.

6. You can enter a unique name for the settings using Save as. Tekla Structures saves the settings in the ..\attributes folder under the current model folder.

7. Click OK to save your NC file settings and to close the NC File Settings dialog box.

8. To select the information to be included in the NC file header (page 199), click Header, modify the information, and click OK.

9. To modify the pop-mark settings (page 200), click Pop-marks, modify the settings and click OK.

10. To modify the contour marking settings (page 205), click Contour marking, modify the settings and click OK.

11. To save the settings that you have modified with another name for later use, click enter a new name next to Save as and click Save as.

12. In the NC Files dialog box, use the All parts or Selected parts options to select whether to create the NC files for all parts or only for the selected parts.

If you use the Selected parts option, you need to select the parts in the model.

13. Click Create.

Tekla Structures creates .nc1 files for the parts using the defined NC file settings. By default, the NC files are created in the current model folder. The filename consists of a position number and the extension .nc1.
14. Click **Show NC log** to create and show the log file `dstv_nc.log` that lists the exported parts and the parts that were not exported.

If all expected parts are not exported, check that the parts which were not exported pass all the profile type, size, hole and other limits set in the NC file settings.

For more information on contour marking, see the support article How to create contour marking for steel beams.

### 23.3 NC file settings

You can open the **NC File Settings** dialog box by clicking **Add** or **Edit** in the **NC Files** dialog box. Here you can define settings for NC files, folder locations, part selection, hard stamps, holes and cuts, AK and IK block curve radius signs, and curve detection.

**Files and part selection tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File format</strong></td>
<td>DSTV is the only available value.</td>
</tr>
<tr>
<td><strong>File location</strong></td>
<td>The default folder is <code>\DSTV_Profiles</code> or <code>\DSTV_Plates</code> under the current model folder. You can define another destination folder for NC files in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>• You can enter the folder path in the <strong>File location</strong> box. You can also browse for the path. For example, enter C:\NC.</td>
</tr>
<tr>
<td></td>
<td>• If you leave the field empty, the NC files will be created in the current model folder.</td>
</tr>
<tr>
<td></td>
<td>• To create the NC file in a specific folder under the current model folder, enter &lt;folder_name&gt;. For example, enter \MyNCFiles.</td>
</tr>
<tr>
<td></td>
<td>• You can use the model-specific advanced option <code>XS_MIS_FILE_DIRECTORY</code> to define the destination folder for NC and MIS files. Go to the <strong>CNC</strong> category in the <strong>Advanced Options</strong> dialog box, and enter the desired folder path for the advanced option <code>XS_MIS_FILE_DIRECTORY</code>. The NC files will be</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>created in the specified folder under a folder that has the name of the current model. For example, if you define C:\NC, and the name of the current model is MyModel, the NC files will be created in the folder C:\NC\MyModel.</td>
<td></td>
</tr>
<tr>
<td>File extension</td>
<td>.nc1 is the default value.</td>
</tr>
<tr>
<td>Include revision mark to file name</td>
<td>Add a revision mark to the NC file name. The file name then includes a number indicating the revision of the file, P176.nc1 becomes P176_1.nc1, for example.</td>
</tr>
<tr>
<td>Create what</td>
<td>Select the type of files to create:</td>
</tr>
<tr>
<td>NC files</td>
<td>creates only DSTV files.</td>
</tr>
<tr>
<td>Part list</td>
<td>creates only a MIS list file (.xsr).</td>
</tr>
<tr>
<td>If you create an MIS list file, enter a name for the list in the Part list file name box. Also, you need to click the Browse button next to the Part list file location box and browse for the location where you want to save the list.</td>
<td></td>
</tr>
<tr>
<td>NC files and part list</td>
<td>creates both the DSTV files and an MIS list file.</td>
</tr>
<tr>
<td>Combined NC files and part list</td>
<td>embeds DSTV files in an MIS list file (.xsr).</td>
</tr>
<tr>
<td>Maximum size</td>
<td>The options define the maximum length, width, and height of the parts the machine tool can handle. Larger parts are sent to other machines.</td>
</tr>
<tr>
<td>Profile type</td>
<td>All profiles that are set to Yes in the Profile type list can be handled by the machine tool. Profile types are named according to the DSTV standard.</td>
</tr>
<tr>
<td>I: I profiles</td>
<td></td>
</tr>
<tr>
<td>U: U and C profiles</td>
<td></td>
</tr>
<tr>
<td>L: L profiles</td>
<td></td>
</tr>
<tr>
<td>M: Rectangular tubes</td>
<td></td>
</tr>
<tr>
<td>R: Round bars and tubes</td>
<td></td>
</tr>
<tr>
<td>B: Plate profiles</td>
<td></td>
</tr>
<tr>
<td>CC: CC profiles</td>
<td></td>
</tr>
<tr>
<td>T: T profiles</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SO: Z profiles and all the other types of profiles</td>
<td>By default, Tekla Structures unwraps round tubes as plate profiles and uses the plate profile type B in the NC file header data. To change this, use the advanced option XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC.</td>
</tr>
</tbody>
</table>

**Maximum size of holes**

The **Maximum size of holes** options define how large holes the machine tool is able to drill. The NC file is not created if a part contains larger holes or its material is thicker than the specified values. The hole size is connected to material thickness or plate thickness.

Each row contains the maximum hole diameter and the material thickness. Both conditions have to be met for the NC file to be created. For example, a row with the values 60 45 means that when the material thickness is 45 mm or smaller, and the hole diameter is 60 mm or smaller, the NC file is created. You can add as many rows as needed.

The following example shows how the Maximum size of holes can be defined. In this example, we have the following situation:

- Three plates of different thickness.
- Two bolt groups with equal sizes, and one bolt group with a larger size.

**Maximum size of holes** are defined as follows:

**Test1** creates a folder under the model folder for the plates that meet the following criteria:

- **Hole diameter**: 22
- **Plate thickness**: 10

**Test2** creates a folder under the model folder for the plates that meet the following criteria:

- **Hole diameter**: 22
### Option Description

- **Plate thickness**: 20

  When you create NC files for the plates, the folder Test1 includes the plate PL350*10 and the folder Test2 includes the plate PL350*20. The plate PL350*15 is not included in any folder, because the hole size criterion is not met.

  The order in which you enter the criteria is important: enter the most exclusive criteria first. If you define the criteria in a different order, the results will also be different.

### Holes and cuts tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inner corners shape</strong></td>
<td>The <strong>Inner corners shape</strong> option defines the shape of, for example, web notches or flange cuts at the beam end.</td>
</tr>
</tbody>
</table>

The **Inner corner shape** option also affects cuts on the flange:

The **Inner corner shape** option does not apply to rectangular openings that are located in the middle of a part:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td>The <strong>Inner corner shape</strong> option does not apply to those inner contours that are already rounded in the model. The model values remain intact. The examples in the below show how the different inner corner shape options affect the part in the NC file. The original part in the model has flanges cut entirely and the web is notched.</td>
</tr>
<tr>
<td><strong>Option 0: Radius</strong></td>
<td><img src="image" alt="Diagram" /> The inner corners are shaped like holes with a given radius. A separate BO block is not written to the NC file.</td>
</tr>
<tr>
<td><strong>Option 1: Tangential</strong></td>
<td><img src="image" alt="Diagram" /> The inner corner is rounded according to the value in the Radius box.</td>
</tr>
<tr>
<td><strong>Option 2: Square</strong></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>2</td>
<td>The corner is as it is in the model.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Drilled hole</strong></td>
</tr>
<tr>
<td>4</td>
<td><strong>Tangential drilled hole</strong></td>
</tr>
</tbody>
</table>

A drilled hole is added to the inner corner. The hole radius is the same as the value in the *Radius* box. Holes are written as a separate BO block to the NC file.

The *Distance from flange within which web is not cut* option defines the height of the flange clearance area. The clearance check only affects the I, U, C, and L DSTV profile types.

If a cut in a part is located closer to the flange than the clearance in the model, the cut points inside that clearance are moved to the border of the clearance area when the NC file is written.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>The part how it is modeled. The cut goes closer to the top flange than the defined flange clearance in the NC file settings:</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram 1" /></td>
</tr>
<tr>
<td></td>
<td>The part how it is written in the NC files. The dimension shows the clearance. The top of the original cut is moved so that the clearance area is left free. The bottom of the cut is not moved.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram 2" /></td>
</tr>
<tr>
<td>Machine slots as</td>
<td>The <strong>Machine slots as</strong> option defines how slotted holes are created:</td>
</tr>
<tr>
<td>Ignore slots</td>
<td><strong>Ignore slots</strong>: Slotted holes are not created in the NC file.</td>
</tr>
<tr>
<td>A single hole in the center of the slot</td>
<td><strong>A single hole in the center of the slot</strong>: Drills a single hole in the center of the slotted hole.</td>
</tr>
<tr>
<td>Four small holes, one at each corner</td>
<td><strong>Four small holes, one at each corner</strong>: Drills four smaller holes, one at each corner.</td>
</tr>
<tr>
<td>Internal contours</td>
<td><strong>Internal contours</strong>: Flame-cuts the slots as internal contours.</td>
</tr>
<tr>
<td>Slots</td>
<td><strong>Slots</strong>: Leaves slots as they are.</td>
</tr>
<tr>
<td>Maximum diameter for holes to be drilled</td>
<td>The <strong>Maximum diameter for holes to be drilled</strong> option defines the maximum hole diameter. Holes and slotted holes that are larger than the maximum hole diameter are manufactured as internal contours.</td>
</tr>
<tr>
<td>Maximum diameter for circular cuts to be</td>
<td><strong>Maximum diameter for circular cuts to be drilled</strong> defines the maximum circular part cuts. They are written as holes if the diameter of the cut</td>
</tr>
<tr>
<td>drilled</td>
<td></td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is less than the value defined for the setting. Smaller internal circular cuts are converted to holes.</td>
<td></td>
</tr>
</tbody>
</table>

**Hard stamp tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create hard stamp</td>
<td>When selected, creates hard stamps.</td>
</tr>
</tbody>
</table>
| Hard stamp content      | The Elements list defines which elements are included in hard stamps and the order in which the elements appear in the hard stamp. You can also define the **Text height** and **Case**.

**Project number**: Adds the project number to the hard stamp.

**Lot number**: Adds the lot number to the hard stamp.

**Phase**: Adds the phase number to the hard stamp.

**Part position**: Prefix and position number of the part.

**Assembly position**: Prefix and position number of the assembly.

**Material**: The material of the part.

**Finish**: The type of finish.

**User-defined attribute**: Adds a user-defined attribute (user fields 1-4) to the mark.

**Text**: Opens a dialog box where you can add user-defined text to the hard stamp.

Including part position and/or assembly position in the hard stamp affects the NC filename:

- **Part position**: P1.nc1, P2.nc1
- **Assembly position**: A1.nc1, A2.nc1
- **Assembly and part position**: A1-P1.nc1, A2-P2.nc1
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hard stamp placing     | If you set the option **By orientation mark** to **Yes**, the default face is changed from bottom (u) to top (o) for L profiles, rectangular tubes and round bars.  
                          The **Side** option defines the side of the part on which the hard stamp is placed.  
                          The **Position along the part** and **Position in depth of part** options define the position of hard stamps on parts.  
                          These options move the hard stamp on the same face it is created, but they cannot move the stamp to a different face. If the face is, for example, the bottom flange, you can move the stamp to a different place on bottom flange, but not to the top flange.  
                          Default faces for different profiles:  
                          I profile: Bottom flange (u)  
                          U and C profiles: Back side of web (h)  
                          L profiles: Back (h) or Bottom (u)  
                          Rectangular tubes: Bottom flange (u)  
                          Round bars: Bottom flange (u)  
                          Circular tubes: Front (v)  
                          T profiles: Back side of web (h)  
                          Plate profiles: Front (v)  
<p>| Advanced Options tab   |                                                                                                                                                                                                                                                                                                                                                                |
| <strong>Option</strong>             | <strong>Description</strong>                                                                                                                                                                                                                                                                                                                                                  |
| Number of decimals     | Define the number of decimals shown in NC files.                                                                                                                                                                                                                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change external contour (AK block) radius sign</strong></td>
<td>Change the AK block curve radius signs on top (o) and back (h) faces. This change only affects on top (o) and back (h) faces.</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign on top (o) and back (h) faces** is not selected.

<table>
<thead>
<tr>
<th>AR</th>
<th>0.00s</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>115.98</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>155.99</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1316.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>115.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign on top (o) and back (h) faces** is selected.

<table>
<thead>
<tr>
<th>AR</th>
<th>0.00s</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>115.98</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1316.75</td>
<td>155.99</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>155.99</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>115.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1066.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Change internal contour (IK block) radius sign**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change internal contour (IK block) radius sign</strong></td>
<td>Change the IK block curve radius signs for on (o) and back (h) faces. This change only affects on top (o) and back (h) faces</td>
</tr>
</tbody>
</table>

**Curve detection**

**Chord tolerance**

**Curve detection** controls whether three points should be read as a curve instead of two straight lines. When **Curve detection** is set to **Yes**, Tekla Structures checks the edges of a solid against a virtual curve described by the edges to see if the edges are curved or straight based on the **Chord tolerance** value. Enter the **Chord tolerance** value in millimeters. **Curve detection** is on by default.
### Customize NC file header information

You can customize the order in which information is displayed in an NC file, and add additional information on individual parts in the NC file header.

1. On the **File** menu, click **Export --> NC Files**.
2. Click the **Header** button in the **NC Files** dialog box.
3. In the **NC File Header Information** dialog box, include in the **Selected elements** list the header information options that you want, and arrange the options in the desired order by selecting the option and using the **Move up** and **Move down** buttons.
4. If needed, add additional information on individual parts.
You can enter text in the **Text info on piece 1 - 4** boxes, and enter desired template attributes in double angle brackets, for example `<WEIGHT>` to display the weight of the part.

5. Click **OK**.

6. If you want to restore the default file header information, click the **Default** button in the **NC File Header Information** dialog box.

7. **Create the NC files** (page 187).

### 23.5 Create pop-marks in NC files

Pop-marks are small holes that help the shop assemble individual parts to form an assembly. Tekla Structures is able to write the pop-mark information in NC files to help position parts that will be manually welded to the assembly main part. Pop-marks are usually made using a drilling machine that drills a small hole in the surface of the material.

**Limitation:** Tekla Structures pop-marking does not work with polybeams. Tekla Structures only creates pop-marks for parts for which you have defined pop-mark settings. You can save the pop-mark settings in a `.ncp` file, which Tekla Structures saves by default in the `..\attributes` folder under the current model folder.
NOTE Pop-marking affects numbering. For example, if two parts have different pop-marks, or one part has pop-marks and the other one does not, Tekla Structures gives the parts different numbers.

1. On the File menu, click Export --> NC files.
2. In the NC Files dialog box, select the parts for which you want to create the pop-marks by selecting the corresponding check boxes in the Pop-marks column.
3. Click the Pop-marks button.
4. In the Pop-Mark Settings, click Add to add a new row.
5. To define which parts are pop-marked and where the pop-marks are created, enter or select information for each item on a row.

The order of the rows in the Pop-Mark Settings dialog box is important. Enter the most limiting definition first, and the most generic one last.

First define the pop-mark settings on the Parts to pop-mark tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main part profile type</strong></td>
<td>Select the main part profile type that is pop-marked. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td><strong>Main part name</strong></td>
<td>Enter the names of the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? [ ] ). For example, HE* matches all parts with a profile name that begins with the characters &quot;HE&quot;. Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td><strong>Sec part profile type</strong></td>
<td>Select the secondary part profile type.</td>
</tr>
<tr>
<td><strong>Secondary part name</strong></td>
<td>Enter the names of the secondary part profiles. You can enter several</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>part names separated by commas.</td>
</tr>
<tr>
<td></td>
<td>You can use wildcards (* ? [ ] ).</td>
</tr>
<tr>
<td></td>
<td>Part name can contain more names separated by comma.</td>
</tr>
</tbody>
</table>

**Pop-mark location**

Select how the secondary part is projected onto the main part.

- **Left side**: The left side of the secondary part is marked on the main part. The left side is the side of the secondary part that is closest to the start point of the main part.
- **Right side**: The right side of the secondary part is marked on the main part.
- **Both sides**: Combines **Left side** and **Right side**.
- **Center**: Center of the secondary part.
- **Left side holes**: Marks the main part with the position of holes in the secondary part, on the left side of the secondary part.
- **Right side holes**: Marks the main part with the position of holes in the secondary part, on the right side of the secondary part.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>• Both side holes:</td>
<td>Combines <strong>Left side holes</strong> and <strong>Right side holes</strong>.</td>
</tr>
<tr>
<td>• Middle line:</td>
<td>Marks two points on the middle line of the secondary part x axis.</td>
</tr>
<tr>
<td>Move to flange</td>
<td>Select to which part of the main part flange the pop-marks are moved. The options are <strong>None</strong>, <strong>Both flanges</strong>, <strong>Top flange</strong>, and <strong>Bottom flange</strong>.</td>
</tr>
<tr>
<td>Edge distance</td>
<td>Enter the minimum distance from a pop-mark to the edge of the main part. Tekla Structures does not create pop-marks inside this distance.</td>
</tr>
<tr>
<td></td>
<td>If a pop-mark is inside the defined edge distance, Tekla Structures moves it, unless you have set <strong>Pop-mark location</strong> to <strong>Center</strong>.</td>
</tr>
<tr>
<td>Secondary pop-marks</td>
<td>Select whether pop-marks are created to the secondary parts.</td>
</tr>
<tr>
<td>Add pop marks to parts welded on site</td>
<td>Select whether pop-marks are created for parts that are welded on site.</td>
</tr>
</tbody>
</table>

Then define the pop-mark settings on the **Pop-marking options** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate part if pop-marks or other items only on the back</td>
<td>First select the <strong>Pop-marks on the back</strong> check box and then one of the options. Also set the <strong>Hole diameter</strong>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rotate part and drill through pop-marks on the back if items or more pop-marks only on the back</td>
<td></td>
</tr>
<tr>
<td>Drill through pop-marks on the back if no other items on the back</td>
<td></td>
</tr>
<tr>
<td>No pop-marks on overlapping holes</td>
<td>Select if you do not want to have pop-marks on overlapping holes.</td>
</tr>
<tr>
<td>Add pop-marks to centers of studs</td>
<td>Select to have pop-marks in the stud centers.</td>
</tr>
<tr>
<td>Show pop-marks in the model</td>
<td>Select to show pop-marks in the model.</td>
</tr>
<tr>
<td>Consider zero diameter holes as pop-marks</td>
<td>Write zero diameter bolt holes as a pop-marks.</td>
</tr>
</tbody>
</table>

6. Click **OK**.
7. Select the parts in the model.
8. Create NC files (page 187).

Pop-marks are written in the **BO** block in the DSTV file as 0 mm diameter holes. If needed, pop-marks can also be displayed in drawings. In drawings, select the **on/off** check box in the part properties to display the pop-marks.

Tekla Structures displays thick red lines for each pop-mark pair in the model view which was last updated.
Examples
Tekla Structures marks the center point of all round secondary profiles on a main part, and does not create pop-marks closer than 10 mm to the main part edge.

Tekla Structures projects the hole location in the secondary plates onto a main part.

23.6 Create contour marking in NC files
Tekla Structures is able to generate contour marking in NC files. This means that information on the layout and the parts that are welded or bolted together can be added to the NC files and passed on to the machine tool.

Limitation: Tekla Structures contour marking on polybeams does not work in all cases. The visual placement of contour marking on polybeams has been improved.

Tekla Structures only creates contour markings for parts for which you have defined contour marking settings. You can save the contour marking settings in a .ncs file, which Tekla Structures saves by default in the ..\attributes folder under the current model folder.

You can add contour marking to both the main and the secondary parts.

NOTE Contour marking affects numbering. For example, if two parts have different contour markings, or one part has contour markings and the other one does not, Tekla Structures gives the parts different numbers.

1. On the File menu, click Export --> NC files.
2. In the NC Files dialog box, select the parts for which you want to create the contour marks by selecting the corresponding check boxes in the Contour marking column.
3. Click the Contour marking button in the NC Files dialog box.
4. In the Contour marking settings dialog box, click Add to add a new row.
5. To define which parts are contour marked and how they are contour marked, enter or select information for each item on a row:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Select the main part profile type that is contour marked. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Main part name</td>
<td>Enter the name for the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? [ ] ). Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Select the secondary part profile type. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Sec part name</td>
<td>Enter the name for the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? [ ] ). Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Secondary contour marking</td>
<td>Select whether the secondary parts are contour marked.</td>
</tr>
<tr>
<td>Punch or powder</td>
<td>In the list, select how the part is contour marked:</td>
</tr>
<tr>
<td></td>
<td>• Punch: The part is punched.</td>
</tr>
<tr>
<td></td>
<td>• Powder: The part is marked with powder.</td>
</tr>
<tr>
<td></td>
<td>• Both: Both techniques are used.</td>
</tr>
<tr>
<td>Hard stamp</td>
<td>Select whether hard stamps are created.</td>
</tr>
<tr>
<td>Mark parts welded on site</td>
<td>Select whether you want to mark parts that are welded on site.</td>
</tr>
<tr>
<td>Edge distance</td>
<td>Define the minimum distance from a contour mark to the edge of the main part. Tekla Structures not create contour marks inside this distance.</td>
</tr>
</tbody>
</table>
6. Click **OK**.

7. **Create NC files (page 187).**

Contour marking is written in the **PU** and **KO** blocks in the DSTV file.

Tekla Structures displays contour marking as thick magenta lines in the model view.

---

### 23.7 **Fittings and line cuts in NC files**

When creating NC files in DSTV format, the method you use to cut the end of the beam affects the beam length in the NC file.

- **Fittings** affect the length of the beam in the NC file.
- **Line cuts** do not affect the length of the beam in the NC file.

When you cut the beam end, use the fitting method to make sure that the beam length is correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This means that Tekla Structures always takes the fitting into account when calculating the beam length.

For lines, polygons, or part cuts, the cut does not affect beam length, but the overall length in the NC file will be the gross (initially modeled) length of the beam.
1. Fitting
2. Line cut
3. Polygon or line cut
4. Fitting

**Shortest length**
If you want to use the shortest possible length in an NC file, use the advanced option XS_DSTV_NET_LENGTH.

**Net and gross length**
If you want to include both net and gross length into NC file header data, use the advanced option XS_DSTV_PRINT_NET_AND_GROSS_LENGTH.

**See also**
Create NC files in DSTV format (page 187)

### 23.8 Create tube NC files
You can create NC files for tubular hollow sections. You first need to use specific tube components to create the connections.

Create the following tube-to-tube and tube-to-plate connections:
- Tube-Chamfer
- Tube-CrossingSaddle
- Tube-MitreSaddle+Hole
- Tube-Saddle+Hole
- Tube-SlottedHole
After using the components, you can create an NC file for data export. The tube NC file creation results into an XML file which includes the model data.

**Limitations:**

To get the correct tube NC export results, note the following limitations:

- Line cuts and fittings created manually or by other components will be exported as simple chamfers.
- Holes created by bolts are not supported, and they will not be exported.
- Curved beams are not supported.

1. On the **File** menu, click **Export --> Tube NC files**.
2. In the **Tube NC Files** dialog box, enter a name for the export file, and browse for the location where you want to save the file. By default, the file is saved in the model folder.
3. Select whether you want to create the file for selected parts or for all parts.
4. Click **Create**.

Tekla Structures creates an XML file and a log file in the location you defined.

---

**23.9 Create NC files in DXF format**

You can create NC files in DXF format by converting DSTV files to DXF files. Before running a DXF conversion, you must first create the NC files in DSTV format.

**Create NC files in DXF format using Convert_DSTV2DXF**

You can convert the created NC files in DXF format by using the **Convert_DSTV2DXF** macro

**Limitation:** The macro has been designed for simple plates. Therefore it may not give correct conversion results for beams, columns and bent polybeams.

1. Create the NC files in the DSTV format.
2. Click the **Applications & components** button in the side pane to open the **Applications & components** catalog.
3. Click the arrow next to **Applications** to open the applications list.
4. If **Convert_DSTV2DXF** is not visible in the **Applications** list, select the **Show hidden items** check box at the bottom of the **Applications & components** catalog.
5. Double-click **Convert_DSTV2DXF** to open the **Convert DSTV Files to DXF** dialog box.

6. Browse for the folder that contains the NC files you want to convert to DXF files.

7. Select the NC files and click **Open**.

   Tekla Structures automatically creates an **NC_dxf** folder in the model folder and the DXF files are created there.

---

**Create NC files in DXF format using tekla_dstv2dxf.exe**

You can use a separate Tekla Structures program **tekla_dstv2dxf.exe** to convert the DSTV files to DXF format. Only one side of a part (front, top, back or bottom) is written to the file, and therefore this export format is most suited to plates.

The program is located in the ..\Tekla Structures\<version>\nt dstv2dxf folder.

1. Create a folder for the NC files, for example c:\dstv2dxf.

   Do not use spaces is the folder path. You should not save the files, for example, in the Tekla Structures folder under the \Program Files folder, because the folder path contains spaces.

2. Copy all files from C:\Program Files\Tekla Structures\<version>\nt\dstv2dxf to the folder you created (C:\dstv2dxf).

3. Create DSTV files and save the files in the in the folder you created (C:\dstv2dxf).


   The program converts the files to DXF format in the same folder.

   If you need to adjust the conversion settings (page 210), modify the settings in an appropriate **tekla_dstv2dxf_<env>.def** file and restart the conversion.

   The conversion file description pdf files can be found in the same folder as the **tekla_dstv2dxf.exe** program.

---

**tekla_dstv2dxf_<env>.def file description**

The **tekla_dstv2dxf_<env>.def** file is used when converting from the DSTV to the DXF format using the **tekla_dstv2dxf.exe**. It contains all the necessary conversion settings. The .def file is located in the ..\Tekla Structures\<version>\nt\dstv2dxf folder.

The **DSTV to DXF conversion (page 209)** settings are described below.
Environment settings [ENVIRONMENT]

INCLUDE_SHOP_DATA_SECTION=FALSE

Specify whether to include a special data section in the DXF file to allow the DXF file to be better imported into CNC software written by Shop Data Systems. Including this special data section in the DXF file makes the DXF file unreadable by AutoCAD.

Options: TRUE, FALSE

NO_INFILE_EXT_IN_OUTFILE=TRUE

Use to add the input file extension to the output file.

Options:

TRUE: p1001.dxf
FALSE: p1001.nc1.dxf

DRAW_CROSSHAIRS=HOLES

Draw crosshair for holes and slotted holes.

Options: HOLES, LONG_HOLES, BOTH, NONE

HOLES:

![Holes Crosshair](image1)

LONG_HOLES:

![Long Holes Crosshair](image2)

BOTH:

![Both Crosshair](image3)

NONE:

![None Crosshair](image4)

NC files 211 Create NC files in DXF format
**SIDE_TO_CONVERT=FRONT**

Define which side of the member to convert.

Options: FRONT, TOP, BACK, BELOW

Defines which part face is shown in the DXF file. This setting is originally designed for plates.

**FRONT** is the most typical option. Sometimes you may need another rotation for a plate, and then you can try if changing this setting to BACK would help. In addition to the **SIDE_TO_CONVERT** setting, it requires that the NC files are created with the advanced option **XS_DSTV_WRITE_BEHIND_FACE_FOR_PLATE** set to TRUE, which will include the back side data of a plate in the NC file.

**OUTPUT_CONTOURS_AS=POLYLINES**

Convert contours as polylines or lines and arcs.

Options: POLYLINES, LINES_ARCS

**NOTE** If you set **OUTPUT_CONTOURS_AS=LINES_ARCS**:

- Slotted holes may sometimes have a gap/offset between a straight line and an arc.
- Sometimes a 3D DXF is produced instead of a 2D DXF.

If you set **OUTPUT_CONTOURS_AS=POLYLINES**, the DXF file may not be correct if the NC is created with the **Inner corner=0** setting.

**CONTOUR_DIRECTION=REVERSE**

Define the contour direction. This option changes the coordinates of the vertices, and the order they are written. You can see the difference if you open the DXF file in a text editor: “reverse” is clockwise and “forward” is counter-clockwise.

Options: REVERSE, FORWARD

**CONTOUR_DIRECTION only works if you have set OUTPUT_CONTOURS_AS=POLYLINES. If you have set it to use LINES_ARCS, the output is always FORWARD (counter-clockwise).**

**CONVERT_HOLES_TO_POLYLINES=TRUE**

Convert holes to polylines.

Options: TRUE, FALSE

NC files 212 Create NC files in DXF format
MAX_HOLE_DIAMETER_TO_POINTS=10.0
Convert small holes to points in the DXF file.

When you set MAX_HOLE_DIAMETER_TO_POINTS to a value, the holes with a diameter smaller than this value will follow the HOLE_POINT_SIZE and HOLE_POINT_STYLE settings. With this kind of point visualization, the hole symbols will no longer show if a hole is bigger or smaller than the other one, but they will all have the same size.

HOLE_POINT_STYLE=33 and HOLE_POINT_SIZE=5
Point style and size for holes.

1 is a circle, but this setting is not in use
2 is +
3 is X
4 is short line
33 is circle
34 is a circle with +
35 is a circle with X
36 is a circle with short line

SCALE_DSTV_BY=0.03937
Use 0.03937 to scale to imperial units.
Use 1.0 to scale to metric units.

**ADD_OUTER_CONTOUR_ROUNDINGS=FALSE**
Add holes to roundings. This only affects the roundings that are created using the Inner corner shape = 1 setting in the NC File Settings dialog box on the Holes and Cuts tab. The hole size information is coming to the DSTV file from the Radius value in the NC File Settings dialog box, and you cannot adjust the hole size in the dstv2dxf converter.

Options: TRUE, FALSE

**ADD_OUTER_CONTOUR_ROUNDINGS=FALSE:**

**MIN_MATL_BETWEEN_HOLES=2.0**
Define how close the holes can be to each other in slotted hole conversion.

**INPUT_FILE_DIR=** and **OUTPUT_FILE_DIR=**
Folders for input and output files.

**DEBUG=FALSE**
Show data processing in the DOS window.

Options: TRUE or FALSE
Text specifications [TEXT_SPECS]

TEXT_OPTIONS=PQDG
Define the text options that you want to use in the DXF file:
S adds a side mark (Side: v)
P adds a part mark (Part: P/1)
B adds a part mark and side mark (Part: P/1 Side: v)
Q adds the quantity (Quantity: 5)
G adds the steel grade (Material: A36)
T adds the thickness (Thickness: 3)
D adds the profile description (Desc: FL5/8X7)

TEXT_POSITION_X=30.0 and TEXT_POSITION_Y=30.0
The X/Y location of lower-left corner of first line of text from the origin point <0,0> of the DXF file.

TEXT_HEIGHT=0.0
TEXT_HEIGHT is not used, the text height is always 10.0, also in text layers.

Text item prefixes
You can define several different prefixes for text items. The prefix is only written in the file if the option CONCATENATE_TEXT is set to 0.
You can use the following prefix definitions:

PART_MARK_PREFIX=Part:
SIDE_MARK_PREFIX=Side:
STEEL_QUALITY_PREFIX=Material:
QUANTITY_PREFIX=Quantity:
THICKNESS_PREFIX=Thickness:
DESCRIPTION_PREFIX=Desc:

CONCATENATE_TEXT=1
Combine text items (part mark, quantity, profile, grade) into one or two lines.
Options:
0: Text lines are not combined. Prefixes work only with this option.
1: Part mark text on one line, other texts combined on another line.
2: All text on one line.

CONCATENATE_CHAR=+
Define a separator of max 19 characters for the text items.

Examples of different text specifications

NC files 215 Create NC files in DXF format
The following settings are used the example below:

- **TEXT_OPTIONS=PQDG**
- **TEXT_POSITION_X=30.0**
- **TEXT_POSITION_Y=30.0**
- **TEXT_HEIGHT=0.0**
- **PART_MARK_PREFIX=Part:**
- **SIDE_MARK_PREFIX=Side:**
- **STEEL_QUALITY_PREFIX=Material:**
- **QUANTITY_PREFIX=Quantity:**
- **THICKNESS_PREFIX=Thickness:**
- **DESCRIPTION_PREFIX=Desc:**
- **CONCATENATE_TEXT=1**
- **CONCATENATE_CHAR=+**

The following settings are used for the example below: **TEXT_OPTIONS=B, CONCATENATE_TEXT=0:**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Layer Name</th>
<th>Color</th>
<th>Text Height</th>
<th>Output as</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEXT</td>
<td>TEXT</td>
<td>7</td>
<td>Not used, always the same as the</td>
<td>NC files 216 Create NC files in DXF format</td>
</tr>
<tr>
<td>Entity</td>
<td>Layer Name</td>
<td>Color</td>
<td>Text Height</td>
<td>Output as</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>-------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OUTER_CONTOUR</td>
<td>CUT</td>
<td>7</td>
<td>general text height</td>
<td>definition 10.0.</td>
</tr>
<tr>
<td>INNER_CONTOUR</td>
<td>CUTOUT</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PART_MARK</td>
<td>Scribe</td>
<td>3</td>
<td>Do not set a value for this</td>
<td>option. If you set one, the DXF file will not be created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHANTOM</td>
<td>LAYOUT</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NS_POP_PMARK</td>
<td>NS_POP_MARK</td>
<td>5</td>
<td>POP_CIRCLE 2.0</td>
<td>(POP_CIRCLE or POP_POINT followed by size)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS_POP_PMARK</td>
<td>FS_POP_MARK</td>
<td>6</td>
<td>1.0</td>
<td>This ‘1.0’ is the diameter of the hole used for far side pop marks. It</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>must match the value in the “drill thru” option in the machinex.ini file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Color table**

1 = red  
2 = yellow  
3 = green  
4 = cyan  
5 = blue  
6 = magenta  
7 = white

NC files 217 Create NC files in DXF format
8 = dark grey
9 = light grey

**Hole layers [HOLE_LAYERS]**

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Min Diam</th>
<th>Max Diam</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>8.0</td>
<td>10.31</td>
<td>7</td>
</tr>
<tr>
<td>P2</td>
<td>10.32</td>
<td>11.90</td>
<td>7</td>
</tr>
<tr>
<td>P3</td>
<td>11.91</td>
<td>14.0</td>
<td>7</td>
</tr>
</tbody>
</table>

**Slot layers [SLOT_LAYERS]**

The type and color affect the symbol, but the color of the slot outline or arrow (phantom) is defined by the PHANTOM layer definition in the MISC_LAYERS definition.

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Min Dia m</th>
<th>Max Dia m</th>
<th>Min ‘b’</th>
<th>Max ‘b’</th>
<th>Min ‘h’</th>
<th>Max ‘h’</th>
<th>Typ e</th>
<th>Colo r</th>
<th>Phantom</th>
</tr>
</thead>
<tbody>
<tr>
<td>13_16x1</td>
<td>20.6</td>
<td>20.6</td>
<td>4.75</td>
<td>4.78</td>
<td>0.0</td>
<td>0.02</td>
<td>3</td>
<td>3</td>
<td>PHANTOM_OUTLINE</td>
</tr>
<tr>
<td>13_16x1-7_8</td>
<td>20.6</td>
<td>20.6</td>
<td>26.9</td>
<td>26.9</td>
<td>0.0</td>
<td>0.02</td>
<td>3</td>
<td>3</td>
<td>PHANTOM_OUTLINE</td>
</tr>
</tbody>
</table>

Below there are three examples with different phantom types. The other settings used are Slot type=1, HOLE_POINT_STYLE=33 and HOLE_POINT_SIZE=1

**PHANTOM_ARROW:**

![PHANTOM_ARROW](image)

**PHANTOM_BOTH:**

![PHANTOM_BOTH](image)

**PHANTOM_OUTLINE:**

NC files    218    Create NC files in DXF format
For an explanation of the “b” and “h” dimensions, see the image below:

Examples of slot types
These example use different slot types, but the other settings are the same:

- Slot layer color is 3 (green).
- Hole layer color is 6 (magenta).
- Phantom layer color is 1 (red).
- Slot layer phantom type: PHANTOM_OUTLINE
- Hole point settings: HOLE_POINT_STYLE=35, HOLE_POINT_SIZE=10

<table>
<thead>
<tr>
<th>Slot type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLOT_TYPE_1</td>
<td>One hole symbol to the center of slot. The hole symbol follows the HOLE_POINT_STYLE and HOLE_POINT_SIZE settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this</td>
</tr>
<tr>
<td>Slot type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Slot type 1</td>
<td>The circle color follows the slot layer color, and the slot color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_2</td>
<td>Two hole symbols to the slot. The hole symbol follows the HOLE_POINT_STYLE and HOLE_POINT_SIZE settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The hole symbol color follows the hole layer color, and the slot color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_3</td>
<td>One circle to the center of slot. The size of the circle corresponds to the real hole size. The color follows the slot layer color, and the slot color follows the phantom layer color. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example).</td>
</tr>
<tr>
<td>SLOT_TYPE_4</td>
<td>Two circles to the slot. The size of the circle corresponds to the real hole size. If the circles would be touching each other, only one circle in the middle of slot is created. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The circle color follows the hole layer color, and the slot color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_5</td>
<td>Hole symbol to the first slot center point. The hole symbol follows the HOLE_POINT_STYLE and HOLE_POINT_SIZE settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The hole symbol color follows the hole layer color, and the slot symbol color follows the phantom layer.</td>
</tr>
<tr>
<td>SLOT_TYPE_6</td>
<td>One circle to the first slot center point. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The circle color follows the hole layer color, and the slot symbol color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_7</td>
<td>No hole symbol is created. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The slot color follows the slot layer color.</td>
</tr>
</tbody>
</table>
HMS stands for Hollowcore Manufacturing System and it is developed in the Netherlands. You can export data of hollow core slabs from Tekla Structures to HMS. HMS uses the data in manufacturing processes.

Click the links below to find out more:
- Export to the HMS format (page 221)
- HMS Export settings (page 222)

### 24.1 Export to the HMS format

You can export model data of hollow core slabs to a HMS format. The result is a `.sot` file.

1. Select the model objects that you want to include in the export.
2. On the **File** menu, click **Export --> HMS**.
   
   The **HMS Export** dialog box opens.
3. **Define the export properties (page 222)** as required.
4. Click the ... button to browse for the folder where you want to save the file.
   
   The `\HMS` folder under the model folder is the default.
5. Enter a name for the file.
   
   The file name extension is `.sot`.
6. Click **Save**.
7. Select the **Add revision to file name** check box and select the revision number if required.
   
   The revision number is added to the HMS export file as follows:
   
   `hms_export_file<revision>.sot`
8. Select the **Open log file after export** check box if you want to see the log after export.

   HMS Export creates the log file in the file export folder.

9. Click **Export** to create the HMS export file.

See also

HMS Export settings (page 222)

### 24.2 HMS Export settings

You can include project data, slab data, and steel part information in the HMS export.

#### Project data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>You can include project data, such as customer name and site address, in the HMS export file.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>The boxes have the following values available:</td>
</tr>
<tr>
<td>Contractor Name</td>
<td>• <strong>Empty</strong></td>
</tr>
<tr>
<td>Site Address</td>
<td>The item is not included in the HMS export file.</td>
</tr>
<tr>
<td>Site City</td>
<td>• <strong>Text</strong></td>
</tr>
<tr>
<td>Section Name</td>
<td>Enter the text in the box next to the item.</td>
</tr>
<tr>
<td>Project Status</td>
<td>• <strong>Project UDA</strong></td>
</tr>
<tr>
<td>Remark 1</td>
<td>The data comes from the project's user-defined attributes.</td>
</tr>
<tr>
<td>Remark 2</td>
<td>• <strong>Project Object, Project Address, Project Info 1 - 2</strong></td>
</tr>
<tr>
<td>Remark 3</td>
<td>The data comes from the project information.</td>
</tr>
</tbody>
</table>

#### Export file

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export file</td>
<td>Define a name and location for the export file. The file name extension is <code>.sot</code>. By default, the export file goes to the <code>\HMS</code> folder under model folder.</td>
</tr>
</tbody>
</table>
### HMS Export settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add revision to file name</td>
<td>Add the revision number to the HMS export file: hms_export_file&lt;revision&gt;.sot.</td>
</tr>
<tr>
<td>Open log file after export</td>
<td>Open the log file after export. HMS Export creates the log file in the file export folder.</td>
</tr>
</tbody>
</table>

### Slab data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position Number</strong></td>
<td>Assigned Control Number (ACN) is the only option.</td>
</tr>
<tr>
<td><strong>Slab Remarks</strong></td>
<td>The options are:</td>
</tr>
<tr>
<td>Element Type</td>
<td></td>
</tr>
<tr>
<td>End Label</td>
<td></td>
</tr>
<tr>
<td><strong>Slab Name</strong></td>
<td>The options are:</td>
</tr>
<tr>
<td><strong>Slab Mark</strong></td>
<td>The options are:</td>
</tr>
<tr>
<td><strong>Slab Weight Units</strong></td>
<td>Select the weight unit.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Live/dead load</strong></td>
<td>Enter the default live/dead load to be exported. For hollow core slab calculation, you can define a default live load/dead load (KN/m²) for slabs. If you do not define this data here, you must enter the default values for each slab in HMS software later.</td>
</tr>
</tbody>
</table>

### Slab scope tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exclude parts</strong></td>
<td>Enter the class of the model object, the name, a text, a UDA or a template in the box to exclude the data.</td>
</tr>
</tbody>
</table>

**Hook Points**
- **Empty**
  - The item is not included in the HMS export file.
- **Name**
  - Select to include the name.
- **Text**
  - Enter the text in the box next to the item.
- **Class**
  - Enter the class of the model object in the box to include the data.
- **UDA**
  - The data comes from the user-defined attributes.
- **Template**
  - The data comes from a template.

**Hook point name**
- Select to include hook point name in export.

**Weld plate name**
- Select to include weld plate name in export.

### Options tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export Hook Box</strong></td>
<td>Select to include hook data.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export HP name</td>
<td>Select to export hook point names. If you do not select this option, only the XY coordinates are exported.</td>
</tr>
<tr>
<td>Export inner cores</td>
<td>Select to include detailed information on hollow cores in export.</td>
</tr>
<tr>
<td>Include full cut to contour</td>
<td>Select to include in export full cut in the contour block (CO). If not selected, the full cut is written as an individual cut (SP).</td>
</tr>
<tr>
<td>Exclude strands from export</td>
<td>Select to exclude strands from export.</td>
</tr>
<tr>
<td>Export strand code</td>
<td>Select to include strand code in export.</td>
</tr>
</tbody>
</table>

See also

*Export to the HMS format (page 221)*
Elematic ELiPLAN is a software for resource planning, scheduling, and management for precast concrete fabricators.

ELiPLAN import and export automates the data transfer between Tekla Structures and ELiPLAN. The data transfer consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.
2. Importing ELiPLAN data file into ELiPLAN.
3. Exporting ELiPLAN status data file from ELiPLAN.
4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental approach, which means that ELiPLAN is able to create, update, and delete parts in its database. This means that precast detailers can export the most up-to-date data files whenever the Tekla Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status data file to Tekla Structures. To keep the status and schedule data up to date in a Tekla Structures model, we recommend you update the status data regularly.

**NOTE** The format and contents of the ELiPLAN status data file imported to Tekla Structures differs from the data file that is exported from Tekla Structures to ELiPLAN.

**See also**

Import an ELiPLAN status data file (page 226)
Export an ELiPLAN data file (page 227)

### 25.1 Import an ELiPLAN status data file

If you have a status data file that has been created in ELiPLAN, you can import the status and scheduling information to your Tekla Structures model.
1. On the **File** menu, click **Import --> EliPlan**.
   The **Import Eliplan status data** dialog box opens.

2. Click the **...** button next to the **Import file name** box to browse for the file to be imported.

3. Click **Create**.
   Tekla Structures updates the status and schedule data for parts in the Tekla Structures model. When the data is read, a log file is displayed.

   The log file shows the parts whose data is updated correctly. It also provides information on possible problems that may have occurred. When you select a row in the log file, Tekla Structures automatically selects the corresponding part in the model. The overall status information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of the parts. To view the data, open the part properties dialog box, click the **User-defined attributes** button and go to the **EliPlan** tab.

**See also**

ELiPLAN (page 226)
Export an EliPLAN data file (page 227)

### 25.2 Export an EliPLAN data file

1. If needed, add EliPLAN information to the parts’ EliPLAN user-defined attributes.

2. On the **File** menu, click **Export --> EliPlan**.
   The **Export EliPlan file** dialog box opens.

3. Define the ELiPLAN export properties on the **Parameters**, **Plotter data** and **Data content** tabs.

4. Set **Scope of export** to **All**.

5. Click **Create**.
   By default, a file called `eliplan.eli` is created in the current model folder, in a `.\EP_files` subfolder.

**See also**

ELiPLAN user-defined attributes (page 228)
ELiPLAN export settings (page 229)
25.3 **EliPLAN user-defined attributes**

In addition to normal model data, you can add additional information in the user-defined attributes of the parts. The additional information can be transferred from Tekla Structures and used in ELiPLAN.

**Product type**

The product type affects how ELiPLAN considers the part dimensions length, length2, deltaL, width, height, and thickness.

To set the product type, select a suitable product type option from the list. If needed, you can override the product type value set in the dialog box:

- You can enter a value for the user-defined attribute `EP_TYPE` in the `objects.inp` file.
- You can enter a value for the user attribute `EP_TYPE` in the **Profile Catalog**.

In the **Profile Catalog** the attribute value is given as a number. The values are as follows:

- Slab = 1
- Beam = 2
- Column = 3
- Wall = 4
- Sandwich wall = 5
- Stair = 6
Product code
You have alternative ways to give the product code. The ELiPLAN export tries to define the product code in the following order:

1. You can enter a value for the product code in the ELiPLAN user-defined attributes dialog box.
2. You can enter a value for the user-defined attribute **EP_CODE** of the cast unit main part in the **objects.inp** file.
3. You can enter a value for user attribute **EP_CODE** in the **Profile Catalog**.
4. You can use the data conversion file to convert parametric profile names to a product code.
5. You can use the main part name as a product code.

Erection sequence
Precast parts are erected in a certain sequence. Use the sequence to help the scheduling of the production in ELiPLAN. You can give the estimated erection sequence by giving the sequence number for parts.

Ready for production
Set this option to **Yes** when the designer or detailer has finished the part and the part is ready for production. The default is **No**, which means that the data is transferred to ELiPLAN for preliminary planning only, and the part is not sent for production until the attribute is set to **Yes** and a new file is transferred to ELiPLAN.

Eliplan status data
The **Eliplan status data** is meant to be read-only information and used to visualize the data in a Tekla Structures model.

Set up your UDAs in the model or profile catalog for mapping object types, profiles and materials
For more information on how to set up your UDAs in the model or profile catalog for mapping object types, profiles and materials to suit the ELiPLAN export, see **EliPLAN/ELiPOS export guide**.

See also
- Export an EliPLAN data file (page 227)
- EliPLAN export settings (page 229)
25.4 **EliPLAN export settings**

Use the **Export ELiPLAN file** dialog box to control the ELiPLAN export properties.

For instructions on how to export the EliPLAN data file, see [Export an EliPLAN data file (page 227)](#).

### Parameters tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope of export</strong></td>
<td>Select whether all parts or only selected parts are exported. Because of the incremental import of EliPLAN, you need to select the same parts, and some additional parts again, if needed, when exporting the next time. Otherwise EliPLAN assumes that the parts missing from the subsequent file have been deleted in the Tekla Structures model. We recommend you to always use the <strong>All</strong> option. Use the <strong>Selected</strong> option only in special cases or when you are exporting parts for the first time.</td>
</tr>
<tr>
<td><strong>Numbering must be up to date to export</strong></td>
<td>Set this setting to <strong>Yes</strong> to prevent export when the numbering is not up to date.</td>
</tr>
<tr>
<td><strong>Export version number</strong></td>
<td>Select whether IDs or GUIDs are used in the export. The use of GUID depends on the EliPLAN version. You need to check with Elematic that the latest version of EliPLAN is in use to benefit from the GUID transfer capabilities. The default is <strong>ID</strong>. All versions of EliPLAN support the use of <strong>ID</strong>.</td>
</tr>
<tr>
<td><strong>Output file name</strong></td>
<td>The name and location of the export file created. The default name is <code>eliplan.eli</code>. You can import this file into EliPLAN. The <code>eliplan.eli</code> file includes, among other things, material information. The accessory code,</td>
</tr>
</tbody>
</table>
which is the material description, is in the #Materials section.

The accessory code is based on the material type as follows:
• For concrete material the default accessory code is same as the material name.
• For mesh, reinforcing bars, or strands the default accessory code is grade|size.
• For embedded material the default accessory code is name|size|material.

Data conversion file
With this file you can convert the parametric profile names into the EliPLAN product codes, and the material descriptions into the EliPLAN accessory codes. The default file name is eliplan_export.dat and this file can be located in your model, XS_FIRM or XS_PROJECT folder.

The data conversion file eliplan_export.dat contains string pairs separated with one or more tabs. The string on the left side is the profile name or Tekla Structures material description and the string on the right side is the corresponding EliPLAN data.

Note that the EliPLAN codes depend on the fabricator and the codes that are valid for one fabricator are likely not valid for other fabricators.

For an example of data conversion file contents, see eliplan_export.dat example.

List of classes to be ignored
A list of classes to be excluded from the export. This contains the class numbers used for concrete parts. Separate the classes with a space.

List of classes to be ignored (Material)
A list of classes to be excluded from the export. This contains the class...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>numbers used for materials. Separate the classes with a space.</td>
<td></td>
</tr>
<tr>
<td><strong>List of classes to be ignored (Concrete)</strong></td>
<td>A list of classes to be excluded from the export. This contains the class numbers used for secondary concrete parts. Separate the classes with a space.</td>
</tr>
<tr>
<td><strong>Create log file</strong></td>
<td>Select whether a log file is created.</td>
</tr>
<tr>
<td><strong>Log file name</strong></td>
<td>The name and location of the created log file.</td>
</tr>
</tbody>
</table>

**Plotter data tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export of cutout data</strong></td>
<td>Select how to export cutout data. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All</strong>: Exports all data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Full depth cuts only</strong>: Exports data only on the cuts that go through the whole part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: Does not export any cutout data. Overlapping cutouts are combined in the export file.</td>
</tr>
<tr>
<td><strong>Export of embed data</strong></td>
<td>Select how to export data of embeds. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes</strong>: Exports data on embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: Does not export any data on embeds.</td>
</tr>
<tr>
<td><strong>Exclude cut parts by</strong></td>
<td>Use to exclude cut parts from export based on the cut part properties. You can define one or more values for the selected property.</td>
</tr>
</tbody>
</table>
## Data content tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Export material data               | Select whether to include or exclude the detailed material data (receipt) of parts.  
If you have no use for material data in EliPLAN (you have no material handling module in EliPLAN), select **No** to exclude the data from the file and to reduce the file size.  
Note that once you have transferred the file with the material data (**Yes**) you should never switch off (**No**) the export of material data in subsequent exports. If you do this, the receipt is also cleared in the EliPLAN database and all modifications are lost. |
| Export rebar bending data          | Select whether to include or exclude the detailed rebar bending information.  
If you do not need this data in EliPLAN, select **No** to exclude the data from the file and to reduce the file size.  
Note that once you have transferred the file with the rebar bending data (**Yes**) you should never switch off (**No**) the export of rebar bending data in subsequent exports. |
| Export embed Z position            | Select whether to include or exclude the Z level of embeds.                                                                                                                                                   |
| Unit for rebar length              | Select the unit for the length of reinforcing bars.                                                                                                                                                           |
| No. of digits after decimal point  | Select the number of digits after the decimal point.  
The default is 2 digits after the decimal point.                                                                                                                                                           |
| Tag for lifters                    | Use to identify lifting loops by their name. Enter the name of the lifting loop.  
When lifting loops are identified, the plotter instruction type is changed from **WPL** to **LL**.                                                                                                          |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix for ID</td>
<td>Enter a prefix (letter) to use with the ID number.</td>
</tr>
<tr>
<td>Notes</td>
<td>Select what type of notes you want to export: A UDA, a template attribute or your own text. Then enter the UDA, template attribute, or text.</td>
</tr>
<tr>
<td>Position number type</td>
<td>Select whether to export the cast unit position number, assigned control number (ACN), or cast unit position number and ACN.</td>
</tr>
<tr>
<td>Remove numbering separator</td>
<td>Select whether a position number separator is used in numbering. The default is No.</td>
</tr>
<tr>
<td>Tag special elements</td>
<td>Set this option to Yes to set a special tag for elements that have notch cuts.</td>
</tr>
</tbody>
</table>
You can export reinforcement geometry to BVBS (Bundesvereinigung Bausoftware) format. The result is a text file in ASCII format. The supported version of the BVBS format is 2.0 year 2000.

You can export bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

Reinforcing bars that have bendings with two or more variable radius values are exported fully conforming with the BVBS specification so that radius element and leg elements are written separately. If this causes compatibility issues within your own environment and other tools using the BVBS files, you can still go back to the older way of exporting by setting the advanced option XS_BVBS_EXPORT_ARC_COMPATIBLE_TO OLDER_METHOD to TRUE in an .ini file, for example, in user.ini.

Click the links below to find out more:

Export to the BVBS format (page 235)
Reinforcing bar length calculation in BVBS export (page 242)

### 26.1 Export to the BVBS format

You can export reinforcement geometry to the BVBS format. The result is an ASCII file with a file name extension .abs.

1. Ensure that numbering is up to date.
2. Select the cast units with the desired reinforcement content, or select the reinforcement.
3. On the File menu, click Export --> BVBS.

   The BVBS export dialog box is displayed.
4. Define the BVBS export settings:
a. On the **Parameters** tab, select which reinforcement to export, how to export drawing data, how and where to export the BVBS file or files, and which BVBS elements to export.

You can use saved selection filters to exclude reinforcement bars or meshes matching with the selected filter.

b. On the **Advanced** tab, select whether you want to make meshes out of rebars, select whether the detailed data of mesh bars is included in the exported data of the mesh, define the order of the items in the output file, and select whether the private data block is exported and select the data items for this additional block.

c. On the **Checking** tab, select whether you want to enter the required minimum and maximum cutting length of the reinforcing bars.

5. Click **Export**.

The BVBS file or files in `.abs` format are exported to the folder specified in the **Output file** area. You can check the export report by clicking the report link that appears at the bottom of the dialog box.

### 26.2 Export settings

Use the **BVBS Export** dialog box to control the BVBS export settings.

For instructions on how to export to BVBS format, see [Export to the BVBS format](page-235).

#### Parameters tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model objects to be exported</strong></td>
<td>Select which reinforcing bars or meshes are exported.</td>
</tr>
<tr>
<td>• <strong>Reinforcement of all cast units in the model</strong></td>
<td>Exports reinforcing bars or meshes in all cast units in the model. If there are cast units that do not have reinforcing bars or meshes, no empty files are created.</td>
</tr>
<tr>
<td>• <strong>Reinforcement of selected cast units</strong></td>
<td>Exports reinforcing bars or meshes in the cast units you have selected in the model.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Selected reinforcement only</td>
<td>Exports the reinforcing bars or meshes you have selected in the model. When you select this option, you can export only to a single file.</td>
</tr>
<tr>
<td>• Reinforcement of all cast units in the model (totals by all positions)</td>
<td>Exports reinforcing bars or meshes in all the cast units that have the same cast unit position as any of the selected cast unit positions.</td>
</tr>
<tr>
<td></td>
<td>For example, if a cast unit with the cast unit position W–120 is selected, the reinforcing bars or meshes in all the cast units that have position W–120 are exported even though not all of them were selected.</td>
</tr>
<tr>
<td>Excluding reinforcement by filter</td>
<td>Exclude reinforcing bars or meshes by selecting any of the selection filters. Reinforcing bars or meshes that match the filter are excluded.</td>
</tr>
<tr>
<td>Drawing name source</td>
<td>In BVBS file each row/rebar has a data field for Drawing number of the respective drawing (drawing name) and Index of the respective drawing (drawing revision). With the option Drawing name source you can control how the values for these data fields will be set.</td>
</tr>
<tr>
<td></td>
<td><strong>Cast_unit_position</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Drawing Name</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Drawing Mark</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Drawing Title1</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Drawing Title2</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Drawing Title3</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Fixed text:</strong> If you select this, enter the text in Fixed drawing name.</td>
</tr>
<tr>
<td></td>
<td>By selecting the option Fixed text you can enter the values in the dialog box and same (&quot;fixed&quot;) values will be written for every exported rebar.</td>
</tr>
<tr>
<td></td>
<td>If any of the other options is selected, the drawing name and revision will be taken from the cast unit or cast unit drawing of the rebar.</td>
</tr>
<tr>
<td></td>
<td>Note that it depends on the receiving system of the BVBS file how important and for what purpose this</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>data will be used. From Tekla Structures perspective, using this data field is not obligatory.</td>
</tr>
<tr>
<td>Fixed drawing name</td>
<td>Enter a text string to be used for the drawing in the export. This option is available only when you have selected the option Fixed text in Drawing name source.</td>
</tr>
<tr>
<td>Rev</td>
<td>Drawing revision (index). This option is available only when you have selected the option Fixed text in Drawing name source.</td>
</tr>
<tr>
<td>Single file</td>
<td>Export all BVBS information into one .abs file. Enter the file name in the box or click the ... button to browse for the file. If you do not enter a path, the file is saved in the model folder.</td>
</tr>
<tr>
<td>One file per each cast unit</td>
<td>Export each cast unit reinforcement content to its own file. The files are created under the folder that you define in the Folder name box, or you can browse for the folder using the ... button. Use the File naming template list to select how the created files are automatically named. You can include revision into file name by selecting the Include revision into file name check box.</td>
</tr>
<tr>
<td>BVBS elements to be exported</td>
<td>Select which item types are exported. The options are: 2D reinforcement bars (BF2D) 3D reinforcement bars (BF3D) Spriral reinforcement coils (BFWE) Reinforcement meshes (BFMA) Lattice girders (BFGT) If you select Lattice girders (BFGT), enter the class numbers used in the model for the lattice girder bars in the Class numbers for girder box. The lattice girder may contain two or three chord bars and one or two diagonal zig-zag bars. The lattice girder length and other attributes are taken from the main chord (usually top chord).</td>
</tr>
</tbody>
</table>
### Advanced tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Try to make meshes of rebars</strong></td>
<td>Select whether the export tries to automatically form meshes of a single reinforcing bar or of a group reinforcing bars and export them as a mesh instead of separate 2D bars. The options are:</td>
</tr>
<tr>
<td><strong>Yes, group rebars by class</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Yes, group rebars by name</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Yes, group rebars by grade</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Yes, group rebars by UDA</strong></td>
<td></td>
</tr>
<tr>
<td>In order to form a mesh the reinforcing bars need to belong to the same part, be straight, be on the same plane, and have equal filtering attribute values.</td>
<td></td>
</tr>
<tr>
<td><strong>UDA name for grouping</strong></td>
<td>If you selected the value <strong>Yes, group rebars by UDA</strong> for <strong>Try to make meshes of rebars</strong>, enter the UDA name for grouping.</td>
</tr>
<tr>
<td><strong>Exporting of mesh bar data (@X..@Y..)</strong></td>
<td>Use this option to control whether the detailed data on mesh bars is included in the exported data of the mesh. The appropriate option depends on the needs and capabilities of the receiving system. The data is needed if it will be used, for example, for mesh fabrication.</td>
</tr>
<tr>
<td><strong>Custom and cut catalog meshes only</strong></td>
<td>Detailed bar data is included only for custom meshes and catalog meshes that have additional cuts, openings or skewed edges.</td>
</tr>
<tr>
<td><strong>All meshes</strong></td>
<td>Detailed bar data is written for all meshes.</td>
</tr>
<tr>
<td><strong>None meshes</strong></td>
<td>Detailed bar data is not written to any of the meshes.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export stepped bars as separate items</td>
<td>By default, the stepped group is exported as a single string with the stepping length defined in a certain data block. If you select the value Yes for Exporting of mesh bar data (@X..@Y..), all tapered reinforcing bar groups are exported as multiple separate reinforcing bar items even if they have regular spacing and could be exported as one single stepped reinforcing bar item.</td>
</tr>
<tr>
<td>Sort items</td>
<td>Use this option to define the order of the items in the output files. The options are: \n  - <strong>No sorting</strong> \n  - By diameter, smaller size first \n  - By diameter, bigger size first \n  - By position number</td>
</tr>
<tr>
<td>Private data block</td>
<td>With Private data block you can control whether the private data block is exported (Export private data block) and select the data items for this additional block. Data fields can be any report properties, user-defined attributes, or object properties. \n  Click the New button to add new predefined private data fields to the list. Enter information about the data item. \n  - <strong>Name in list</strong> \n    The text shown in the Private data block list. \n  - <strong>Field identifier</strong> \n    The field code which separates the individual data fields in the private data block. It can be any lower case letter. Typically, it is a good practice to use a different value for each data item but this is not required. The receiving system</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>may also be able to read only certain data</td>
<td>fields.</td>
</tr>
<tr>
<td>• <strong>Property or UDA name</strong></td>
<td>The value defines which data will be inquired from the reinforcement object. Note that a non-existing property will be not exported.</td>
</tr>
<tr>
<td>• <strong>Property data type</strong></td>
<td>The value has to match the actual selected property. The options are:</td>
</tr>
<tr>
<td>Check cutting length</td>
<td>Select whether you want to run an additional check for the Minimum cutting length and Maximum cutting length of the reinforcing bars.</td>
</tr>
<tr>
<td>The log file entry contains the ID of the reinforcing bar. You can locate the reinforcing bar in the model by selecting the appropriate row in the log file. Note that the reinforcing bar is still exported normally and only the additional warning is given.</td>
<td></td>
</tr>
</tbody>
</table>

**Checking tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check cutting length</strong></td>
<td>Select whether you want to run an additional check for the Minimum cutting length and Maximum cutting length of the reinforcing bars.</td>
</tr>
<tr>
<td>When you select the Check cutting length check box, and the cutting length of the exported reinforcing bar is less than the minimum cutting length or greater than the maximum cutting length, a warning is written to the export log file.</td>
<td></td>
</tr>
<tr>
<td>The log file entry contains the ID of the reinforcing bar. You can locate the reinforcing bar in the model by selecting the appropriate row in the log file. Note that the reinforcing bar is still exported normally and only the additional warning is given.</td>
<td></td>
</tr>
<tr>
<td>Note that when the minimum/maximum cut length check is</td>
<td></td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
acted, the length of lattice girders is also checked. A warning is added in the log when the check fails. The length of the main chord defines the exported length of the lattice girder.

### 26.3 Reinforcing bar length calculation in BVBS export

The length of the reinforcing bar is calculated according to the BVBS specification. The length also depends on the bending angle. Lengths L1 and L2 are exported.

If you set the advanced option `XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT` to `TRUE`, the user-defined length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the bar is ignored if the data contains actual geometry data. Some other software applications may still use the overall length values in the BVBS file for calculating quantities. The exported overall length in Tekla Structures is the same length as shown in reports.
See also

BVBS (page 235)
Export to the BVBS format (page 235)
You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format.

Supported versions of the Unitechnik format are:

- 6.1.0 17.9.2009
- 6.0.0 14.6.2005
- 5.2b 11.9.2000
- 5.0c 30.10.1997

You can export cast units consisting of concrete, steel and surface materials. Exporting of reinforcing bars (bent and not-bent), reinforcing bar groups and meshes with hooks is also supported. You can also export braced girders, solid, sandwich and double walls.

**Example**

Exported cast unit:
1. Hole
2. Steel embed
3. Reinforcing bars
4. Insulation plate (green)

For details about exporting to Unitechnik, see Export to the Unitechnik format (page 246).

For details about Unitechnik export settings, click the following links:

- Unitechnik export: Main tab (page 247)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Validation tab (page 274)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Data specification tab (page 278)
- Unitechnik export: Mounting part data specification tab (page 279)
- Unitechnik export: Line attributes tab (page 280)
27.1 Export to the Unitechnik format

You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format with a file name extension .uni.

Limitation: Cast units with cast unit type cast-in-place are not exported.

1. Go to the part properties of the parts that you plan to export, and edit the user-defined attributes on the Unitechnik tab as required. The user-defined attributes are environment specific, so you may not have all the settings below available:

   - **Product type**: Product type is important for identifying the object type in CAM software. Undefined product type will result in error notification while importing the production data file. You can define the product type by selecting one of the options, or by defining a user-defined text.

   - **User-defined product type**: Optional field for product type.

   - **Product addition**: This attribute is exported with Unitechnik export (79) to object’s SLABDATE block as a representative number 00-03. The available options are Standard element, Balcony, Roof, and Plastered element.

   - **Storey**: Optional field used for planning the transport and erection processes.

   - **Transport unit number** and **Transport sequence number**: Optional fields used for planning the transport and erection processes. These can be defined in the export settings to be included as part of SLABDATE block.

   - **Concreting identification (LOT block)**: You can select No special treatment or Shovel concrete, or leave the field empty.

   - **Layer split thickness**: Manually define the layers with names and thicknesses.

   - **Layer not to export**: Specify the layer that you do not want to export.

2. Update numbering.

   - **Export Unitechnik** reads and exports data from the numbering series of parts. It is important that all exported parts are numbered correctly. Incorrectly numbered parts are not exported.

3. On the **File** menu, click **Export --> Unitechnik**.

   The **Export Unitechnik** dialog box is displayed.

4. Define the Unitechnik export properties on the tabs:
5. Click **Create**.

By default, `.uni` output files are created in the `\UT_Files` folder under the current model folder. The number of output files depends on the options selected in the **Create from** list on the **Main** tab, and on the total number of selected parts, cast units, or assemblies.

### 27.2 Unitechnik export: Main tab

Use the **Main** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unitechnik version</strong></td>
<td>Select the Unitechnik version.</td>
</tr>
<tr>
<td><strong>Create from</strong></td>
<td>Select which parts or cast units are exported.</td>
</tr>
<tr>
<td>• <strong>Selected cast units</strong></td>
<td>Only cast units that have one or more parts selected in the model are exported. Each cast unit has one output file.</td>
</tr>
<tr>
<td>• <strong>All parts</strong></td>
<td>All cast units are exported. Each cast unit has one output file.</td>
</tr>
<tr>
<td>• <strong>Selected parts (separately)</strong></td>
<td>Only the selected concrete parts (also embeds and insulation parts belonging to the selected part) are exported. Each part has one output file.</td>
</tr>
</tbody>
</table>

---
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Selected parts (cast united)</strong></td>
<td>Selected parts belonging to one cast unit are grouped and exported together in one output file.</td>
</tr>
<tr>
<td><strong>Selected assemblies</strong></td>
<td>All selected assemblies are exported. One assembly equals one cast unit and has one output file. Selection of subassemblies is also allowed.</td>
</tr>
<tr>
<td><strong>Cast units in list</strong></td>
<td>Select the cast units for export from the Cast unit position list you enter.</td>
</tr>
<tr>
<td><strong>By cast unit Id</strong></td>
<td>Each cast unit has its own output file.</td>
</tr>
<tr>
<td><strong>By cast unit position</strong></td>
<td>Identical cast units share an output file.</td>
</tr>
</tbody>
</table>

<p>| Parts excluded from export (classes)        | If you do not want to export some parts, enter the classes of the parts. Parts with classes in this list will not be exported. |
| Directory path                              | Define where the export files are saved. The default folder is .\UT_Files under the current model folder. |
| File name                                   | Select the name of the output file from the lists and file name extension. |
| <strong>Proj. nr</strong>                                | is the number of the project.                                              |
| <strong>Proj. name</strong>                              | is the name of the project.                                                |
| <strong>CU nr</strong>                                   | is the assembly position number of the main part of the cast unit.          |
| <strong>Phase</strong>                                   | is the current phase.                                                      |
| <strong>CU pos</strong>                                  | is the assembly position of the main part of the cast unit.                |
| <strong>ACN</strong>                                     | is the assembly control number. To generate the assembly control numbers, go to the Drawings &amp; reports tab and click Numbering --&gt; Assign control numbers. |
| <strong>Part ID</strong>                                 | is the ID number, which is 10 characters long. If the ID number is not 10 characters long, zeros are added in front of the ID number to |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>make it 10 characters long. For example, id number 45699 will be 0000456999.</td>
<td></td>
</tr>
<tr>
<td>• Counter is the amount of characters that the property can contain. For example, (5) means that the property can contain only 5 characters. If there are less than 5 characters, zeros are added in front of the property. If there are more than 5 characters, characters at the beginning of the number series are deleted.</td>
<td></td>
</tr>
<tr>
<td>• Other options are <strong>Date</strong>, <strong>Time</strong>, <strong>Date-Time</strong>, <strong>UDA</strong>, <strong>Text</strong>, <strong>Template</strong>, and <strong>Project UDA</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Extension</strong></td>
<td>The file name extension. By default it is <strong>Text</strong> and <strong>uni</strong>. You can select another option from the list.</td>
</tr>
<tr>
<td><strong>File name mask</strong></td>
<td>The format (length) of the output file name and file name extension. Numbers represent the length of the output string. If the name is longer than the selected option, it is cut.</td>
</tr>
<tr>
<td><strong>Open folder after export</strong></td>
<td>Select whether the folder where the output file is saved is opened after the export.</td>
</tr>
<tr>
<td><strong>Output file structure</strong></td>
<td>Structure of the exported file (slab date and layer part).</td>
</tr>
<tr>
<td>• Multiple layers</td>
<td>One <strong>SLABDATE</strong> block with N layers. Each cast unit has its own <strong>LAYER</strong> block. Embeds, reinforcement and insulations belong to one concrete part, and they are exported to the related <strong>LAYER</strong> block.</td>
</tr>
<tr>
<td></td>
<td><strong>HEADER</strong>&lt;br&gt;...&lt;br&gt;<strong>SLABDATE</strong>&lt;br&gt;...&lt;br&gt;<strong>LAYER</strong>&lt;br&gt;...&lt;br&gt;<strong>END LAYER</strong>&lt;br&gt;<strong>LAYER</strong>&lt;br&gt;...&lt;br&gt;<strong>END LAYER</strong>&lt;br&gt;<strong>LAYER</strong>&lt;br&gt;...&lt;br&gt;<strong>END LAYER</strong>&lt;br&gt;<strong>SLABDATE</strong>&lt;br&gt;<strong>END HEADER</strong></td>
</tr>
<tr>
<td>• Single layer, 1 slabdate, 1 part</td>
<td>Each cast unit has its own <strong>SLABDATE</strong> block, no <strong>LAYER</strong> blocks.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Single layer, n slabdate, n parts</strong></td>
<td>Cast units with equal geometry are collected in one <strong>SLABDATE</strong> block. No <strong>LAYER</strong> or <strong>LOT</strong> blocks are defined. Embeds, reinforcement and</td>
</tr>
<tr>
<td></td>
<td>insulation belonging to a cast unit with the same geometry are collected and exported in one <strong>SLABDATE</strong> block.</td>
</tr>
<tr>
<td><strong>Single layer, 1 slabdate, n parts</strong></td>
<td>All similar wall shells are defined within one <strong>SLABDATE</strong> block instead of being defined in a separate <strong>SLABDATE</strong> block per wall shell. The</td>
</tr>
<tr>
<td></td>
<td>option is useful when exporting special embeds.</td>
</tr>
<tr>
<td><strong>Combined, n slabdate, 1 part</strong></td>
<td>Combined export that can contain more than one cast unit.</td>
</tr>
</tbody>
</table>

<p>| <strong>1st exported layer</strong>                      | Select which part is exported in the first <strong>LAYER</strong>. This option allows to define which wall shell is positioned on the pallet first.          |
|                                             | The options are:                                                                                                                             |
|                                             | • <strong>Main part</strong> (of cast unit)**                                                                                                              |
|                                             | • <strong>Biggest part</strong>                                                                                                                           |
|                                             | • <strong>Heaviest part</strong>                                                                                                                          |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consider layer split thicknesses</strong></td>
<td>Select how the layers of the cast unit are exported. These options are available when you have set <strong>Output file structure</strong> to <strong>Multiple layers</strong>.</td>
</tr>
<tr>
<td>• <strong>No</strong></td>
<td>The cast unit is exported as one volume.</td>
</tr>
<tr>
<td>• <strong>Yes</strong></td>
<td>The different layers set on the Unitechnik user-defined attributes of a part are taken into consideration, and the cast unit is exported in two or three layers.</td>
</tr>
<tr>
<td><strong>Blank symbol in exported file</strong></td>
<td>Select the blank symbol to be used in the export file.</td>
</tr>
<tr>
<td>An example with &quot;_&quot; symbol:</td>
<td></td>
</tr>
<tr>
<td>HEADER_</td>
<td>005</td>
</tr>
<tr>
<td>57_____ W1_____ W</td>
<td>57</td>
</tr>
<tr>
<td>Corporation_</td>
<td></td>
</tr>
<tr>
<td>An example with &quot; &quot; symbol:</td>
<td></td>
</tr>
<tr>
<td>HEADER_</td>
<td>005</td>
</tr>
<tr>
<td>57 W1 W1</td>
<td>57</td>
</tr>
<tr>
<td>Corporation</td>
<td></td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Data specification tab (page 278)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Data specification tab (page 278)
- Unitechnik export: Mounting part data specification tab (page 279)
27.3 **Unitechnik export: TS configuration tab**

Use the **TS configuration** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Rotation** | Select the scanning direction. Unitechnik export uses scanning layers to obtain the geometry of all parts in a cast unit.  

The scanning direction depends on the plane of the cast unit main part. A floor panel is scanned from bottom to top side. A wall panel and a column are scanned from one side to the other side. The position and direction of a basic shape of the exported cast unit depends on the rotation.  

**No**  
Floor: Bottom to top  
Wall: Front to rear side  
Column: Side to side  

**180**  
Floor: Top to bottom  
Wall: Rear to front side  
Column: From one side to the opposite side |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+90 around X</td>
<td>Floor: Left to right side&lt;br&gt;Wall: Top to bottom&lt;br&gt;Column: Side to side</td>
</tr>
<tr>
<td>-90 around X</td>
<td>Floor: Right to left side&lt;br&gt;Wall: Bottom to top&lt;br&gt;Column: From one side to the opposite side</td>
</tr>
<tr>
<td>-90 around Y</td>
<td>Floor: Rear to front side&lt;br&gt;Wall: Right to left side&lt;br&gt;Column: Top to bottom</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>

Examples of rotation:
- Wrong scanning plane (from the right side to the left side):
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra rotation</td>
<td>Select the rotation around the z coordinate. The z coordinate has the same direction, but the x and y directions are changed.</td>
</tr>
<tr>
<td></td>
<td>To show the actual coordinate system, set <strong>Draw pallet axis</strong> to <strong>Yes</strong> on the <strong>Pallet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong></td>
</tr>
<tr>
<td></td>
<td>No extra rotation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Swap X/Y</strong></td>
</tr>
<tr>
<td></td>
<td>Swap x and y axis.</td>
</tr>
<tr>
<td></td>
<td>• <strong>X=max(X_dim,Y_dim) main part</strong></td>
</tr>
<tr>
<td></td>
<td>X axis goes through the longer side of the main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>X=min(X_dim,Y_dim) main part</strong></td>
</tr>
<tr>
<td></td>
<td>X axis goes through the shorter side of the main part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>X=max(X_dim,Y_dim) cast unit</strong></td>
<td>X axis goes through the longer side of the cast unit.</td>
</tr>
<tr>
<td><strong>X=min(X_dim,Y_dim) cast unit</strong></td>
<td>X axis goes through the shorter side of the cast unit.</td>
</tr>
<tr>
<td><strong>+90 around Z</strong></td>
<td>Rotates x and y axis around the z axis by 90 degrees.</td>
</tr>
<tr>
<td><strong>-90 around Z</strong></td>
<td>Rotates x and y axis around the z axis by -90 degrees.</td>
</tr>
<tr>
<td><strong>180 around Z</strong></td>
<td>Rotates x and y axis around the z axis by 180 degrees.</td>
</tr>
</tbody>
</table>

The following example shows the coordinate system with no rotation and no extra rotation settings. Panel 1 has the z axis set parallel to the shorter side. It is incorrect in the Unitechnik format, so the coordinate system has to be rotated. Panel 2 shows a rotation by 90 degrees around the z axis.

![Diagram showing coordinate system with rotations](image)

**Rotate 90° if pallet width exceeded**

In double walls, select whether to rotate also the second shell when the pallet width is exceeded.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan position</strong></td>
<td>The number of the scanning layers depends on the selected scan position. Each object of the cast unit is scanned in one direction. Select the position in which all parts are scanned. Each part is scanned separately. Scanning plane is parallel to the basic shape plane.</td>
</tr>
<tr>
<td>Bottom and top</td>
<td>Two scanning planes at the start and at the end of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>Bottom only</td>
<td>One scanning plane at the start of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>Top only</td>
<td>One scanning plane at the end of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| • **Middle only** | ![Image](image1.png)  
One scanning plane at the middle of bounding box of the scanning part.  
To move the position of the exact scanning plane, use the **Scan position offset** boxes below to define start offset and end offset. |
| **Merge CONTOUR layers** | You can export one scanned layer only. With two scanned layers, they have to be merged into one layer.  
• **Intersection**  
Creates polygon intersection of two contour geometries.  
1. First scanned layer  
2. Second scanned layer  
3. Layer  
• **Union**  
Creates polygon union of two contour geometries. |
<p>| <strong>Merge CUTOUT layers</strong> | The same as <strong>Contour export</strong>, but for holes only. |
| <strong>Extend contour and add formwork</strong> | Select whether to extend the contour by embeds which are outside the element. |
| <strong>Name for additional formwork (embed)</strong> | Define a name for the embed. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry export</td>
<td>Select whether the geometry of the exported part is represented as polygons or lines.</td>
</tr>
<tr>
<td></td>
<td>Polygons exported:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Geometry export example" /></td>
</tr>
</tbody>
</table>

Unitechnik export: TS configuration tab
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export rounded holes as circle (K)</strong></td>
<td>Select whether you want to export rounded holes as circles (K) or polygons/lines.</td>
</tr>
<tr>
<td><strong>Double wall turned</strong></td>
<td>Select whether the first shell of a double wall on the pallet is turned. The options are:</td>
</tr>
<tr>
<td></td>
<td><strong>No</strong>: Exported as in model, shell1 is in front, shell2 in background.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes, turn shell1</strong>: Exported according UT standard.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes, turn shell1 - fixed edge up</strong>: This is meant for special machines.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: Main tab (page 247)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
27.4 Unitechnik export: Embeds tab

Use the Embeds tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal embeds</strong></td>
<td>Select which parts are considered as embeds. Embedded parts are exported in the <strong>MOUNPART</strong> block.</td>
</tr>
<tr>
<td></td>
<td>If the embed block consists of several parts, it is useful to weld all embeds into one block and then connect the created block with a concrete part to a cast unit. Subassemblies are also supported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All classes listed in the <strong>Embeds classes</strong> box are considered as embeds. All steel parts are also considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected</strong></td>
</tr>
<tr>
<td></td>
<td>Classes listed in the <strong>Embeds classes</strong> box are only considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No export</strong></td>
</tr>
<tr>
<td></td>
<td>Ignores the <strong>Embeds classes</strong> box and exports all steel parts as standard parts.</td>
</tr>
<tr>
<td><strong>Embeds classes</strong></td>
<td>Enter the classes for embeds.</td>
</tr>
<tr>
<td><strong>Export assemblies</strong></td>
<td>Select how embeds and steel blocks are exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>Embds are exported as parts. All embedded welds and assembly relations are ignored.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Welded embeds and the assembly block are exported as one part. | ![Diagram](image1)  
Welded embeds and the assembly block are exported as one part. |
| Only the main part of the embedded block or embedded assembly is exported. | ![Diagram](image2)  
Only the main part of the embedded block or embedded assembly is exported. |
| The main part of the embedded block extended in the x direction to cover all the parts of the embedded block is exported. | ![Diagram](image3)  
The main part of the embedded block extended in the x direction to cover all the parts of the embedded block is exported. |
| Only the bounding box around the main part of the embedded block or embedded assembly is exported. | ![Diagram](image4)  
Only the bounding box around the main part of the embedded block or embedded assembly is exported. |

**Def export code**

Define how the insertion point and the direction for embeds is calculated. Possible values are 1, 2, 3, 11, 12, 21, 22, 23, 31 and 32.

**Cut outer assemblies**

Select how the embedded parts that are outside the concrete element are exported.

All parts in the embed are exported.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /> → <img src="image2" alt="Diagram" /></td>
<td>Only the embedded parts that are inside of the concrete element are exported. Embedded parts that are outside the concrete element are ignored. If an embedded part is partly inside a concrete element, the exported geometry of the embedded part is changed to cut.</td>
</tr>
<tr>
<td><img src="image1" alt="Diagram" /> → <img src="image2" alt="Diagram" /></td>
<td>Same as the previous option, but only embedded parts with class defined in <strong>Cut outer only classes</strong> are taken into account.</td>
</tr>
<tr>
<td><strong>Cut outer only classes</strong></td>
<td>Enter the classes of parts whose geometry is changed to cut when you have selected the last option in the <strong>Cut outer assemblies</strong> list.</td>
</tr>
</tbody>
</table>
| **Special assemblies export / Special export assembly file name** | The options affect the exported geometry of the embeds. The real geometry is replaced by the geometry defined in text files. The default name of the text file is `spec_assemblies_def.txt` and is searched for in the model folder. Use **Special export assembly file name** to define the name and the location of the text file. Required structure of the text file is:  
  - Name(text)  
    Number_of_lines_defined(number)  
  - S(representing single line)  
    Start_coors(number number)  
    End_coors(number number)  
  - S(representing single line)  
    Start_coors(number number)  
    End_coors(number number)  
  - S(representing single line)  
    Start_coors(number number)  
    End_coors(number number)  
Example of the file: |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
|                        | **Quicky 4**  
|                        | S -100 100 100 -100  
|                        | S 100 100 -100 -100  
|                        | S -100 -100 -100 -100  
|                        | S -100 100 100 100  
|                        | **QuickyS 2**  
|                        | S -50 0 30 0  
|                        | S 0 -50 0 50  
|                        | **E-Doze 2**  
|                        | S -100 100 100 100  
|                        | S 0 -100 0 0  |

The geometry of all embeds (from example with names Quicky, QuickyS, E-Doze) are replaced by geometry defined in the text file. In the following example, the part number 1 (the name is Beam) was not found in the text file so the geometry is exact. On the opposite side the part number 2 (the name is Quicky) was found, so the geometry is replaced.

**Embed Z position**

Select the embed z position. The options are **Minimum to pallet** or **Start point**.

Alternatively, you can use the `spec_assemblies_def.txt` file to set the position of the embeds.

For example:

| Quicky 4 1 1 middle  
| S -100 100 100 -100  
| S 100 100 -100 -100  
| S -100 -100 100 -100  
<p>| S -100 100 100 100  |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insulation classes</td>
<td>Define the insulation classes. Parts with classes in this list will be exported as insulation parts. All parts considered insulation are exported in the MOUNPART block.</td>
</tr>
<tr>
<td>Electric tubes classes</td>
<td>Define the electric tubes classes. Parts with classes in this list will be exported as MOUNPART with lines geometry.</td>
</tr>
<tr>
<td>Opening embed classes</td>
<td>Define the opening embed classes. Parts with classes in this list will be exported as normal embeds in the MOUNPART block. The geometry will not be considered in the CONTOUR and CUTOUT blocks of the concrete part.</td>
</tr>
<tr>
<td>Opening cutout classes</td>
<td>Define the opening cutout classes. Parts with classes in this list will be exported only in regard to their geometry in the CUTOUT block of the concrete part. They will not be exported in the MOUNPART block.</td>
</tr>
<tr>
<td>Export insulation</td>
<td>Select whether insulation parts are exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td>Export surface</td>
<td>Select whether surfaces are exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td>Install identification</td>
<td>Select the installation identification for the MOUNPART block. The options are Installed (0), Only plotted (1), Only installed (2), Not installed, not plotted (3), Installed in reinforcement (4), Installed automatically (5)</td>
</tr>
</tbody>
</table>

See also
- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: Main tab (page 247)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Validation tab (page 274)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Data specification tab (page 278)
27.5 **Unitechnik export: Reinforcement tab**

Use the Reinforcement tab to control the Unitechnik export properties.

You can export single reinforcing bars, groups of straight and bent reinforcing bars, and rectangular or polygonal or bent meshes. The reinforcing bar group, or rectangular or polygonal mesh is divided into several single reinforcing bars. All reinforcing bars are exported in the RODSTOCK block.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebars export</td>
<td>When set to <strong>Yes</strong>, straight reinforcing bars are exported. Hooks are supported. You can define the setting separately for straight or bent rebars.</td>
</tr>
<tr>
<td>Meshes export</td>
<td>When set to <strong>Yes</strong>, polygonal or rectangular meshes are exported. Hooks are supported. You can define the setting separately for straight or bent meshes. You can also select whether to unfold along longest line or parallely to pallet.</td>
</tr>
<tr>
<td>Bent reinf. as unfolded</td>
<td>When set to <strong>Yes</strong>, bent reinforcement is exported as unfolded. Hooks are also supported for unfolded reinforcement, and you can select <strong>Yes, with end hooks</strong>. Hooks form 0, 2 and 5 are detected.</td>
</tr>
<tr>
<td></td>
<td>You can select between two reinforcement starting points: <strong>Origin in unfolded rebar</strong> or <strong>Origin in start rebar point</strong>. The option also affects the z level of the reinforcement in the resulting Unitechnik file.</td>
</tr>
<tr>
<td>Export meshes as embeds</td>
<td>When set to <strong>Yes</strong>, meshes are exported as embeds.</td>
</tr>
<tr>
<td>Braced girder classes</td>
<td>Enter the class of reinforcing bars, steel rods or profiles representing braced girders. For example, 15 17 5 means that parts with class 15, 17, or 5 are considered braced girders. If the Braced girder export and Braced girder classes boxes are not used, the braced girders will be exported incorrectly as reinforcement or embeds.</td>
</tr>
<tr>
<td>Reinforcement export type</td>
<td>Define the structure of the exported file for reinforcement.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Plant with lying robot only</strong></td>
<td>All embeds without modifications are exported.</td>
</tr>
<tr>
<td></td>
<td><strong>HEADER__</strong>&lt;br&gt;SLABDATE&lt;br&gt;CONTOUR__&lt;br&gt;CUTOUT__&lt;br&gt;MOUNPART&lt;br&gt;RODSTOCK&lt;br&gt;BGRGIRDER&lt;br&gt;EXTRON__&lt;br&gt;END SLABDATE&lt;br&gt;END HEADER__&lt;br&gt;</td>
</tr>
<tr>
<td><strong>Fabrication of welded rebars</strong></td>
<td>If <strong>Export type</strong> is set to <strong>Fabrication of welded rebars</strong>, a single reinforcing bar is exported in one <strong>STEELMAT</strong> block, all reinforcing bars of one group are exported together in one <strong>STEELMAT</strong> block, and all reinforcing bars of one mesh are also exported together in one <strong>STEELMAT</strong> block.</td>
</tr>
<tr>
<td></td>
<td>The structure of the output file (one <strong>SLABDATE</strong> is shown only):</td>
</tr>
<tr>
<td></td>
<td><strong>HEADER__</strong>&lt;br&gt;SLABDATE&lt;br&gt;CONTOUR__&lt;br&gt;CUTOUT__&lt;br&gt;MOUNPART&lt;br&gt;RODSTOCK&lt;br&gt;BGRGIRDER&lt;br&gt;REFORCME&lt;br&gt;STEELMAT&lt;br&gt;RODSTOCK&lt;br&gt;BGRGIRDER&lt;br&gt;END STEELMAT&lt;br&gt;STEELMAT&lt;br&gt;RODSTOCK&lt;br&gt;BGRGIRDER&lt;br&gt;END STEELMAT&lt;br&gt;EXTRON__&lt;br&gt;END REFORCME&lt;br&gt;END SLABDATE&lt;br&gt;END HEADER__&lt;br&gt;</td>
</tr>
<tr>
<td><strong>Collect reinforcement</strong></td>
<td>The structure of the output file is the same as for <strong>Fabrication of welded rebars</strong>. This option allows you to collect mesh, single reinforcing bars and reinforcing bar groups into groups exported in one <strong>STEELMAT</strong> block. The groups are collected based on the <strong>Collect based on</strong> field. You can also collect meshes which belong to different cast units.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td>(orange color): The mesh belongs to the bottom panel of the cast unit, mesh name is MESH1.</td>
</tr>
<tr>
<td>2</td>
<td>(blue color): Two single bars, the name is MESH1.</td>
</tr>
<tr>
<td>3</td>
<td>(green color): One reinforcing bar group belongs to the top panel, the name is MESH1.</td>
</tr>
</tbody>
</table>

If **Reinforcement export type** is set to Collect reinforcement and **Collect based on** is set to Name, all three different reinforcement types are collected into one mesh, which is exported in one STEELMAT block.

**Meshes as MOUNPART**

Meshes are exported in the MOUNPART block.

**Collect based on**

Select how meshes are collected. Meshes with one bar are exported as a single reinforcing bar.

- **Name**

  Meshes, single reinforcing bars and reinforcing bar groups with the same name are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with the same name equals one mesh in the exported file.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Class</td>
<td>Meshes, single reinforcing bars and reinforcing bar groups with the same class number are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with one class number equal one mesh in the exported file.</td>
</tr>
<tr>
<td>• Grade</td>
<td>Meshes, single reinforcing bars and reinforcing bar groups with the same grade are collected into meshes.</td>
</tr>
<tr>
<td>• UDA</td>
<td>Meshes, single reinforcing bars and reinforcing bar groups with the same user-defined attribute are collected into meshes.</td>
</tr>
<tr>
<td></td>
<td>The value you enter in the box next to this option is the UDA value.</td>
</tr>
<tr>
<td>Collect if distance is</td>
<td>Define the maximum distance between the meshes to be collected.</td>
</tr>
<tr>
<td>lower then</td>
<td></td>
</tr>
</tbody>
</table>

**Option**

- **Class**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same class number are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with one class number equal one mesh in the exported file.

- **Grade**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same grade are collected into meshes.

- **UDA**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same user-defined attribute are collected into meshes.
  - The value you enter in the box next to this option is the UDA value.

**Collect if distance is lower then**

Define the maximum distance between the meshes to be collected.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reinforcing bars length</strong></td>
<td>Select how the reinforcing bar length is calculated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Lines in the middle</strong></td>
</tr>
</tbody>
</table>

![Diagram of reinforcing bars length calculation](image)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Lines at the edge</td>
<td><img src="image" alt="Diagram of lines at the edge" /></td>
</tr>
</tbody>
</table>

Unitechnik export: Reinforcement tab
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinforcing bars diameter</td>
<td>Select how the reinforcing bar diameter is exported.</td>
</tr>
<tr>
<td></td>
<td>This selection affects the results of the Rebar length option.</td>
</tr>
<tr>
<td>Rebar direction angle limit</td>
<td>Select whether the reinforcing bars are sorted according to their angle direction.</td>
</tr>
<tr>
<td></td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>The reinforcing bars are not sorted.</td>
</tr>
<tr>
<td></td>
<td>• From 0 to 180</td>
</tr>
<tr>
<td></td>
<td>The reinforcing bars are exported as they are read from Tekla Structures and sorted according to their x and y position.</td>
</tr>
<tr>
<td></td>
<td>• From 0 to 180 ordered</td>
</tr>
<tr>
<td></td>
<td>The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with lower angles are first.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• From 180 to 0 ordered</td>
<td>The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with higher angles are first.</td>
</tr>
<tr>
<td>Reinforcement types</td>
<td>Select the reinforcing bar type in a mesh to be exported.</td>
</tr>
<tr>
<td></td>
<td>1 and 2 are for the rods in the bottom layer.</td>
</tr>
<tr>
<td></td>
<td>5 and 6 are for the rods in the top layer.</td>
</tr>
<tr>
<td></td>
<td>4 is for other or inclined rods.</td>
</tr>
<tr>
<td></td>
<td>8 is for loose bars.</td>
</tr>
<tr>
<td>Classes for loose rebar</td>
<td>Enter the classes of loose reinforcing bars to be collected. The bars are a part of a mesh and are exported as reinforcing bar type 8.</td>
</tr>
<tr>
<td>type 8</td>
<td></td>
</tr>
<tr>
<td>Classes for non-automated</td>
<td>Enter the classes of non-automatic reinforcing bars to be collected.</td>
</tr>
<tr>
<td>rebars</td>
<td></td>
</tr>
<tr>
<td>Add mesh stabilizing wires</td>
<td>Select whether to add wires to the reinforcement mesh to stabilize the mesh. Use for meshes with large openings.</td>
</tr>
<tr>
<td>Stabilization wire max</td>
<td>Enter a value to define the maximum spacing of the wires that stabilize the reinforcement mesh.</td>
</tr>
<tr>
<td>spacing</td>
<td></td>
</tr>
<tr>
<td>Meshes sort</td>
<td>Select whether meshes are sorted.</td>
</tr>
<tr>
<td>Meshes offset</td>
<td>Select whether the mesh has an offset defined in the STEELMAT block. If the option is set to Yes, the value for X and Y direction is set to zero. If the option is set to No, the X and Y values are exported according to modeled situation.</td>
</tr>
</tbody>
</table>
## 27.6 Unitechnik export: Validation tab

Use the **Validation** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw scanned geometry</strong></td>
<td>The exported geometry can be shown with <strong>Draw scanned geometry</strong>. This property shows the inside lines of the exported reinforcing bars. Select whether you want to check if the geometry of the exported parts is correct. It shows the lines representing the exported rectangle of the basic shape, the exported geometry of parts, cuts, embeds, and reinforcement. Embeds are projected to the plane of the basic shape. The reinforcement lines are positioned inside each reinforcing bar.</td>
</tr>
<tr>
<td><strong>Draw pallet axis</strong></td>
<td>Select whether to show the coordinate system. The axes are displayed with dotted lines.</td>
</tr>
<tr>
<td><strong>Wall to pallet checking</strong></td>
<td>Select whether the export checks the wall size against the pallet size. If you select the <strong>Yes</strong>, if</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>exceeded, do not export</td>
<td>option, the Pallet width and Pallet length, and Max. cast unit thickness options cannot be empty.</td>
</tr>
<tr>
<td>Pallet width</td>
<td>Define the pallet width.</td>
</tr>
<tr>
<td></td>
<td>With the help of pallet width and length the Wall to pallet checking option can check if a wall element is too big and does not fit to a pallet. If the wall element does not fit to a pallet, the wall element is turned.</td>
</tr>
<tr>
<td>Pallet length</td>
<td>Define the pallet length.</td>
</tr>
<tr>
<td>Max cast unit thickness</td>
<td>Define the maximum cast unit thickness.</td>
</tr>
<tr>
<td></td>
<td>To avoid collision with the drying chamber, the maximum thickness of a cast unit should be smaller than the maximum opening of the drying chamber.</td>
</tr>
<tr>
<td>Rebar diameter limitation</td>
<td>Minimum and maximum diameter for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation</td>
<td>Minimum and maximum length for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation (Longitudinal)</td>
<td>Minimum and maximum diameter for longitudinal reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation (Cross)</td>
<td>Minimum and maximum length for cross reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Export others</td>
<td>Select whether the reinforcing bars that do not meet the above limitations are exported at all (No), as loose reinforcing bars of type 4 or 8, or whether the diameter and length limitations are ignored.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: Main tab (page 247)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Data specification tab (page 278)
- Unitechnik export: Mounting part data specification tab (page 279)
- Unitechnik export: Line attributes tab (page 280)
27.7 Unitechnik export: Reinf. data specification tab

Use the **Reinf. data specification** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebars: Article number rebar</strong></td>
<td>Select which property you want to export as a reinforcing bar article number for rebars. The options are Empty, Name, Class, Rebar ID, UDA, Phase, User-defined text, User-defined text + class, and Template.</td>
</tr>
<tr>
<td><strong>Rebars: Article number mesh</strong></td>
<td>Select which property you want to export as a mesh article number for rebars. The options are Empty, Name, Class, Mesh ID, UDA, Phase, User-defined text, User-defined text + class, and Template.</td>
</tr>
<tr>
<td><strong>Meshes: Article number rebar</strong></td>
<td>Select which property you want to export as a reinforcing bar article number for meshes. The options are Empty, Name, Class, Rebar ID, UDA, Phase, User-defined text, User-defined text + class, and Template.</td>
</tr>
<tr>
<td><strong>Meshes: Article number mesh</strong></td>
<td>Select which property you want to export as a mesh article number for meshes. The options are Empty, Name, Class, Mesh ID, UDA, Phase, User-defined text, User-defined text + class, and Template.</td>
</tr>
<tr>
<td><strong>Meshes: Meshes designation</strong></td>
<td>Select what information you want to export about the meshes.</td>
</tr>
<tr>
<td><strong>Meshes: Info 1 text (UT 6.0)</strong></td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td><strong>Meshes: Info 2 text (UT 6.0)</strong></td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td><strong>Strands (UT 6.0): Pull force (KN)</strong></td>
<td>You can now use main part UDA (<strong>UDA (main part)</strong>) or rebar UDA (<strong>UDA (rebar)</strong>) to include strand pull force information in the Unitechnik export. Selecting <strong>Empty</strong> does not export the strand pull force information. This setting only works for rebars that are set to type <strong>9</strong> in the Unitechnik reinforcement type box.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>on the <strong>Unitechnik</strong> tab in the user-defined properties of the rebars.</td>
<td></td>
</tr>
<tr>
<td><strong>BRGIRDER block:</strong> Braced girder type</td>
<td>Select the string value of girder type field in the BRGIRDER block in the exported file.</td>
</tr>
<tr>
<td>• <strong>Empty</strong></td>
<td>No string is exported.</td>
</tr>
<tr>
<td>• <strong>Name</strong></td>
<td>The name of the braced girder type is exported. If the name of the top part of a braced girder is empty, the names of the rods are checked.</td>
</tr>
<tr>
<td>• <strong>UDA</strong></td>
<td>You can export the user-defined attribute values for a braced girder type (<strong>type</strong>), braced girder article number (<strong>art_number</strong>), or braced girder fabricator name (<strong>fabricator</strong>). The UDAs can be added to the braced girder if the parts have been created using the system component <strong>Braced girder (88)</strong> or <strong>Braced girder (89)</strong> and you have entered the needed values on the dialog boxes of the components.</td>
</tr>
<tr>
<td>• <strong>User defined text</strong></td>
<td>The value you enter in the box next to this option is exported.</td>
</tr>
<tr>
<td><strong>CAGE BLOCK:</strong> Cage designation</td>
<td>Select what information you want to export about the cage in the CAGE block (UT 6.1).</td>
</tr>
<tr>
<td><strong>CAGE BLOCK:</strong> Base cage shape</td>
<td>Select the information that you want to show as base cage shape. The options are Empty, Name, Class, Grade, Mesh ID, Mesh position, UDA, Phase, User-defined text, User-defined text [TplEd]#Counter, Part UDA, Main part UDA, and Template.</td>
</tr>
<tr>
<td><strong>CAGE BLOCK:</strong> Info 1 text</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td><strong>CAGE BLOCK:</strong> Info 2 text</td>
<td>Information field is filled with the selected data.</td>
</tr>
</tbody>
</table>

**See also**

- **Unitechnik** (page 244)
- **Export to the Unitechnik format** (page 246)
- **Unitechnik export: Main tab** (page 247)
27.8 **Unitechnik export: Data specification tab**

Use the **Data specification** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of order</td>
<td>Order fields in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>Name of component</td>
<td>Component fields in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>Drawing number</td>
<td>Drawing number fields in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>Drawing revision</td>
<td>Drawing revision fields in the <strong>HEADER</strong> block are filled with the selected data and drawing revision mark is exported.</td>
</tr>
<tr>
<td>Product code</td>
<td>Product code fields in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>Project line3 text</td>
<td>Project information fields (3rd line) in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>Project line4 text</td>
<td>Project information fields (4rd line) in the <strong>HEADER</strong> block are filled with the selected data.</td>
</tr>
<tr>
<td>File creator (UT 6.0)</td>
<td>You can select to export the Tekla Structures version information, use name or user-defined text in the <strong>HEADER</strong> block.</td>
</tr>
<tr>
<td>Free field (UT 5.2)</td>
<td>Only for Unitechnik 5.2. You can select to export the following information to the <strong>HEADER</strong> block: user name, user-defined text, file name with extension, file name without extension, or model name.</td>
</tr>
<tr>
<td>Slab number</td>
<td>Slab number field in the <strong>SLABDATE</strong> blocks is filled with the selected data.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transport unit number, Transport sequence number</td>
<td>Define a value for the transport unit and sequence numbers in the SLABDATE blocks.</td>
</tr>
<tr>
<td>Production thickness</td>
<td>Calculates the production thickness in SLABDATE block based on cast unit width or concrete part width.</td>
</tr>
<tr>
<td>Production weight</td>
<td>Set the type of the SLABDATE weight. The options are Part weight and Unit weight.</td>
</tr>
<tr>
<td>Quality of layer</td>
<td>Set the quality of the slabdate. The options are Material and UDA.</td>
</tr>
<tr>
<td>Info 1 text (60) - Info 4 text (60)</td>
<td>Information fields (1-4) in the SLABDATE and MOUNPART blocks are filled with the selected data.</td>
</tr>
<tr>
<td>Export project coordinates</td>
<td>Select whether you want to swap X and Y axis of the exported project coordinates.</td>
</tr>
</tbody>
</table>

See also
- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: Main tab (page 247)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Validation tab (page 274)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Mounting part data specification tab (page 279)
- Unitechnik export: Line attributes tab (page 280)
- Unitechnik export: Pallet tab (page 284)
- Unitechnik export: Log files tab (page 285)

27.9 Unitechnik export: Mounting part data specification tab

Use the **Mounting part data specification** tab to control the Unitechnik export properties.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of mounting part</td>
<td>You can define the type of mounting part in the <code>MOUNTPART</code> block using a user-defined attribute.</td>
</tr>
<tr>
<td>Reference number</td>
<td>You can define the reference number of a mounting part in the <code>MOUNTPART</code> block using a user-defined attribute.</td>
</tr>
<tr>
<td>Mountpart name</td>
<td>Enter the <code>MOUNTPART</code> name.</td>
</tr>
<tr>
<td>Info 1 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Info 2 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
</tbody>
</table>

See also

Unitechnik (page 244)
Export to the Unitechnik format (page 246)
Unitechnik export: Main tab (page 247)
Unitechnik export: TS configuration tab (page 252)
Unitechnik export: Embeds tab (page 261)
Unitechnik export: Reinforcement tab (page 266)
Unitechnik export: Validation tab (page 274)
Unitechnik export: Reinf. data specification tab (page 276)
Unitechnik export: Data specification tab (page 278)
Unitechnik export: Line attributes tab (page 280)
Unitechnik export: Pallet tab (page 284)
Unitechnik export: Log files tab (page 285)

27.10 Unitechnik export: Line attributes tab

Use the Line attributes tab to control the Unitechnik export properties. Sometimes line attribute values that are exported in the Unitechnik files are not suitable for the particular situation. For example, to preserve lightness in the model, you might have fewer chamfers in the model than there will be in the actual structure. For this reason, you might want to override some line attributes in the export so that the model remains light, but the exported Unitechnik files are correct. You can do this by using the options on the Line attributes tab.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export line attributes for contour</strong></td>
<td>Select whether the line attribute values are used for contours (<a href="#">Export line attributes for contour</a>) or for holes (<a href="#">Export line attributes for cutouts</a>) in the export.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are not used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All lines</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are used for all lines.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Outmost lines only</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are used only for the outermost lines in the part:</td>
</tr>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td>This option is available only for contours.</td>
</tr>
<tr>
<td><strong>Border line overriding</strong></td>
<td>You can enter up to six border line modifications in the line attribute export.</td>
</tr>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td>No border lines are overridden.</td>
</tr>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td>Vertical outermost border lines at the start are overridden.</td>
</tr>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td>Horizontal outermost border lines at the bottom are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>Vertical outermost border lines at the end are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>Horizontal outermost border lines at the top are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>Vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>Horizontal outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>Horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>All inclined outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="Option.png" alt="Option" /></td>
<td>All outermost border lines are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td>All vertical border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
<td>All horizontal border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram" /></td>
<td>All vertical and horizontal border lines except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram" /></td>
<td>All border lines except outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Diagram" /></td>
<td>All border lines except the horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Diagram" /></td>
<td>All border lines are overridden.</td>
</tr>
</tbody>
</table>

**Orig. attr, New attr.**

Define the original attribute (Orig. attr) and the attribute that will be used in the export (New attr.).

In the example below the horizontal outermost border line at the top would get a line attribute.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value 0033 originally, but the value will be overridden, and the line attribute value in the Unitechnik file will be 0040.</td>
<td></td>
</tr>
</tbody>
</table>

Export line attributes for cutouts
Select whether all line attributes are exported for holes.

Export angle of 1st and last vertical border
Select whether you want to export the angle of cut at the first and last vertical border.

See also
- Unitechnik (page 244)
- Export to the Unitechnik format (page 246)
- Unitechnik export: Main tab (page 247)
- Unitechnik export: TS configuration tab (page 252)
- Unitechnik export: Embeds tab (page 261)
- Unitechnik export: Reinforcement tab (page 266)
- Unitechnik export: Validation tab (page 274)
- Unitechnik export: Reinf. data specification tab (page 276)
- Unitechnik export: Data specification tab (page 278)
- Unitechnik export: Mounting part data specification tab (page 279)
- Unitechnik export: Pallet tab (page 284)
- Unitechnik export: Log files tab (page 285)

### 27.11 Unitechnik export: Pallet tab

Use the Pallet tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placing on pallet</td>
<td>Select if the placing is checked from the start or end of the pallet.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Offset at start or end</td>
<td>Define the offset at start or end of the pallet used in checking.</td>
</tr>
<tr>
<td>Clearance between cast units</td>
<td>Define the clearance between the cast units used in checking.</td>
</tr>
<tr>
<td>Same cast unit thickness needed</td>
<td>Select if the cast unit thickness is checked.</td>
</tr>
</tbody>
</table>

**See also**

Unitechnik (page 244)

Export to the Unitechnik format (page 246)

Unitechnik export: Main tab (page 247)

Unitechnik export: TS configuration tab (page 252)

Unitechnik export: Embeds tab (page 261)

Unitechnik export: Reinforcement tab (page 266)

Unitechnik export: Validation tab (page 274)

Unitechnik export: Reinf. data specification tab (page 276)

Unitechnik export: Data specification tab (page 278)

Unitechnik export: Mounting part data specification tab (page 279)

Unitechnik export: Line attributes tab (page 280)

Unitechnik export: Log files tab (page 285)

---

**27.12 Unitechnik export: Log files tab**

Use the Log files tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Log file directory path</td>
<td>Define the path for a log file. If the path is empty, then the log file is saved in the same location as the export files.</td>
</tr>
<tr>
<td>Create main Log file</td>
<td>Select whether to create a one main log file.</td>
</tr>
<tr>
<td>Create Log file for each file</td>
<td>Select whether a log file is created separately for each export file.</td>
</tr>
<tr>
<td>Write history to log file and UDA</td>
<td>Create a log file containing the history of the exported parts. The information is also written to the UDA UT_export_history of the main part. The following data is gathered: export time, part</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>information, export path and file, and who has performed the export.</td>
</tr>
<tr>
<td><strong>Show error dialog boxes</strong></td>
<td>Select whether an error message is shown when exported parts are not numbered correctly or when the embedded parts have no parent part.</td>
</tr>
</tbody>
</table>

**See also**

Unitechnik (page 244)
Export to the Unitechnik format (page 246)
Unitechnik export: Main tab (page 247)
Unitechnik export: TS configuration tab (page 252)
Unitechnik export: Embeds tab (page 261)
Unitechnik export: Reinforcement tab (page 266)
Unitechnik export: Validation tab (page 274)
Unitechnik export: Reinf. data specification tab (page 276)
Unitechnik export: Data specification tab (page 278)
Unitechnik export: Mounting part data specification tab (page 279)
Unitechnik export: Line attributes tab (page 280)
Unitechnik export: Pallet tab (page 284)
Use Layout Manager to import and export layout data between Tekla Structures and a field layout device. Layout Manager enables you to use accurate model data on the construction site.

The image below illustrates the phases in the field layout workflow.

1. First define layout points and layout lines in your model, and organize them in suitable groups in Layout Manager. We recommend that you first set up the groups in Layout Manager, then model the points and lines and organize them in the groups. The points and lines are used in a layout device on the construction site to position parts correctly.

2. Once you have defined the layout data, you can export the data from Layout Manager to a field layout device in three different export formats: point file (.txt), job file (.cnx), and field link file (.tfl).

3. You can check and measure the positions of the exported layout points (design points) on the site using a field layout device. The layout device helps
you to position the parts correctly on the site, as the points along the part boundaries can be placed to the correct locations.

4. To place the part boundaries correctly, measure the as-built positions of the parts on the site and create measured points along the part boundaries.

5. When you have measured the as-built positions and created measured points, you can import the points to Tekla Structures. You can first preview the points in Layout Manager.

6. Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device such as Trimble® LM80, you need to connect your computer to the device. Your computer needs to have software that enables it to communicate with a mobile device. For information on how to connect your computer to Trimble layout devices, see the Trimble website.

See also
Create a group in Layout Manager (page 288)
Create a layout point (page 290)
Create a layout line (page 291)
View groups, layout points and layout lines in Layout Manager (page 292)
Export layout data from Layout Manager (page 293)
Import layout data to Layout Manager (page 296)

28.1 Create a group in Layout Manager

You can create groups in Layout Manager to organize layout points and layout lines suitably.

1. On the Manage tab, click Layout manager.
2. Right-click Layout Manager Object Group and select Add Group.
   You may want to set up several groups so that you can organize the points and lines into groups as they are modeled.
3. If needed, click the group to rename it.
   A group name can have 18 characters.

NOTE Layout Manager may show an Unassigned group in the tree structure. The Unassigned group shows layout points and layout lines that have inadequate
group information. Such points and lines have usually been created in an earlier Layout Manager version.

See also
Define numbering settings for groups in Layout Manager (page 289)
Define a local coordinate system for a group in Layout Manager (page 289)

Define numbering settings for groups in Layout Manager
You can define that all groups in Layout Manager have the same numbering settings. When you change the settings, the changed settings are used in all the groups you create after the change. The settings in the existing groups are not changed.

1. On the Manage tab, click Layout manager.
2. Click Settings > Group.
3. Define the numbering settings.
   a. Enter the prefix in the Prefix box.
   b. Enter the starting number in the Starting number box.
   c. Enter the maximum length of the number in the Number max length box.
   d. Enter a delimiter to separate the prefix and the number in the Delimiter box: a hyphen or an empty space.
   e. Select from the Fill leading space list whether the leading space in front of the number is filled with zeroes or not, for example, PFX 00001 or PFX 1.
4. Click OK.
5. To apply the numbering settings to the points and lines in a group, right-click the group and select Auto Naming.

NOTE You can modify the numbering settings of an individual group if you do not want to use the default settings. Select the group and change the settings. To restore the default settings, click Reset.

See also
Create a group in Layout Manager (page 288)
Define a local coordinate system for a group in Layout Manager

You can define a local coordinate system for each group in Layout Manager. Local coordinate systems may be relative to a municipal monument or to the local project site datum. In many cases, models may already be properly placed so that no local coordinate system needs to be defined.

1. On the Manage tab, click Layout manager.
2. Select a group.
3. Define the coordinates using the Group local coordinate system options:
   a. Click the Pick button next to the Location box and pick the origin in the model.
   b. Click the Pick button next to the Axis X box and set the x direction in the model.
   c. Click the Pick button next to the Axis Y box and set the y direction in the model.
4. Click Set.

**NOTE** You can set the work plane using a suitable Workplane command on the View tab. When you have set the work plane, select a group in Layout Manager. Click the Pick button next to the Use current work plane option under Group local coordinate system and click Set.

See also
Create a group in Layout Manager (page 288)

28.2 Create a layout point

Use the Layout Point tool in the Applications & components catalog to create layout points. The layout points that you create in the model are design points that you can export to a layout device.

Before you start, ensure that the Select components selection switch is activated.
1. Double-click the Layout Point tool in the list of components in the Applications & components catalog.
2. Define the layout point properties on the Parameters tab:
   a. Enter a name and a description for the layout point.
You can use the following special characters in layout point names: _ ~ % ! @ # & . = + - and space.

Note that the maximum length of the name is 16 characters if you export layout data to .cnx and .tfl formats. When exporting to a text file, there is no limitation to the number of characters in the name. The maximum length of the description is 24 characters.

b. Enter the diameter of the layout point in the Size box.

   Layout Manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.

c. Select whether the layout point is a reference point or not.

   A reference point is a mapping point to another coordinate system such as a geo-spatial coordinate system or a municipal monument.

d. Select a color for the layout point.

e. Select a shape for the layout point.

f. Select a group from the list or create a new group by entering a name.

3. Select a location for the layout point in the model.

   The layout point is created when you select the location.

4. On the Manage tab, click Layout manager.

5. Click Refresh to show the added point.

   NOTE You can also add a layout point to a group in Layout Manager. First select a group, then select the point in the model. Right-click the group and select Add Selected from the pop-up menu. Click Refresh to show the point.

See also

Create a group in Layout Manager (page 288)
Measured points in Layout Manager (page 299)

28.3 Create a layout line

   Use the Layout Line tool in the Applications & components catalog to create layout lines. Layout lines are created between layout points.

   Before you start, ensure that the Select components selection switch is activated. Create layout points in your model.
1. Double-click the **Layout Line** tool in the list of components in the **Applications & components** catalog.

2. Define the properties of the layout line:
   a. Enter a name and a description for the layout line.
   b. Enter the diameter of the layout line in the **Size** box.
      
      **Layout Manager** uses the **XS_IMPERIAL** advanced option to determine the units. Set **XS_IMPERIAL** to **TRUE** to show imperial units.
   c. Select a color for the layout line.
   d. Select a group from the list or create a new group by entering a name.

3. Pick the first layout point.

4. Pick the second layout point.
   
The start point and the end point cannot be in the same location.
   
The layout line is created.

5. On the **Manage** tab, click **Layout manager**.

6. Click **Refresh** to show the added line.

**NOTE** You can also add a layout line to a group in **Layout Manager**. First select a group, then select the line in the model. Right-click the group and select **Add Selected** from the pop-up menu. Click **Refresh** to show the line.

See also

- Create a group in Layout Manager (page 288)
- Create a layout point (page 290)

### 28.4 View groups, layout points and layout lines in Layout Manager

You can view the properties of groups, layout points and layout lines in **Layout Manager**. You can zoom to and highlight selected layout points and layout lines in the model and in **Layout Manager**.

On the **Manage** tab, click **Layout manager** and do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide the properties of groups,</td>
<td>Click <strong>Show property pane</strong> in <strong>Layout Manager</strong>. The property pane is visible by default.</td>
</tr>
</tbody>
</table>
To | Do this
--- | ---
layout points and layout lines in **Layout Manager** |  

| 1. Right-click a point or a line in **Layout Manager**.  
2. Select **Zoom Selected** from the pop-up menu. |

| Zoom in to a point or a line in the model |  

| 1. Select a point or a line in the model.  
2. Click 🕵️ in **Layout Manager**.  
3. Select **Highlight selected model point**.  
To remove the highlighting, select **Redraw**. |

| Highlight a point or a line in **Layout Manager** |  

---

**See also**

[Layout Manager](page 287)  

---

**28.5 Export layout data from Layout Manager**

You can use **Layout Manager** to export layout data from your model to a layout device.

You have two options when exporting:

- Export the layout data from **Layout Manager** to a file and move the file later to a layout device.
- Export a file directly to a layout device. You can do this if you connect the layout device to your computer using a USB or a Bluetooth connection.

Before you export, you can define the default export settings in **Layout Manager Settings** 📁, see [Define default export settings in Layout Manager](page 294).  

1. On the **Manage** tab, click **Layout manager**.
2. Click **Settings 📁** to check that you have defined the needed export settings.
3. Close the **Settings**.
4. Select the group that you want to export.

   If you have defined a local coordinate system for a group, the points in such a group are exported according to the local coordinate system. The local coordinates of the points are shown in the export dialog box. The
temporary work plane location will not affect the coordinates of the exported points.

If you select more than one group, ensure that the groups have the same local coordinate system. If the groups have different local coordinate systems, a warning message is displayed and you cannot proceed to export.

5. Click Export.

6. Select an export option:
   - Export point file (.txt) to export layout points.
   - Export job file (.cnx) to export all layout data in the model to Trimble® LM80.
   - Export Field Link File (.tlf) to export all layout data in the model to a field link device.

   Note that in addition to Trimble devices, other layout devices can also read in the .txt and .cnx file types.

   **NOTE** The layout points that you create in the model are design points that you can export to a layout device.

   The maximum length of the layout point name is 16 characters if you export layout data to .cnx and .tlf formats. When exporting to a text file, there is no limitation to the number of characters in the name. The maximum length of the description is 24 characters.

7. Click Select to enter a name for the export file.

8. Select the destination folder.

9. Click Save.

10. If needed, select a drawing in Map file.

    You can attach a layout drawing when exporting a job file (.cnx) and a field link file (.tlf). You can use the layout drawing with the layout point data in the layout device.

11. Click OK.

**See also**

Layout Manager (page 287)
Define the drawing scale in Layout Manager (page 295)
Define default export settings in Layout Manager

You can define the default export settings for each export file type: point file (.txt), Trimble LM80 job file (.cnx), and Trimble Field Link (.tfl). The units depend on the settings in File menu --> Settings --> Options --> Units and decimals.

1. On the Manage tab, click Layout manager.
2. Click Settings.
3. Click Point File to define the export settings for point files (.txt):
   a. Select the unit.
   b. Select the delimiter.
   c. Define the order of column headers in point files. Right-click a header in the list and select Move Up or Move Down.
4. Click Trimble LM80 to define the export settings for Trimble® LM80 job files (.cnx):
   a. Select the Default directory.
   b. Select the default Length unit.
      You can select to export as meters, feet-inches, or survey feet.
   c. Select the plane Angle unit.
      The default angle unit is Degree.
   d. Select the Version of the Trimble® LM80 device.
      The default version is V4. Ensure that the setting matches the version of your layout device.
5. Click Trimble Field Link to define the Trimble Field Link file default directory for field link files (.tfl).
6. Click OK.

See also

Export layout data from Layout Manager (page 293)

Define the drawing scale in Layout Manager

You can include a drawing when exporting all layout data in a job file or a field link file from Layout Manager. The drawing is exported in the .dxf or .dwg format. To ensure that the drawing is exported correctly, you need to define the drawing scale.

1. Create a general arrangement (GA) drawing of your model.
   We recommend that you make the drawing as simple as possible, include only parts and grids, to show the drawing correctly in a layout device. You
can, for example, create a drawing template to be used in Layout Manager export.

2. Open the drawing.
3. Double-click the drawing view frame to open View Properties.
4. Copy the drawing scale.
5. On the Manage tab, click Layout manager.
6. Click Drawing Scale Calculator.
7. Paste the drawing scale in the Scale Denominator box.
8. Click Calculate.

   The drawing scale is shown in the Scale box.
9. Copy the drawing scale from the Scale box and close the Drawing Scale Calculator dialog box.
11. Define the export file name on the Export file tab.
12. Go to the Options tab.
13. Paste the copied drawing scale in the Drawing scale box.
14. Click Export.

   You can now export the job file or the field link file and the drawing from Layout Manager.

See also

Export layout data from Layout Manager (page 293)

28.6 Import layout data to Layout Manager

You can use Layout Manager to import layout data to your model from a layout device to verify the as-built conditions.

You have two options when importing:

- Copy the file that contains the layout data from the layout device to your computer and import the file later to Layout Manager.
- Import the file directly to Layout Manager. You can do this if you connect the layout device to your computer using a USB or a Bluetooth connection.

1. On the Manage tab, click Layout manager.
2. On the View tab, click Workplane to set the work plane to the model origin or to the location you want to use as the origin when importing points and lines.
3. In Layout Manager, click Import.

4. Select an import option:
   - **Import point file (.txt)** to import layout points.
     Point files (.txt) are always imported to the Design Points tab, regardless of whether they have been measured on the site or not.
   - **Import job file (.cnx)** to import all layout data in a Trimble® LM80 job file.
     Job files (.cnx) are imported to the Measured Points tab.
   - **Import Field Link file (.tfl)** to import all layout data in a field link file.
     Field link files (.tfl) import both design points that have been exported from Tekla Structures originally and measured points that have been measured on the site. In the import dialog box, a design point is flagged ▼ if the point name and, therefore, the point already exists. We recommend that you do not import an existing design point. Clear the check box next to the flag to exclude an existing point from the import ▶.

5. Click Select to select the file to import.
6. Click Load to show the file contents.
7. If needed, define the point file columns in the Text File Import - Column Headers Mapping dialog box.
8. Define the import location in your model using the Insert coordinate system options.
   You can either select the Insert to default coordinate system option or define the location. To define the location:
   - Click the Pick button next to the Location box and pick the origin in the model.
   - Click the Pick button next to the Axis X box and set the x direction in the model.
   - Click the Pick button next to the Axis Y box and set the y direction in the model.
   - Click Set.
9. Select the group to which the layout data is imported.
   - If you do not select any existing group or create a new group, the layout points are imported using their existing Trimble layer categories.
10. Click OK.
NOTE  Design points are layout points that have been created in the Tekla Structures model. Measured points are layout points that have been measured on the construction site.

See also

Define point file columns in Layout Manager (page 298)
Measured points in Layout Manager (page 299)

Define point file columns in Layout Manager

You can import layout points to your model in a point file that lists the layout point names and the point coordinates. If the point file does not have a header or if Layout Manager does not recognize the header, the Text File Import - Column Headers Mapping dialog box is displayed when you click Load to show the file contents in the import dialog box.

Example of a point file without a header:

```
Layout point 6, 0, 13.12336, , 0
Layout point 5, 0, 6.56168, , 0
Layout point 4, 4.92126, 0; , 0
Layout point 3, 9.84252, 6.56168, , 0
Layout point 2, 4.92126, 13.12336, , 0
Layout point 1, 9.84252, 13.12336, , 0
Layout point, 9.84252, 0, , 0
```

In the Text File Import - Column Headers Mapping dialog box, the content of the point file is shown at the bottom and the column headings are shown at the top.

1. Check that the point file content is shown under the correct column headings:
   - Name Column shows the layout point name.
   - X Column shows the x coordinates.
   - Y Column shows the y coordinates.
   - Z Column shows the z coordinates.
2. If needed, change the columns at the top of the dialog box by selecting the correct column from the list.

3. Select a measuring unit.

4. Select in the **Process first line** option whether the first line in the point file is a header row or not.
   - **Yes** means that the first line has layout point data and that it is not a header line.
   - **No** means that the first line is a header line.

5. Click **OK**.

**See also**

Import layout data to Layout Manager (page 296)

**Measured points in Layout Manager**

Measured points are points that are measured on the construction site using a layout device and imported to Tekla Structures. You can view the properties of measured points in **Layout Manager** or in the **Layout Point** tool dialog box. In addition to the general point properties, such as name, diameter, and shape, measured points have measured point properties that cannot be modified in Tekla Structures.
To view the properties, select the point in **Layout Manager** or double-click the point in the model.

The measured point properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Is Stakeout Point</strong></td>
<td>You can label a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td><strong>Is Field Point</strong></td>
<td>A field point has been measured on the construction site and imported to Tekla Structures.</td>
</tr>
<tr>
<td><strong>Is Field Line</strong></td>
<td><strong>Is Field Line</strong> is the corresponding property for layout lines. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td><strong>HR</strong></td>
<td>Height of rod is the height of the prism on the pole. It is used to determine instrument height, and therefore the actual elevation of the measured point.</td>
</tr>
<tr>
<td><strong>HA</strong></td>
<td>Horizontal angle is the angle that was measured from the back sight or 0 angle.</td>
</tr>
<tr>
<td><strong>VA</strong></td>
<td>Vertical angle is the difference in angle measurement from the horizontal position of the instrument scope.</td>
</tr>
<tr>
<td><strong>SD</strong></td>
<td>Slope distance is the actual distance regardless of elevation change. Horizontal angle is the distance along a horizontal plane.</td>
</tr>
<tr>
<td><strong>PPM</strong></td>
<td>Parts per million is a factor used to determine measurements that take into account the air conditions and how they affect the ability of light to travel through the air. This property is important in the measurement calculation and accuracy.</td>
</tr>
<tr>
<td><strong>Benchmark offset</strong></td>
<td>Benchmark offset is a measurement that is taken to</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>define a benchmark that elevation measurements are calculated from.</td>
</tr>
</tbody>
</table>

**See also**

- Import layout data to Layout Manager (page 296)
- Create a layout point (page 290)
You can publish your Tekla Structures models as web pages that can be viewed via the Internet using Internet Explorer.

See also
Publish a model as a web page (page 302)
Customize Web Viewer tooltips (page 303)
Web templates in Web Viewer (page 304)
Send Web Viewer models (page 304)
Create a named view in Web Viewer (page 305)
View a model in Web Viewer (page 306)

29.1 Publish a model as a web page
You can publish a model as a web page with Tekla Web Viewer and include tooltips in the model.

1. On the File menu, click Export --> Publish as web page.
2. Select Publish as Web Page.
3. Select whether to publish the entire model or selected objects.
   If you are publishing selected objects, use the appropriate selection switch to control whether parts, or parts in assemblies or cast units are published.
4. Select the file type.
5. Define a title for the published web page.
6. Select a Web Viewer template.
7. Define the destination folder and the file name.
   You can define the location and the name of the published model folder.
   You can also rename the published file but do not change the file name
extension (*.xml). By default, Tekla Structures creates a \PublicWeb folder with sub-folders in the current model folder and places the published model there as an index.html file.

8. Select the tooltip template.
   You can create your own tooltip templates in Template Editor. The preview shows how the tooltip is shown in Web Viewer.

9. Click Publish.
   The web browser includes several commands for examining the model. You can right-click the model in the browser to access a pop-up menu containing these commands.

**TIP** To use a large model faster in Web Viewer:
   1. Right-click and select Disable full content rendering from the pop-up menu.
   2. To enable full content rendering again, select Enable full content rendering from the pop-up menu.

See also
- Customize Web Viewer tooltips (page 303)
- Web templates in Web Viewer (page 304)

### 29.2 Customize Web Viewer tooltips
   You can define what kind of tooltips are shown in a published Web Viewer model. Use Template Editor to create a tooltip template.
   1. On the File menu, click Editors --> Template Editor.
   2. Create a new template.
   3. Save the template in the *.rpt format in the ..\Tekla Structures \<version>\Environments\<environment>\template\tooltips folder.
   4. On the File menu, click Export --> Publish as web page.
   5. Select a customized tooltip template in the Tooltip in Web Viewer list.
      The preview shows how the tooltip is shown in Web Viewer.
   6. Click Publish.

**NOTE** If you do not want to show the template name as a file name in the tooltip template list, add the template in the WebViewerTooltips.ini file. The file is located in the same folder as the tooltip templates. For example, to show
See also

Publish a model as a web page (page 302)

29.3 Web templates in Web Viewer

All Web Viewer specific materials, for example, a tool (*.dll) for viewing the model and templates for HTML files are stored in the subfolders under \Tekla Structures\<version>\nt\WebTemplates\TeklaWebViewer.

When you publish a model as a web page, Tekla Structures copies the tool and the files to the folder you have given in the File name box in the Publish as Web Page dialog box. You cannot modify the tool, but you can modify the HTML files to include information that is relevant to your company and the project.

Project-specific fields must be inside % signs in the HTML files. Tekla Structures uses information from the model you are publishing in these fields. For example, when you want the project name to show in the Web Viewer model, add %NAME% in the HTML file. When you publish your model, Tekla Structures takes the project name from the project properties.

NOTE Do not remove the string %PUBLISHED_MODEL% from the index.html file. Tekla Structures replaces the string with the file name information from the Publish as Web Page dialog box.

See also

Publish a model as a web page (page 302)

29.4 Send Web Viewer models

When you have published a model as a web page in Web Viewer, you can send Web Viewer models to others as zipped files. You can also send a link to Web Viewer views or to the whole model.
See Publish a model as a web page (page 302) on how to publish a model in Web Viewer.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send a Web Viewer model as a zipped file</td>
<td>1. Create a .zip file of the entire \PublicWeb folder that is under the model folder. Remember to use the folder structure.</td>
</tr>
<tr>
<td></td>
<td>2. Attach the .zip file to an e-mail message and send it to the recipient. When you receive a zipped Web Viewer model, ensure that you keep the folder names when extracting the files. To open the model, double-click the index.html file.</td>
</tr>
<tr>
<td>Send a link to a Web Viewer view</td>
<td>Use the <strong>Send Web Viewer Link</strong> tool in Web Viewer. See Create a named view in Web Viewer (page 305) for instructions on how to create named views.</td>
</tr>
<tr>
<td></td>
<td>To see the view name in the <strong>Named views</strong> list, the recipient must copy the text string and paste it into the Web Viewer model. You can also send links to several views. Copy the text strings pointing to the views into a text file and send the text file. The recipient then copies the contents of the text file and pastes it into the Web Viewer model.</td>
</tr>
<tr>
<td>Send a link to a Web Viewer model</td>
<td>Use the <strong>Send ULR Link</strong> tool in Web Viewer. The recipient must have access to the folder that contains the published model.</td>
</tr>
</tbody>
</table>

### 29.5 Create a named view in Web Viewer

You can zoom in the Web Viewer model and create named views.

1. In the \PublicWeb folder under the model folder, open the index.html of the published model.
2. Zoom in to the part of the model from which you want to create the view.
3. Right-click and select **Copy location**.
4. Create a new file in any text editor (for example, Microsoft Notepad) and paste the location information into it.
The file should look, for example, as follows:

```
[webviewer pointinformation] name: "xyz"
projectiontype: perspective
position: (2047.73 2809.072 11.216) direction: (0.128 0.974 -0.187) upvector: (0.024 0.185 0.982)
```

5. Replace the default name `xyz` with a name you want the view to have.
6. Select all text in the file, right-click and select **Copy** to copy the updated location information to the published model.
7. In Web Viewer, right-click on the model and select **Paste location**. The view name appears in the **Named views** list.

Web Viewer does not save named views with the published model. You can save the text file that contains the location information, then copy the text to the published model in Web Viewer the next time you want to use the view.

To allow others to see your named views, send the views using the **Send Web Viewer link** tool.

**See also**
Send Web Viewer models (page 304)

### 29.6 View a model in Web Viewer

You can show and hide objects, and move and zoom in a model in Web Viewer.

See **Publish a model as a web page** (page 302) on how to publish a model in Web Viewer.

#### Show and hide objects in Web Viewer

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide an object</td>
<td>1. Move the mouse pointer over the object.</td>
</tr>
<tr>
<td></td>
<td>2. Hold down the <strong>Ctrl</strong> key and scroll up using the mouse wheel (or press the <strong>Page Up</strong> key).</td>
</tr>
<tr>
<td>Show a hidden object</td>
<td>1. Move the mouse pointer over the hidden object.</td>
</tr>
<tr>
<td></td>
<td>2. Hold down the <strong>Ctrl</strong> key and scroll down using the mouse wheel (or press the <strong>Page Down</strong> key).</td>
</tr>
<tr>
<td>Show all objects</td>
<td>Press the <strong>Esc</strong> key.</td>
</tr>
</tbody>
</table>
### To Do this

| **Show and hide objects by using a clip plane** | 1. Press the P key.  
2. Select an object face to align the clip plane with.  
3. Move the clip plane by dragging the scissor symbol.  
You can jump from a clip plane to another by pressing the space bar. |

### Move and zoom in Web Viewer

<table>
<thead>
<tr>
<th><strong>To</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
</table>
| **Zoom in or out** | Do one of the following:  
• Press the **Page Up** or **Page Down** key.  
• Scroll the mouse wheel up and down. |
| **Move the model** | Do one of the following:  
• Click **Pan** and drag.  
• Drag with the mouse middle button. |
| **Rotate the model** | Do one of the following:  
• Click **Rotate** and drag.  
• Hold down the **Ctrl** key and drag with the middle mouse button. |
| **Fly through the model** | 1. Click **Fly** and move the mouse forward to fly forward.  
2. To change flying direction, move the mouse to the desired direction.  
3. To stop, click **Esc**. |
| **Center the model on the screen** | Click **Center**. |
| **Return the model to the original view** | Click **Home**. |
| **Relocate the center of rotation** | 1. Press the **V** key.  
2. Click to select a new center of rotation. |

You can also right-click the model and select the move and zoom commands from the pop-up menu.
Tekla BIMsight is a free project collaboration software.

With Tekla BIMsight you can combine models from different project participants and check for hard and soft conflicts visually and with conflict checking tools. You can communicate with other parties involved in the project by adding notes, markups and project documentation to the models.

You can download Tekla BIMsight at www.teklabimsight.com.

**See also**

Import reference models from Tekla BIMsight (page 308)
Import additional reference models from a Tekla BIMsight project (page 309)
Publish a model to Tekla BIMsight (page 309)

### 30.1 Import reference models from Tekla BIMsight

You can import models from a Tekla BIMsight project to Tekla Structures as reference models.

1. On the **File** menu, click **Import --> Tekla BIMsight**.
   
   The **Import From Tekla BIMsight** dialog box opens.

2. Browse for the Tekla BIMsight project (.tbp file).

3. Click **Import** to import the models from the Tekla BIMsight project.
   
   You may need to subdivide the reference models, fit the work area in the model, and change the main 3D view depth to see the reference models entirely after importing.

**See also**

Import additional reference models from a Tekla BIMsight project (page 309)
30.2 **Import additional reference models from a Tekla BIMsight project**

Additional models may have been added to a Tekla BIMsight project after you have imported reference models from the project to Tekla Structures. You can import the additional reference models to Tekla Structures.

1. Save the Tekla BIMsight project with the same name as previously.
2. In Tekla Structures, on File menu click **Import --> Tekla BIMsight**.
3. Browse for the Tekla BIMsight project (.tbp file).
4. Click **Import** to import the models from the Tekla BIMsight project.

New reference models are added to the Tekla Structures model. The existing reference models are not modified in any way. Tekla Structures keeps track of the reference models by checking the TeklaBIMsightGUID attributes.

30.3 **Publish a model to Tekla BIMsight**

You can publish your Tekla Structures model and the reference models included in the model as a Tekla BIMsight project file (.tbp).

1. On the File menu, click **Export --> Tekla BIMsight**.
   - The **Publish to Tekla BIMsight** dialog box opens.
2. Enter a name for the project file.
3. Select the folder where you want to save the project file.
4. Select other options as required.
   - You can include assemblies, base quantities, bolts, grids and reinforcements in the published project.
   - You can split models according to phases.
   - Select the **Open After Publish** check box to open the project in Tekla BIMsight after publishing.
5. Do one of the following:
   - Click **Publish All** to publish the whole model. If the model contains reference models they are also included.
   - Click **Publish Selected** to publish the selected objects.

**See also**

*IFC base quantities in exported IFC model (page 95)*
Tekla Structural Designer is a software that allows you to design reinforced concrete buildings and steel buildings. It works with real physical objects such as beams, columns and slabs. The information transferred is the physical information such as geometry, section sizes and grade as well as attributed data. In Tekla Structures, you can import from and export to Tekla Structural Designer.

Tekla Structural Designer is a code-based modeling tool, which enables structural engineers to establish a code compliance design of the structure, and perform calculations and schema design, for example. All the design/code data is held within Tekla Structural Designer at all times.

Tekla Structural Designer will analyze and design structures to a range of International codes of practice.

The initial model can be started in either Tekla Structures or Tekla Structural Designer, depending on the project needs. You can import and export many times, and make use of the effective change management functionality.

The integration process allows you to pass models between Tekla Structural Designer and Tekla Structures, allowing the updates in the model at both ends. As the model is integrated between software applications, the changes are updated, and modifications performed since the last integration operation are maintained within the model.

Tekla Structural Designer and Tekla Structures accept and produce files in the .cxl neutral file format. The .cxl file format is an XML based neutral file format that allows applications to link Tekla Structural Designer.

Tekla Structures supports files created in Tekla Structural Designer 2016 or later.

This section only contains instructions regarding import (page 312), re-import (page 314) and export (page 315) with the Tekla Structural Designer integrator. For more information about Tekla Structural Designer and the integration between Tekla Structural Designer and Tekla Structures, see Guidance notes for Integration between Tekla Structural Designer and Tekla Structures. This page contains a link to "Integration with Tekla Structures" guide in .pdf format.
31.1 Example workflow of integration between Tekla Structures and Tekla Structural Designer

Integration between Tekla Structures and Tekla Structural Designer has been developed to ensure that the initial model can be started in either tool without any detriment to the design process. This added flexibility enables companies to align their software solutions closely to their own workflows. (i.e. The initial model can be created in Tekla Structural Designer by the engineer or in Tekla Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model" for geometrical changes as this model also is linked to the BIM documentation. Alterations made to the model geometry are best handled by altering the Tekla Structures model and transferring the changes through to Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different stages of a project could be as follows:

Initial scheme stage

• The initial model may be started in Tekla Structures or Tekla Structural Designer without any detriment to the process.

• A number of factors may determine which software is used for starting the modeling process, such as availability of staff, or deliverable requirements.

• Unless there are external drivers, Tekla Structures may prove to be the best starting point for the model as it can provide most of the deliverable items at the initial stage.

• The model does not need to cover the complete building, it might be a typical bay or floor, for example.

• The generated structure can be designed in Tekla Structural Designer for initial section sizing at the initial stage and synchronized back to Tekla Structures for initial drawings or material list creation.

• Simple drawings can be created at this stage, this can be done in Tekla Structures or Tekla Structural Designer.

• Initial material lists for cost estimates can be generated at this stage.
Detailed design stage

- It is not always appropriate to carry models forward from the Initial scheme stage to the Detailed design stage as changes to the overall scheme may have been made, which will not be reflected in the initial scheme model. It is sometimes better to begin the model again.
- Models can be started in Tekla Structures or Tekla Structural Designer to suit the user. The models can then be transferred to the other modeling system.
- Importantly, the two models can be worked on at the same time, with synchronization of the two models taking place to suit the workflow.
- Tekla Structural Designer can be used for a full gravity and lateral design of the structure.
- Within Tekla Structures, drawings can be generated to a tender stage level and general arrangements submitted to building control for approval.

Construction stage

- Using the model from the Detailed design stage, much of the Construction stage process will take place in Tekla Structures so that the integration with other disciplines can be accounted for.
- The design is not revisited unless the client drives the requirement for change.
- If a re-design of the structure is required, the same synchronization of Tekla Structures or Tekla Structural Designer models can be carried out to suit the user.
- The model will be completed within Tekla Structures and fully detailed drawings for parts can be created along with construction level arrangement drawings of the structure.
- Detail integration checks with other disciplines (e.g. mechanical and electrical engineers) can be carried out at this stage.

31.2 Import with Tekla Structural Designer integrator

Import with Tekla Structural Designer integrator creates Tekla Structures parts, such as beams, columns, slabs, and shear walls based on the contents of the imported .cxl neutral file.

Before importing, open Tekla Structures and the model where you want to import.

1. On the File menu, click Import --> Tekla Structural Designer .
2. In the import dialog box, enter the path of the import .cxl file in the Import file box or click the ... button next to the box to browse for the file.
3. Once you have selected a valid file, the import buttons and the Preview Conversion button will be enabled. To read the import file and display all the proposed profile and material grade conversions to be used, click the Preview Conversion button.

The import uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the Tekla Structures name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials manually in the following way:

   a. Create a profile and/or material conversion file in a text editor using the file name extension .cnv.
      The conversion files can also be used to override the standard conversion.

   b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:

      STB 229x305x70=TEE229*305*70 for profile
      S275JR=S275 for material

   If the conversion files are not used, the members with profiles or materials that cannot be converted will still be created but they will use the import file profile or material, which may be invalid in Tekla Structures, and the members may be drawn as lines in the model, but can then be edited manually in Tekla Structures.

5. Select the grid options:

   • **Delete Tekla Structures' grids**: Import will remove all grid lines/planes from the current Tekla Structures model.

   • **Import grids from import file**: The grid lines from the import file will be imported into the Tekla Structures model. A grid line pattern will be created, and all the imported grid lines will be attached as individual grid planes to this pattern.

6. Import by pressing one of the following buttons:

   • **Import at Origin**: Import the model using the global X, Y and Z coordinates with the global origin as the 0,0,0 point for the import model's coordinate system.

   • **Import at Location**: Select a point in the model to use as 0,0,0 and select a second point to define the X axis to use.

When a Tekla Structural Designer .cxl file is imported into Tekla Structures, the model is checked for existing items. If none of the items in the import file have previously been imported into the current model, Tekla Structures imports the contents of the selected import file and creates all the required objects in the Tekla Structures model. If the Tekla Structures model is empty,
the project properties from the .cxl file will be written into the model's project properties. If the model contains members, the .cxl model data will be ignored leaving existing project properties intact.

See also
Re-import with Tekla Structural Designer integrator (page 314)

31.3 Re-import with Tekla Structural Designer integrator

When you import from Tekla Structural Designer you can control which changes will be made in the Tekla Structures model. If none of the objects in the import file have been previously imported in Tekla Structures, the import will complete after Tekla Structures has created the required objects. If objects already exist then the new members will be listed as new, but if no objects exist then the import will just take place.

1. Follow the steps in Import with Tekla Structural Designer integrator (page 312).

2. To display the properties of an object, select the object from the list on the left in the import verification dialog box.
   If you select more than one object, only the properties for the first object on the list are displayed, but all the objects that you selected are highlighted in the model.

3. If any object in the import file has previously been imported into the Tekla Structures model, the Model Comparison Tool dialog box is displayed showing the changes and allowing you to control which changes will be made in the Tekla Structures model. You can do one of the following:
   • Ignore deleted list: The .cxl file may contain a list of objects deleted in Tekla Structural Designer. If objects in this list still exist in the Tekla Structures model, they will be deleted unless this check box is selected.
   • Ignore new items: Objects that did not previously exist in the Tekla Structures model that are in the import file are excluded from the import if you select this check box.

4. To append the Tekla Structures object ID to the object type string in the comparison tool list, select Display part IDs.

5. If updating the positions of objects is not required, selecting Profile and material updates only will only update the object profiles and materials, and ignore other changes.

6. To reduce the amount of information displayed about the objects that have been updated, select Only display changed fields.
   Only the values that have been changed are displayed instead of all the object properties.
7. Click **Accept** to use the current settings and complete the import.

Once the import is complete you can view the changes in the model using **Tekla Structural Designer Integration Status** object group color and transparency settings ( **View tab --> Representation --> Object Representation** ).

**31.4 Export with Tekla Structural Designer integrator**

Export with Tekla Structural Designer integrator allows you to export the entire Tekla Structures model or a selected subset of the model. The exported .cxl file can be uploaded to Tekla Structural Designer to update the model, or to create a new Tekla Structural Designer model based on the Tekla Structures model.

Before exporting, open Tekla Structures and the model from which you want to export.

1. On the **File** menu, click **Export --> Tekla Structural Designer**.
2. In the export dialog box, either enter the path of the export file in the **Export file** box or click the ... button at the end to browse to a folder and enter a name for the file.
3. Once you have selected a valid file, the export buttons and the **Preview Conversion** button will be enabled. To process the model and display all the proposed profile and material grade conversions to be used, click the **Preview Conversion** button.

   The export uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the export name will be replaced with the text *** NO MATCH ***.
4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials in the following way:
   a. Create a profile and/or material conversion file in a text editor using the file name extension .cnv.

      The conversion files can also be used to override the standard conversion.
   b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:
STB 229x305x70 = TEE229*305*70 for profile
S275JR = S275 for material

If the conversion files are not used, the objects with profiles or materials that cannot be converted will still be created but they will use the export file profile or material that may be invalid.

5. You can export the whole Tekla Structures model or only the objects that you select. Do one of the following to create the neutral file:
   • To export the whole model, click Export Model.
   • To export only the selected parts, select the parts from the model and click Export Selected.

   The use of select and view filters is recommended to ensure that only structural part of the model or elements requiring design are exported.

   The Quick report window will show you the result of the export.
Tekla Warehouse is a service for collaboration, and for storing and sharing Tekla Structures content.

Tekla Warehouse provides centralized access to a wide range of content that you can use in your Tekla Structures models.

With Tekla Warehouse you can:

• Publish your content online.
• Use your company network or a commercial file storage and synchronization service to share content.
• Save content locally for private use.

In Tekla Warehouse, content is organized into collections.

Tekla Structures collections contain official Tekla Structures content that you can use in your models. The content is grouped by geographical area. There is also a global folder for content that is not location specific.

Tekla Warehouse has the following content categories:

• Applications
• Custom components
• 3D products
• Profiles
• Materials
• Bolts
• Reinforcement
• Model setup files
• Drawing setup files
• Report templates

**Accessing Tekla Warehouse**

To open Tekla Warehouse while using Tekla Structures, do one of the following:
• On the **File** menu, click **Extend --> Tekla Warehouse**.

• Go to **Quick Launch**, and start typing **Tekla Warehouse**.

**Tekla Warehouse Service**


You need Tekla Warehouse Service to benefit from all the features Tekla Warehouse offers, for example, easy installation of content into a Tekla Structures model, or local and network collections.

**See also**

For more information on Tekla Warehouse, go to Tekla Warehouse and click **About**, or see **Getting started with Tekla Warehouse**.
Trimble Connector

**Trimble Connector** enables Tekla Structures to connect with Trimble Connect for sharing reference models.

With **Trimble Connector**, you can

- attach a Tekla Structures model to a Trimble Connect project and project folders
- download a reference model from a Trimble Connect project to a Tekla Structures model
- upload a Tekla Structures reference model to a Trimble Connect project
- export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project

**NOTE** You need to have a Trimble Identity before you can start using **Trimble Connector**.

**NOTE** Trimble Connect related metadata and all reference models are located in the `..<\TeklaStructuresModels<model>\TConnect` folder. Exported reference model settings are stored to the `..<\TeklaStructuresModels<model>\Links` folder. **Trimble Connector** does not work correctly if you manually modify the files in these folders.

### 33.1 Download reference model from and upload reference model to Trimble Connect

- To download a reference model from a Trimble Connect project to a Tekla Structures model, click **File menu** --** Import** --** Trimble Connect**.
To upload a Tekla Structures reference model to a Trimble Connect project, click **File menu --&gt; Export --&gt; Trimble Connect**. The **Trimble Connector** dialog box opens. Log in to Trimble Connect using your Trimble Identity. Then you can start working with **Trimble Connector**.

### 33.2 Link a Tekla Structures model to a Trimble Connect project

1. Click **+**.
   
   The **Select project** dialog box opens.

2. Select the project geographical location in the Trimble Connect service. A list of available projects is shown.

3. Select a project and click **OK**.
   
   The name of the selected project is shown on top of the **Trimble Connector** dialog box.

   Now you can attach folders to the project.

4. Click **+**.
   
   The **Select folders** dialog box opens. The previously selected project is shown.

5. Double-click the project to see the folders inside the project.

6. Double-click the root folder to see the subfolders.
   
   A list of available folders is shown. You can select multiple folders, create new folders and delete existing folders from the list.

   If you create a new folder, enter the folder name in the box and click **Create**.

7. Select a folder where you want to link the model and click **OK**.
   
   The selected folders are shown in the **Trimble Connector** dialog box.

8. Double-click the folder to open it.

9. Click **Export new model to Trimble Connect** and specify the export details:
   
   • Enter a name for the model. The model name is unique for a project.

   • Select what you want to link: **Filter, All, or Selected**.

   • If you selected **Filter**, select an appropriate filter.
• If you selected **Selected**, select the objects in the Tekla Structures model.
• Click **OK**.

### 33.3 Download a reference model from a Trimble Connect project to a Tekla Structures model

1. Double-click a selected folder.
   A list of reference models in that folder is shown.
2. A reference model that has not yet been downloaded to a Tekla Structures model has the **️** icon. Select a reference model and click **️**.
   The reference model is downloaded to a Tekla Structures model subfolder and inserted to the Tekla Structures model.

If you want to see a list of reference model versions, click the arrow in front of the reference model name. You can select any of the previous versions of the model and insert it to the Tekla Structures model by clicking **️**.

When a reference model version has been inserted to the Tekla Structures model, the version gets the **✔** icon.

If there is a reference model version that exists in the Tekla Structures model subfolder but has not been inserted to the Tekla Structures model, the version gets the **➕** icon.

When the reference model version is the same in Tekla Structures and in Trimble Connect, the model gets the **✔** icon.

### 33.4 Download a reference model update from a Trimble Connect project to a Tekla Structures model

If a Trimble Connect project folder contains an update to a reference model that already has been downloaded to Tekla Structures, the reference model gets the **️** icon. Click the icon to download the latest version of the model.
33.5 **Upload a Tekla Structures reference model to a Trimble Connect project**

If a Tekla Structures model has a reference model inserted that has not been uploaded to a Trimble Connect project, the model gets the ![icon](image.png) icon. The models are listed at the bottom of the Trimble Connector dialog box. You can upload the reference model to a Trimble Connect project by clicking ![icon](image.png).

33.6 **Upload a Tekla Structures reference model update to a Trimble Connect project**

If a Tekla Structures model has an update to an inserted reference model, and the model has been published to a Trimble Connect project, the reference model gets the **New version** label. You can upload the reference model update to a Trimble Connect project by clicking ![icon](image.png).

33.7 **Export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project**

You can create an .ifc coordination view 2.0 file from Tekla Structures model objects and export it to a Trimble Connect project. You can create the file from selected model objects, or from all model objects.

1. Click ![icon](image.png) to start the export.
   
   The **Configure IFC export** dialog box opens.
2. Enter a name for the exported model.
   
   The model name is unique for a project.
3. Select the properties.
4. Click **OK**.

You can download the reference model to the Tekla Structures model. Select the reference model in trimble Connector and click ![icon](image.png).

After a successful export, the model is marked with ![icon](image.png).
If the Tekla Structures model has an updated version of the exported reference model, click to export the updated version of the reference model.

The .ifc file includes parts and grids. The .ifc file does not include assembly information, which means that you can export only main parts. You can add additional property sets by saving a property set in File menu --> Export --> IFC.

### 33.8 Use base point instead of alignment offset

If the Trimble Connector project folder name is equal to an existing base point name, or if the project folder name ends with (existing base point name), then the base point is used instead of the alignment offset. If a base point is used, offsets are ignored. An example of a project folder name ending with (existing base point name) would be the folder name Architectural (EK840) where base point with the name EK840 representing the coordinate system name exists.

### 33.9 ToDos

The ToDos list in Trimble Connector displays the ToDo notes added to the project. You can add ToDo notes and reply to notes of other project members. The ToDo notes are shared to all project members by default, but you can select a user or a user group who to assign the ToDo with a due date when it needs to be resolved.

**Open and view the ToDo list**

1. In Trimble Connector, open a project.
   
   You cannot view or create ToDo notes if you do not have a project open.

2. Click the ToDo button.

3. You can:
   
   • Sort the list according to Author, Assignee, Due date, Status, and Priority.
   
   • You can use Search to search for specific ToDos.
   
   • You can group by Author, Status, Priority, Creation date, and Last modified date.

4. To close the ToDo list, click the Close button.
Create ToDo notes

1. In **Trimble Connector**, click the ✉️ **ToDo** button.

2. Click the ✉️ **Create ToDo** button, and a new pane opens where you can fill in the ToDo information.
   - To create a ToDo with a view and a snapshot, select the native Tekla Structures objects.
     Select only one view. When you create a view, an IFC file of the selected native objects is created and uploaded to the project root \TeklaStructures-ToDos folder.
   - Do not create views of a lot of objects at a time, because then creating a ToDo may take a long time.
   - To create a ToDo without a view and a snapshot, do not select any objects.
   - The **Description** information is obligatory. You cannot save a ToDo without a description.

3. Click the **Save** button to save the ToDo.
   The saved ToDo is immediately synchronized to Trimble Connect. After the ToDo has been pushed to Trimble Connect, it receives a unique name consisting of the abbreviated project name plus a running number.
   The created ToDo can be seen in Trimble Connect on the **ToDo** and **Activity** tabs.

View ToDo notes

1. In **Trimble Connector**, click the ✉️ **ToDo** button.
   The **ToDo** list opens.

2. Double-click the ToDo you want to view.
   The **ToDo** property pane opens.

   You can close the **ToDo** property pane by clicking the ✅ **Close** button.

Add comments to ToDo notes

Any user in the project can comment any ToDo.

1. In **Trimble Connector**, click the ✉️ **ToDo** button.
   The **ToDo** list opens.

2. Double-click the ToDo note you want to comment.

3. In the opened property pane, add your comments to the **Comments** box.
4. Save your comments by clicking **Add comment**. Project administrators and ToDo creators can also delete comments by clicking the **Delete** button next in the comment box.

**Assign ToDos**

Once a project has been shared, ToDos can be assigned to other users. You can assign the ToDo only if you are the administrator of the project, or if you have created the ToDo. You can only assign ToDos created in Trimble Connector in Tekla Structures.

1. In **Trimble Connector**, click the **ToDo** button. The **ToDo** list opens.
2. Double-click the ToDo note you want to assign.
3. Click the **Edit** button.
4. In the **Assignee** box, click **Select** and select a project member or user group from the list, or start typing the name of the user or user group to filter the user list.
5. Select the due date from the calendar.
6. Set the priority and the status of the ToDo, if needed.
7. Click the **Save** button to save changes.

**Synchronize ToDo notes**

If another project member has created or commented ToDo notes in Trimble Connector, the ToDos are automatically synchronized immediately.

Alternatively, you can click the synchronize button 🔄 to synchronize the ToDos immediately.

**Adjust ToDo settings**

1. In **Trimble Connector**, click the **Settings** button.
2. Select the **Double-click ToDo view** settings to use:
   - These settings affect the snapshot view in ToDo notes.
   - **Adjusts camera and view projection:** This option is needed if you do not want the snapshot view to change because of coordinate system difference, for example, to keep the current view untouched. If you select this option, the view projection will also change if the Tekla Structures view projection differs from the ToDo note snapshot view projection.
   - **Removes and adds clip planes:** Clip planes in the Tekla Structures view are removed, and clip planes in the ToDo view are added to the
Tekla Structures view. This option can only be used available if the **Adjusts camera and view projection** option is selected.

- **Selects objects:** This option selects the Tekla Structures native object if the corresponding object has been selected in the ToDo view. If the coordinate systems differ, it is possible to select objects and zoom to the selected objects.

3. In **Base point**, select another base point, if needed.

   The list contains project base points in the current Tekla Structures model. If the IFC reference model has been exported by using a project base point, the coordinate system is most likely different from the Tekla Structures coordinate system. You can then change to a different coordinate system by changing the base point. By default the box is empty, which means that the coordinate system is model origin.

4. To close the settings pane, click the **Close** button.
Analysis and design systems are used to design and analyze the frame or components within a structure. These applications calculate the loading, stresses and strains on the elements. They also calculate the moments, shears and deflections on objects under various loading conditions.

These types of applications make use of various forms of analysis from the traditional first order static, second order p-delta, geometric non-linear or buckling analysis. They can also make use of various forms of dynamic analysis from modal extraction to time history and response spectrum analysis along with the sizing of steel, concrete and timber elements to the relevant national and international design codes.

Some examples of these systems are ETABS, STAAD.Pro, SAP2000, Robot, ISM, S-Frame, MIDAS, Dlubal, SCIA, Powerframe, GTStrudl, Strusoft, and AxisVM.

See also
Analysis and design direct links (page 327)
STAAD.Pro (page 329)
SAP2000 (page 328)
Robot (page 328)
ISM (page 329)
S-Frame (page 330)

34.1 Analysis and design direct links

When you have a direct link to an analysis and design application, and you export the analysis model from Tekla Structures using that particular analysis application, the model is opened in the application. Tekla Structures and the analysis and design application need to be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open API or the older COM link (Common Object Model transfer technology). A
number of direct links are available including AxisVM, Diamonds, Dlubal, ETABS, GTStrudl, ModeSt, MIDAS, NISA, Powerframe, ISM, Robot, SAP2000, SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft.

Many of the direct links are available for downloading in Tekla Warehouse. For the applications that are not available in Tekla Warehouse, the links can be downloaded from the vendor web sites or by contacting the vendor.

34.2 Robot

The Robot Millennium A&D application is owned by Autodesk Inc. Full product details can be found on the Robot Millennium web site.

- This application is suitable for basic interoperability, and it can export and import cis/2 files.
- If you install Tekla Structures and Robot Millennium on the same computer, then a direct link can be used.
- Currently only the EC3, LRFD, CM66, E32 and ANS design codes are available in Robot when using the direct link.
- If you are upgrading to Robot 2012, you will need to uninstall Robot 2011 along with the Autodesk Robot Structural Analysis link. Then install Robot 2012 and the link again. This way you make Tekla Structures point to the Robot 2012 application.

To get more information and to download, go to Tekla Warehouse

See also
Linking Tekla Structures with Robot
Analysis and design direct links (page 327)

34.3 SAP2000

The SAP2000 analysis & design application is written by Computers & Structures, Inc. Full product details can be found on their website.

- The SAP2000 analysis & design application can export and import cis/2 and ifc files, and export SDNF files.
- If Tekla Structures and SAP2000 are installed on the same computer, then a direct link can be used.
- It is important that you run SAP2000 for the first time as a standalone application before your load the link. Just start SAP2000 and create a new
model, save it and close SAP2000. This will then update your registry which is needed by the link.

To get more information and to download, go to Tekla Warehouse.

**See also**

Linking Tekla Structures with SAP2000
Analysis and design direct links (page 327)

### 34.4 STAAD.Pro

The STAAD.Pro analysis and design application is owned by Bentley Systems, Incorporated. Full product details can be found on their website.

- STAAD.Pro can export and import CIS/2 files, along with their std format. It has become a semi-industrial standard especially in the plant and heavy engineering segments.
- If Tekla Structures and STAAD.Pro are installed on the same computer, then a direct link can be used.
- Profile mapping for different installation environments is achieved by mapping the profiles used by Tekla Structures and Bentley in files called `ProfileExportMapping.cnv` and `ProfileImportMapping.cnv` located in the `TeklaStructures\TS_STAAD` folder. Currently these files are only used in import.

To get more information and to download, go to Tekla Warehouse.

**See also**

Linking Tekla Structures with STAAD.Pro
Analysis and design direct links (page 327)

### 34.5 ISM

Bentley’s Integrated Structural Modeling (ISM) is a technology for sharing structural engineering project information among structural modeling, analysis, design, drafting and detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the information that is important in the design, construction and modification of the load bearing components of buildings, bridges and other structures. Full product details can be found on their website.

The ISM link is different form the other analysis and design links in that the physical model is also transferred at the same time as the analysis and design...
model and the ISM model can be imported into an empty Tekla Structures model. The round-trip of model information is also controlled by a synchronizer.

If Tekla Structures and an ISM enabled Analysis & Design application or Bentley Viewer v8i are installed on the same computer then a direct link can be used.

In order to use the link, the ISM Structural Synchronizer version 3.0 needs to be loaded before the link.

For more information and to download, go to Tekla Warehouse.

See also

Linking Tekla Structures with an ISM enabled Analysis & Design application
Analysis and design direct links (page 327)

34.6 S-Frame

S-Frame Analysis is owned and developed by S-FRAME Software Inc. It is a complete 4D structural modeling, analysis and design solution for steel, concrete, linear and non-linear structural models. Full product details can be found on their website https://s-frame.com.

- S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed on the same computer, then a direct link can be used. A copy of the link can be requested from S-FRAME Software Inc. Descriptions regarding the link can be found here: Building information modeling (BIM) links.

- In some areas S-Frame used to be distributed by CSC, in which case the installation points to different folders. The model name must not include spaces as this currently is an issue as the analysis and design frame is not created if spaces are included.

The process of importing to and exporting from S-Frame

The Tekla API link allows you to write code to connect to an open model in Tekla and query or manipulate the model. The link was established by using
both the S-Frame and Tekla APIs. It uses a library database to manage items between Tekla Structures and S-Frame.

A copy of the link and instructions on using the link can be requested from S-Frame Software Inc.

The whole process involves the following steps: importing to S-Frame, displaying imported items, and exporting from S-Frame. This process is described below.

**Importing objects to S-Frame and displaying the objects**

1. The S-Frame software checks to see if there is an open model in Tekla Structures using the Tekla API.
2. If a connection can be established, the Tekla Structures model is queried for a list of model objects, such as modeled members or panels.
3. The returned objects are iterated through, recognized types are processed, and equivalent S-Frame objects are added or updated to a library database.
4. The IDs from Tekla Structures are stored so that items can be mapped back and forth between Tekla Structures and S-Frame.
5. Once the objects have been iterated through, the library database is queried, and the updated or created objects referenced in the library are displayed in S-Frame display window.

**Exporting from S-Frame**

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.
2. The library is iterated through for types of known objects (members and panels) that can be mapped back and forth between Tekla Structures and S-Frame.
3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if items exist. If they do not, they will need to be created, and the library will be updated.
4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.
© 2017 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights reserved.

Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

Teigha © 2002-2016 Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures, click File menu --> Help --> About Tekla Structures and then click the 3rd party licenses option.

The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the United States and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.
Index

3

3D DWG/DXF
exporting................................................ 103

A

abs files........................................................ 235
analysis & design
direct links..................................................327
analysis & design
Robot...................................................... 328
SAP2000................................................. 328
systems...................................................327
ASCII
exporting...............................................162,163
file description.......................................163
importing........................................ 162,163

B

base point...................................................... 37
base quantities..............................................95
basepoint....................................................... 37
Bus.................................................................137
importing................................................ 157
BVBS
calculating bar length........................... 242
export settings.......................................236
exporting................................................ 235

C

CAD models
re-importing.............................................149
CAD............................................................... 137
export file types........................................ 131
exporting..............................................143,144
import file types........................................ 131
importing..............................................131,132
Calma..........................................................137
derchange detection for reference models.....51
dchecking reference model contents........... 60
dchecking
exported IFC model.................................95
CIMSteel....................................................... 137
dconversion files.......................................177
dexporting................................................ 173
dexporting to an analysis model..............174
dimporting................................................ 173
dCIMSteel design/manufacturing models
dexporting................................................ 175
dCIS Model.....................................................137
dCIS Model/CIMSteel.................................... 137
dCIS status................................................... 137
dCIS/2............................................................. 173
dCIS................................................................. 329
dconversion files.......................................177
dexporting................................................ 173
dexporting to an analysis model..............174
dimporting................................................ 173

dCNC............................................................... 184
dcompatible software.....................................13
dcontour marking......................................... 205
dconversion files....................................... 32

dCIMSteel....................................................... 177
dcreating.................................................. 34
dtwin profiles............................................. 33
dconverting IFC objects............................... 70
Convert_DSTV2DXF..................................... 209
dcreating
contour marking.......................................205
dcreating layout line................................... 291
dcreating layout point............................... 290
dcreating
conversion files.......................................34
dlayers for DWG export............................. 116
Layout Manager groups............................ 288
NC files in DSTV format........................ 187
NC files in DXF format...........................209
pop-marks..............................................200
rule for DWG export............................. 116
selection filter for DWG export............115
tube NC files......................................... 208
customizing
   NC file header information............... 199
cxl..........................................................310

defining
   custom line type for DWG export.......117
   export settings in Layout Manager.....294
   line types and weights for layers in DWG
   export..................................................118
design models.................................... 175
DGN..................................................... 123
   exporting.............................................126
   importing.............................................123
   supported objects................................124
direct links.........................................327
direct links.......................................... 13
drawing export
defining customized line type mappings
......................................................111
drawings
default line types................................ 114
   export layers..................................107,109,110
   exporting........................................105,107,111
DSTV....................................................137,153,184
   converting to DXF.............................210
   creating NC files................................187
   exporting.........................................159,160
   importing.........................................153
   supported entities............................ 160
DSTV file description............................186
dstv2dxf.exe...........................................209
DWG....................................................101
   drawing export layers......................107,109,110
   export example.................................115
   exporting 3D......................................103
   exporting drawings..........................105,107
   importing..........................................102
   objects in export layers....................108
DXF....................................................101,184
   creating from NC files........................209
drawing export layers.......................107,109,110
   exporting 3D......................................103
   exporting drawings..........................105,107
   importing..........................................102
   objects in export layers....................108
E
   ELiPLAN
      export settings...............................229
      exporting........................................226,227,228
      importing........................................226
   Eureka LMP............................................137
examples
   converting IFC objects....................... 80
   creating layers for DWG export...........116
   creating rule for DWG export...............116
   creating selection filter...................115
   defining custom line type for DWG
   export..................................................117
   defining line types and weights for layers
......................................................................118
   exporting drawing to DWG...................119
   setting up layers for DWG export.........115
   export layers.................................107,109
   assigning objects............................108
   copying to another project...............110
   export types...........................................30
   exporting
      CAD...................................................143
      exporting...........................................30
      3D DWG/DXF........................................103
      ASCII...............................................162
      assigning objects to drawing export
      layers................................................108
      BVBS..............................................235,236,242
      CAD....................................................144
      CAD export file types......................131
      checking exported IFC model...............95
      CIMSteel..........................................173
      CIS...................................................173
      compatible formats...........................11
      compatible software........................13
      DGN..................................................126
      drawing............................................119
      drawing export layers.....................107,109,110
      drawings..........................................111
      drawings to 2D DWG/DXF files............105,107
336
DSTV .................................................. 159
ELiPLAN ............................................. 226, 227, 228
FEM .................................................. 144
FEM export file types ...................... 152
IFC base quantities ......................... 95
into IFC .............................................. 89
layers ................................................. 107
Layout Manager ............................. 287
layout points .................................. 293
MIS list ............................................. 179
model to Tekla BIMsight ................. 309
PDMS ................................................. 144
PML ................................................... 144
SDNF .................................................. 144
SketchUp .......................................... 100
STAAD ............................................... 158
supported DSTV entities ................... 160
to a CIMSteel analysis model ............ 174
to CIMSteel design/manufacturing
models .............................................. 175
to HMS .............................................. 221
Unitechnik........................................ 244, 246, 247, 252, 261, 266, 274, 276, 278,
279, 280, 284, 285
XML .................................................. 144

F
FabTrol XML .................................... 181
importing ......................................... 181
FEM .................................................. 137, 144
export file types ............................... 152
import file types ............................... 152
importing ......................................... 152
files
conversion ....................................... 32, 33, 34
firm folders
exporting drawings ........................... 110
fittings in NC files .............................. 207
formats
in import and export .......................... 11

H
header
NC files ........................................... 199
HMS .................................................. 221
exporting from Tekla Structures ........ 221
project data in export ...................... 222
slab data in export ............................ 222
steel part data in export .................... 222

I
IFC .................................................... 67
base quantities ............................... 95
cHECKing exported IFC model ............ 95
converted objects ............................. 70
defining property sets in export ........ 86
eXample of converting IFC objects ......... 80
export ............................................... 85
exporting Tekla Structures models ...... 89
import ............................................. 70
object conversion limitations .......... 84
object converter .............................. 70
profile conversion ........................... 79
property set configuration files ........ 96
reference model assemblies ............. 65
supported schemas ......................... 70
using Organizer spatial hierarchy in
export .............................................. 89
import types ..................................... 30
importing points .............................. 299
importing ......................................... 30
additional models from Tekla BIMsight .. 309
ASCII .................................................. 162
Bus .................................................... 157
CAD .................................................. 131, 132
CAD import file types ..................... 131
CAD models ...................................... 149
CIMSteel .......................................... 173
CIS .................................................... 173
compatible formats .......................... 11
compatible software ........................ 13
DSTV ................................................. 153
DWG files .......................................... 102
DXF files .......................................... 102
ELiPLAN ........................................... 226
FabTrol XML ..................................... 181
FEM .................................................. 152
FEM import file types ....................... 152
from Tekla Structural Designer .......... 312
Layout Manager .............................. 287, 296
layout point.............................................298
models..................................................137
PDF to model.........................................130
Plantview models....................................135
re-importing a model.............................149
reference models.........................42,43,70,308
reference models from Tekla BIMsight......
reports..................................................150
SDNF....................................................132
STAAD..................................................154
Stan 3d..................................................156
SteelFab/SCIAD.....................................136
user-defined attribute values...............166,167,168,170
industry standards..................................10
inquiring reference model contents.........60
inserting reference models....................43
interoperability
compatible formats.........................11
compatible software.......................13
definition...........................................9
ISM........................................................329

L
LandXML................................................128
layers
assigning objects in drawing export...108
copying to another project.............110
in drawing export.........................107,109,110
Layout Manager
coordinates.................................289
creating layout line......................291
creating layout point.....................290
default numbering.........................289
defining groups..............................289
exporting.................................287,293,294
exporting drawings......................295
field point........................................299
fields................................................299
ingroups...........................................288
importing.....................................287,296,298
importing points............................299
measured point................................299
viewing..........................................292
line cuts in NC files............................207

line types
customizing.................................107
in drawings.................................114
mapping.........................................107,111
locking
reference models..........................50

M
manufacturing models..........................175
mapping line types............................107
mapping
line types for drawing export.........111
matexp_cis.cnv.................................177
MicasPlus..........................................137
MIS.....................................................179
exporting.........................................179
file types information....................180
models
importing.....................................137

N
NC files
destination folder.........................189
settings........................................189
NC files
contour marking.............................184
creating.........................................187
creating contour marking...............205
creating in DXF format..................209
creating pop-marks.......................200
customizing file header information..199
DSTV file description....................186
fittings..........................................207
line cuts........................................207
NC file headers..................................184
pop-marks....................................184
tube NC files..................................208

O
object conversion..............................84
objects.inp..........................................49
P

PDF
  import.....................................................130
  importing to model...............................130
PDMS.........................................................144
  PDMS/E3D ...................................................183
  Plantview......................................................137
    importing models..................................135
  PML
    exporting................................................ 144
    pop-marks
      creating...................................................200
  project folders
    exporting drawings......................................110
property set configuration files
  in IFC export.............................................96
property sets
  defining in IFC export..................................86
publishing
  model to Tekla BIMsight............................309

R

reference model
  LandXML.......................................................128
reference models
  locking.......................................................50
reference models
  assemblies..................................................65
  checking contents...........................................60
  detecting changes...........................................45,51
  hiding and showing.......................................45
  hierarchy.....................................................61
  highlighting in model view..................................45
  importing...................................................43
  inquiring contents.........................................60
  inquiring native reference objects..................61
  loading.........................................................42
  modifying details.........................................49
  opening reference models list..........................45
  reference model objects...................................61
  showing details.............................................45
  showing layers.............................................45
  supported DGN objects....................................124
  Trimble Connector..........................................319
  updating.......................................................45
user-defined attributes..........................45
reports
  importing...................................................150
Robot.........................................................328

S

S-Frame
  displaying...................................................330
  exporting...................................................330
  importing...................................................330
SACS.........................................................137
SAP2000.........................................................328
SDNF.........................................................137
  exporting...................................................144
  importing...................................................132
SketchUp......................................................100
  exporting...................................................100
software.........................................................13
Staad.........................................................137
  exporting...................................................158
  importing...................................................154
table type specifications...........................................156
STAAD.Pro....................................................329
Stan 3D.........................................................137
  importing...................................................156
SteelFab/SCIA................................................137
  importing...................................................136

T

table type specifications
  STAAD.........................................................156
Tekla BIMsight................................................308
  importing additional models..........................309
  importing reference models...........................308
  publishing models from Tekla Structures..................309
Tekla Structural Designer..................................310
  exporting to.................................................315
  importing from.............................................312
  re-importing from.................................314
Tekla Warehouse............................................317
Tekla Warehouse Service..................................317
tube NC files................................................208
twin profiles
  conversion..................................................33
U
uni................................................................. 246
Unitechnik
exporting....
244,246,247,252,261,266,274,276,278,
279,280,284,285
user-defined attribute values
importing......................... 166,167,168,170

V
viewing
layout lines.............................................292
layout points...........................................292

W
Web Viewer
creating named views......................305
e-mailing models...............................304
full content rendering......................302
large models.....................................302
moving objects.................................306
publishing a model as web page........302
receiving models..............................304
sending links..................................304
sending models...............................304
Tekla Web Viewer..........................302
tooltips...........................................303
viewing objects...............................306
web templates...............................304
zooming.........................................306

X
XML
exporting..............................................144